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Thank you for choosing eBay Photos That Sell. This book is part
of a new wave of Sybex graphics books, all written by outstanding authors—artists and
teachers who really know their stuff and have a clear vision of the audience they’re
writing for. It’s also part of our growing library of truly unique digital imaging books.

Founded in 1976, Sybex is the oldest independent computer book publisher.
More than twenty-five years later, we’re committed to producing a full line of consis-
tently exceptional graphics books. With each title, we’re working hard to set a new
standard for the industry. From the paper we print on, to the writers and photographers
we work with, our goal is to bring you the best graphics books possible.

I hope you see all that is reflected in these pages. I’d be very interested to hear
your comments and get your feedback on how we’re doing. To let us know what you
think about this, or any other Sybex book, please visit us at www.sybex.com. Once
there, go to the product page, click the Submit a Review link, and fill out the question-
naire. Your input is greatly appreciated.

Please also visit www.sybex.com to learn more about the rest of our 
graphics line.

Best regards,

DAN BRODNITZ

Publisher
Sybex Inc.

Dear Reader,
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This is Dan Gookin’s 99th book on personal computers and technology. Dan’s books,
which include the international bestsellers DOS for Dummies and PCs for Dummies,
have been translated into more than 30 languages and have sold more than 15 million
copies. Visit his website at www.wambooli.com.

Robert Birnbach has been shooting people, places, and things for more than 15
years. He started in New York, but has been working in San Francisco since opening his
studio there in 1993. Robert has developed national campaigns for Pottery Barn, Tar-
get, Kinko’s, and MTV. You can check out more of his work at his website: www.robert-

birnbachstudio.com.
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“This book shows

you how, with a minimum

investment in time

and money, you can start

shooting better photographs

now.”
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To say that eBay is a craze is an understatement. It’s a phenomenon. eBay,
along with other online auctions and resale websites on the Internet, has opened up the
retailing market to any entrepreneur with a computer, Internet connection, and some-
thing to sell. Eager buyers show up by the thousands every day. There are deals to be
had and money to be made. Just about everyone is eager to be a part of that picture.

Setting up an online sale is simple. It’s not really that technical; the steps involved
don’t require a Ph.D. in computer science or years of practice. The process is almost too
easy, but making the sale often isn’t. That’s because the competition online is fierce. The
buyer’s attention span is short, so anything you can do that gives you that edge is valu-
able and necessary to help close the deal.

One of the most neglected yet vital parts of selling things online is the photo-
graph. People desire a visual image of what they’re buying. That picture can make or
break a sale, so it’s odd that sellers don’t place that much emphasis on taking better
photographs. In fact, the typical seller’s photograph you find on eBay is such an after-
thought that the image borders on comical. It’s surprising that some people are able to
sell anything, because they just can’t take a good picture.

This book aims to eliminate the Bad eBay Photograph Syndrome. The idea is not to
turn you into a professional photographer, but rather to give you some helpful hints, words
of advice, and useful strategy for taking good, quality photographs—pictures that sell.

About This Book
You want to sell. Heck, you probably want to sell more. That’s great! That’s why you
got this book. You know the value of a good photograph, and you want to take pic-
tures of your stuff so that it looks much better than what the other guy offers—even
when he’s offering the same thing. Yes, that’s entirely possible, and this book shows
you how it’s done.

What you don’t want, however, is to waste time. You don’t have the time to
become a professional product photographer. You don’t want to learn everything there
is to know about a digital camera. You don’t have time to waste on various studio tech-
niques or money to waste buying expensive photographic equipment. You don’t want to
wade through all the countless options and features available in various photo-editing
software. You just want to take a picture that sells.

Well, you’ve found your book.
Using the advice, knowledge, experience, and insight of a professional product

photographer, this book gives you only the information you need to know to take the
photograph that sells your stuff.

The cost involved is minimal. True, you might need a new or better digital cam-
era, but that will pay for itself with all the sales you’ll soon be making.

Introduction
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This book shows you how, with a minimum investment in time and money, you
can start shooting better photographs now. In just a few short pages, you’ll immediately
be able to recognize what you’re doing wrong and take better pictures. The examples
and step-by-step procedures tell you exactly what to do and how to create a picture that
outshines the competition and leads to a sale made and profit gained.

What’s Covered Here

This book shows you how to become a better photographer, with a specific concentra-
tion on taking product shots, or pictures of the things you plan to sell on the Internet.

Even though the concentration is on eBay, the techniques here work for any
online auction or resale website. This information applies to all product shots, not only
those that you’ll use on eBay.

The book works sequentially, chapter by chapter. You’ll discover how product
shots work, why some shots don’t, and how to improve your pictures and solve com-
mon problems.

You’ll read here how to find material to help you set up the best possible shots.
We cover two approaches to product photography: subjective and objective. You’ll learn
which is which, why one is more important than the other, and when to use either one.

This book tells you about digital photography and what’s important to look for in a
digital camera—specifically a camera that you’ll use to take product shots. The camera is a
money-making tool, and you need the best camera you can get to help you make money.

A great deal of information is provided on how to set up your product shots.
You’ll learn some tricks and secrets of the professionals. You’ll find out how to best
position the camera and your product. Plus, you’ll learn valuable lighting techniques
that help make the stuff you sell look natural and appealing.

There is basic information here on photo-editing software, specifically the latest
version of Adobe’s Photoshop Elements—a product that may have even come bundled
with your digital camera. The emphasis is on only those parts of the photo-editing pro-
gram that help you make the sale. This is not a photo-editing book, and no time is
wasted on those parts of the program that have little to do with product photography.

Finally, you’ll see page after page of examples. You’ll see good shots. You’ll see
bad shots. You’ll see step-by-step illustrations of ways to improve your photographs,
along with instructions and suggestions, particularly for how to set up your shots. Plus,
you’ll see various ways to accomplish the same thing.

The bottom line here is the sale. You want to make an emotional connection with
your buyer. The photograph is the ideal tool to meet that end. This book shows you
exactly how that connection is made and how you can use a simple image to help you
close the deal.

What You Won’t Find Here

This is not a book on how to become a professional photographer. A special type of
high-end photography is devoted to taking product shots. The experts in that field have
invested years of study and practice, and they really know what they’re doing.

If you want to spend money on your photographs, hire a professional to take
them. Or when you have a product shot that you just can’t get right, it’s worth it to pay
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a little more and get that professional eye and experience. But for most of the typical
shots found on eBay, the method that this book proposes will be more than enough.

This book does not contain detailed tips and tricks that you can use in photo-
editing programs. Although this book covers only Adobe Photoshop Elements, you’ll
find that many of the features documented here appear in other photo-editing pro-
grams. These programs may not use the same commands in the same way, but the fea-
tures are commonly available.

This book doesn’t have the space to illustrate an example for everything you
could possibly sell on eBay. In fact, only two approaches are really necessary for prod-
uct shots: objective and subjective. And despite the variety of objects for sale on the
Internet, they all fall into the handful of categories presented in this book.

The only types of photographs you won’t find specifically addressed here are pic-
tures of cars and real estate. That’s because car photography is a specialty all unto itself—
really the topic for an entire book. Ditto for real estate photography. Yet for everything
else, the approaches discussed in this book cover those items well.

Conventions

It is not necessary to have any specific digital camera or computer system to make this
book work. The shots you’ll see in this book were made with a variety of cameras that
span the spectrum of cost and complexity.

The kind of computer you’re using isn’t really crucial. This book assumes that
the computer’s hardware is beefy enough to run standard photo-editing software, which
is true for most computers sold in the past several years.

Instructions are provided for both PCs running Windows XP and Macintosh
computers running OS X. When this book refers to Windows, it specifically means
Windows XP, either the Home or Professional Edition. Where keyboard directions are
given, the Windows keys Alt and Ctrl are specified. On the Macintosh, the # and
Option keys are used.

Though this book specifically mentions Adobe’s Photoshop Elements (version 3),
you can use any photo-editing software. There are similar versions of Photoshop Ele-
ments for both the PC and the Mac.

N o t e : This text format identifies bonus information about the current subject or something you should

pay particular attention to.

What Now?

You’re probably itching to start improving your photography. That’s great! This book
was crafted to be read front to back. Though it’s not necessary to read it in that man-
ner, you’ll benefit most if you read the chapters sequentially.

You can e-mail the authors at ebay@robertbirnbach.com and dgookin@wambooli

.com. The authors would love to hear feedback regarding this book, but they are not
available to answer technical questions or for troubleshooting purposes. 

Please enjoy this book!
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In This Chapter
Professional and amateur photography
The emotion involved with sales
Good and bad picture examples
Rules for taking the best photograph
The results you want

Selling Your Image

It’s you versus the other guy, and the competi-

tion is stiff. Whether you’re selling off great

grandma’s china, some extra stamps from your

collection, or knickknacks from your own

homegrown antique store, you want to take a

picture that helps sell your stuff, a photograph

that connects with the viewer and makes your

item look better than the competition’s.

Taking a photograph of an item you want to

sell is vastly different from taking pictures at a

birthday party. Yes, you can use the same cam-

era. But creating an image that sells involves a

deeper understanding of photography—and

that’s more than just knowing about all the

knobs on your camera. It involves making a

connection between the photograph and the

buyer. That’s the secret this chapter uncovers.
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Say “Cheese”
There is a whopping difference between taking a picture for your photo album and tak-
ing a picture of something you want to sell. If that’s news to you, great! (It should be
news to most folks, given the clumsy “for sale” photographs you can easily find on
eBay.) If it’s not news to you, at least you can recognize the professional edge, especially
when you compare a good image with a bad one. Yet despite the obvious difference, few
people can put their finger on exactly what makes one photo better than another.

Don’t mull it over! Here’s the answer: In a nutshell, the difference between the
professionally taken photograph and the bazillions of pictures amateurs take every day
is that the professional knows how to make a connection between the photograph and
the person looking at the photograph. Everything else—the lighting, the technique, the
approach—is all working toward the same thing: making the connection.

Aunt Flo versus the Professional

Photography has been around for more than 100 years. It’s neither a dark nor a myste-
rious art. There are professional photographers, but amateurs do most of the picture
taking. That’s possible because taking a picture is one-click simple. But that miracle
didn’t happen overnight. 

Millions of research dollars have been spent over the years to find ways to make
picture taking easier. Camera and film companies have invested in quick and idiot-
proof ways to stick film in a camera. Research has been done on various methods of
automatically focusing, automatic no-red-eye flash, and adjusting the exposure. 

And I’m certain that psychologists have studied ways to help dear Aunt Flo know
which end of the camera to look through. Such an investment made sense because people
just love to take pictures. Amateurs are crazy about photography—quality be damned! 
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After all, a picture is a picture; the rough edges can be overlooked simply because
photography in itself is just so darn amazing. Sure, James’s head is off the frame, but you
can see Kelly just fine. Jean and Joan look a bit fuzzy in front of the Golden Gate Bridge,
but see how Bob got in the shot as well (see Figure 1.1)? And God bless Grandma Eunice
for believing that you had to take every picture before you could turn in a roll of film;
otherwise, we wouldn’t have scrapbooked the “Grandpa Frank Reading the Paper in His
Underwear” series.

Figure 1.1 Jean and Joan (and Bob) in San Francisco

The same applies to taking photos of bicycles, dinnerware, or clothing that you
want to sell on eBay. Figure 1.2 is typical in this regard. Yes, that must be a beautiful
Fabergé-like egg in the picture, but is it that one silver egg that’s really what’s for sale?
What about all the other junk in the picture? And then look in the background: isn’t
that the photographer reflected in the glass?

Contrast Figure 1.2 with Figure 1.3. It’s the same egg, but it’s a better shot. The
focus is completely on the egg itself. You can see the detail. You notice the little golden
legs in Figure 1.3, which are easy to overlook in Figure 1.2. The image in Figure 1.3
helps to sell the object with just a few simple tricks—time, thought, and care—nothing
that this book cannot teach you.
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N o t e : No one knows for certain where the phrase “Say ‘cheese’“ originated, though it’s easy to assume

that by saying that word, the mouth opens into a semi-smiling position. But what’s odd is that the phrase

transcends cultures. In other lands, folks will pose for a picture and say “cheese” in their own native

tongue—even when their word for cheese might not cause the mouth to open at all!

Admit it: there are some bad shots out there, taken by perfectly fine cameras,
but imperfect photographers. What’s missing is the connection. The professional knows
how to connect with the person who’s viewing the photograph. You may need more
than 1000 words to describe something, but if you take the time to set up your photo-
graph, the connection will be there. Even an amateur photographer recognizes it.

All Sales Are Emotional

When it comes time to take a photograph of something you want to sell, you need to
pitch away all your amateur notions of photography. Even if you understand the
mechanics—the focal length, shutter speed, aperture, and other technical camera
terms—there is something more that needs to be put in the photograph.

When a photograph becomes a sales tool, you depart from the realm of photog-
raphy and enter the high-pressured world of sales. Face it, you’re not trying to sell any-
thing (or anyone) when you show a picture of your family sitting on a blanket having a
picnic. But when you have something to sell—anything from a baseball card, to a rare
coin, to an antique clock or an MP3 player—the photograph becomes a means to help
you sell, to make money.

Figure 1.3 Same egg, better shotFigure 1.2 What exactly is for sale here?
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In sales, you have competition, especially in the expanding world of online sales.
On eBay, 100 other auctions can be going on at the same time, selling much the same
thing. Immediately you know that your photograph must look better than the other
seller’s picture. Whether you’re hawking the same thing as your competition or your
stuff is miles better, your photograph must outshine that of the other person or you’ll
lose the sale—and the money. But there’s even more to it than that.

All sales are emotional—on the part of the seller, but more important, on the
part of the buyer. Emotion is present no matter what is being sold; even a basic neces-
sity has emotion attached to its sale.

The person who buys a new car is after the emotion—the look and feel and
excitement of the new car. Collectors may seem cold and calculating in their decisions,
but they want to own and hold things they deem precious. New clothes make you look
and feel good. Name a kid who doesn’t get thrilled over a new toy. No matter the item,
emotion is ever present in the buyer, who can be swayed to make a purchase by your
ability to take the photo that makes the connection.

The best photographs make the emotional connection, bringing out the proper
moods in the buyer. They think, “Wow! I could have that fantastic-looking lamp in my
own house!” or “That train set is in mint condition and would be an asset to my collec-
tion.” Or, “Wow, that coffee cup sure would sate my caffeine binge!” (See Figure 1.4.)

Figure 1.4

A well-done photograph

makes a connection.

What does this photo-

graph say to you?

4381ch01.qxd  12/4/04  0:03  Page 5

TEAM LinG - Live, Informative, Non-cost and Genuine !



6

C
H

A
P

T
E

R
1

:
S

E
L

L
IN

G
Y

O
U

R
IM

A
G

E
■

With the proper photograph conveying a feeling, the sales happen. But you must
know how to take photographs that make the emotional connection or that evoke the
kind of “I must have this” feeling in the buyer.

Rules for Taking the Best Picture
The photograph is such an important part of selling things that it’s curious (and often
laughable) why so many people who try to sell things take such horrid pictures. Maybe
they’re in a hurry. Maybe they really think that having neighbor Agnes’s hands holding
up the flowerpot against the velvet wallpaper is the best way to sell such a thing. Or
perhaps they don’t understand the emotional connection and the simple things this
book describes to help make that connection and sell the product.

The rest of this book is devoted to helping you take the best possible pictures
and sell your stuff. Before rushing off, creating your own photo studio, and snapping
pictures, however, it’s best that you learn and understand a few basic rules.

Keep It Simple, Stupid

You’ve doubtless heard this rule before, and that’s because it’s a good rule that is too
quickly forgotten: Keep it simple, stupid.

It’s too easy to overthink things. It’s too easy to become distracted with minutiae
and get sidetracked. Don’t be afraid to try the easy way. Take a step back and consider
easy alternatives when things become complex.

Consider Figure 1.5, in which someone is trying to sell a set of salt-and-pepper
shakers. The shakers are set on a table, as they would be used in real life, but the shot
is distracting. There are objects in the background, but not only that, the shot is taken
with a wide-angle lens that distorts things. Although it is a true image of the shakers,
it’s not the best image.

Figure 1.5

A quick shot taken with-

out consideration of dis-

tractions
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To improve things, you don’t need much. Remember: keep it simple. In this case,

a better shot in Figure 1.6 simply has the camera moved to a different angle, which still
shows the same table as in Figure 1.5, but shows only the salt-and-pepper shakers.

Another improvement was made in Figure 1.6 as well: a sheet of white cardboard
was set off to one side to help “bounce” light back onto the salt-and-pepper shakers.
This cardboard wasn’t any expensive material found only in a photography store. It was
just a sheet of white cardboard, ideal for reflecting enough light to balance the sunlight
coming in naturally from the window. No extra expense was involved, yet the shot looks
like a million bucks over the original.

This book is packed with such examples of keeping it simple; they’ll save you
time, and they’ll make you money.

Less Is More

In addition to keeping things simple, consider limiting the number of objects in each
photograph. Think: less is more.

Remember the egg in Figure 1.2 with all the objects in the background? Yet Fig-
ure 1.3 showed all that’s necessary in the shot.

In Figure 1.7, you see a set of wineglasses. Four of them are for sale, and four
are shown. But do you really need to show all four? After all, the text description on
eBay will say, “Set of wineglasses, quantity four” (or something like that). So the buyer
knows the quantity and can probably assume that they’re all the same glass. Why not
just show one and show it best? Less is more!

Figure 1.6

A simple shot
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In Figure 1.8, you see a wineglass for sale. It’s probably one of a set, yet only
the single glass is shown. In keeping with the previous rule, the setting is simple. An
out-of-focus wine bottle in the background helps create the setting (covered in the
next section). The camera is at a high angle, which helps you discern the true shape of
the glass. And the glass is partially filled with wine, evoking a context for the buyer—
literally inviting them to try a drink from this glass.

Compare how Figure 1.7 makes you feel versus Figure 1.8. Keep in mind that all
sales are emotional, so note which image works better on that level. Which one says to
you, that could be me sitting there sipping wine from that fine glass?

Figure 1.8

A single wineglass, but using

the less-is-more technique to

help sell the lot

Figure 1.7

Some wineglasses for sale.

Ho-hum.
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You don’t need to show a whole group of identical items you’re selling. Instead,

use one. Less is more. Just show one of the dozen lawn chairs, one place setting, one
shot glass, one jewelry box.

Choose Your Approach

This book illustrates two different approaches to taking photographs of things you
want to sell:

• The subjective approach

• The objective approach

The subjective approach places an object in an environment, showing the object
in context. Some objects come across better this way, as opposed to being pictured
alone For example, the salt-and-pepper shakers of Figure 1.6 or the wineglass shown in
Figure 1.8. Those items are placed in an environment. This helps create a better emo-
tional connection with the buyer as opposed to showing the object alone against a solid
background or otherwise out of context. In the subjective approach, it’s easier for the
viewer to imagine how they will use the object; you’re setting up an example and sell-
ing your potential buyer a fantasy.

The objective approach shows an object placed in an artificial environment or
out of context. A solid background or a minimal background is used that doesn’t dis-
tract or pull the focus away from the object. This type of approach works best for
objects that the buyer is familiar with, things they know about. So the context aspect of
the subjective approach isn’t really needed.

As an example, the egg shown in Figure 1.3 illustrates an objective approach.
The background is present, but out of focus. That helps bring the egg forward and let
the buyer examine the detail.

The objective approach is used with the Leica camera shown in Figure 1.9. This
approach minimizes distractions and permits a potential buyer to concentrate on the
object itself: it can be scrutinized, its details examined, and its worthiness judged. The
objective approach appeals to people who know what they want and don’t need the
extra push that showing an object in context offers. It’s more coolly logical than the
subjective approach.

Figure 1.9

The objective approach helps the

buyer scrutinize something they’re

familiar with.
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Common to both approaches is the emotional connection with the buyer.
Remember that emotion is involved with selling, and you’re using the photograph to
help push that emotion. With the subjective approach, the emotion is a fantasy image,
selling the item in an imaginary context that the viewer can project themselves into.
The emotions might be subtler with the objective approach, but they’re still there; a
collector needs to be sold the next item in their collection to satisfy whatever needs the
collection gives them.

Choosing the right approach depends on many things, yet it’s possible to use
either approach in many circumstances. The same vase is shown objectively in Fig-
ure 1.10 and subjectively in Figure 1.11. Deciding which image is best to use depends
on the subject matter, who you’re trying to sell to, and your gut instinct. This book
helps you decide which approach works best, how to set up and use those approaches,
and how to take your photographs.

The images in Figures 1.10 and 1.11 were taken in the same location. Setting the
vase on a sheet of white paper, which was bent upward, created the “infinite horizon”
effect in Figure 1.11. Otherwise, it’s the same vase in the same location. Remember:
keep it simple, stupid.

Thoughtful Setup

Great care must be taken in creating the type of photograph you need, subjective or
objective. Setup is involved, which is a must! The camera must be properly positioned,
never handheld. Attention must be paid to the lighting. Technical issues must be dealt
with. (Don’t fret; it’s all carefully explained in this book.)

Figure 1.11 The same vase shown in an objective approachFigure 1.10 A vase shown in a subjective approach
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Why bother? Because you want more than yet another amateur photograph!

Compare the quick rush of the table photographed shown in Figure 1.12 with that in
Figure 1.13. It’s the same table in both figures.

In Figure 1.12, the camera angle is bad because the tabletop directly reflects the
sunlight. Also the floor color tends to blend in with the table, detracting from the
table’s appearance. Sure, that may be the exact spot where the table sits in the seller’s
house, but because no attention was paid to the setup, the photograph is less than what
it could be.

In Figure 1.13, it’s the same table. In fact, the camera is even at the same angle.
But the table was moved away from the window so that the bad reflection is gone. The
table was also cleaned—which is an amazing thing to try and something many people
often forget. Clean up the stuff you plan to sell!

In Figure 1.13, the new floor helps warm up the image, balancing the industrial
gray of the table. A magazine placed beneath the table’s glass top helps the buyer to con-
nect with the image, showing a possible way of using the table. And finally, the door is
open and objects are placed inside, again showing not only that there is a glass door in
the table (which isn’t obvious in Figure 1.12) but that the inside of the table can be used
for storage.

The main difference between Figures 1.12 and 1.13 is simple: setup.
Figure 1.14 shows a popular MP3 player, the Apple iPod. The owner probably

keeps his iPod in such a position and such a place, but without careful setup, you
have an awful picture. When the iPod is lying flat, all dimension is lost. The wide

Figure 1.13 A better shot of the same tableFigure 1.12 A rush job doesn’t properly showcase this 

fine table.
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camera angle makes the thing look distorted. And what the hell is the screwdriver
doing in the shot?

Figure 1.15 shows a more improved version of the iPod with just a modicum of
setup and a few fancy camera tricks that this book later discloses. The difference
between the images is not only in the setup; you can bet dollars to donuts that the iPod
shown in Figure 1.15 sells before the one in Figure 1.14.

Remember, the photograph is a tool to help you make the sale, not a rushed
obligation. Is that what you figure the photographer in Figure 1.16 had in mind? The
sad thing here is that the photo might just work, but with a little extra care and really
no extra expense, so much more can be done.

Consider Figure 1.17, which, like Figure 1.16, is attempting to sell a hat. In
this case, a wee bit of devotion was necessary to properly take the shot. First, the
hats are just sitting on regular hat stands—something that anyone who’s into hats
would have. The stands are sitting on a regular wooden table. Finally, a roll of
brown shipping paper is draped in the background, covering up whatever is behind
the table. The light is natural and coming through a window. Maybe 10 or 15 min-
utes was taken to set up this shot, yet it looks so much better than the haphazard
shot in Figure 1.16.

Figure 1.15 Same iPod, better setupFigure 1.14 Another hasty setup leads to an awful picture.
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Do It Right the First Time

Thanks to the miracle of today’s photo-editing software, you can fix just about any
flaw in any photograph. That’s nice, but it’s distracting if you’re shooting and thinking,
“Well, I can always fix it later.” It’s better to get the image right in the camera the first
time than leaning too heavily on photo-editing software. You can still use the software

Figure 1.17

Some minor attention to setup

creates a wonderful display.

Figure 1.16

Oh look: a hat.
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to fix mistakes, but it’s better to spend that 5 extra minutes setting up the best shot in
the first place than to spend 50 minutes fumbling around in a photo-editing program.

Believe it or not, that’s a perfume bottle in Figure 1.18. Like many perfume bot-
tles, it’s of an unusual shape. It’s also shiny and reflects light. But more important, like
lots of things people sell on eBay, it’s black. Black shiny objects are difficult to photo-
graph, especially when (as in Figure 1.18) the background is mostly black as well.

Yes, the photograph in Figure 1.18 can be spiffed up nicely using photo-editing
software. But why spend a few hours in front of your computer when a few simple,
less-is-more, objective rules can be applied to the object instead? The result is the photo
in Figure 1.19.

First, the perfume bottle was cleaned. Reflections on a shiny black object are
good, but not when they reflect dirt and crud—and especially fingerprints. (No one
wants to believe that their new purchase has been overly manhandled.)

Second, the shiny black object was placed a sheet of white plastic, though any
white material could work. The purpose here is twofold: to contrast with the black
object and help it stand out, and to aid in the reflections on the black object. You can
see the edge of the white material reflected in the black object, which also helps define
the object’s shape.

Finally, natural light coming through a window is allowed to reflect on the
object, helping to define the surface and expose the object’s dimensions. The reflection
is good.

Yes, all the differences between Figures 1.18 and 1.19 could have been achieved
in the digital darkroom. But a little setup and attention to detail—and no expense—led
to an image that needs little, if any, fixing in a photo-editing program.

Figure 1.19 Some minor attention to setup creates a

wonderful display.

Figure 1.18 What the hell is that?
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In Figure 1.20, you see a lunch box for sale. The photographer has done a bit

of setup here, positioning the lunch box in the light and angling it so that the dimen-
sions are properly shown. It would be super easy to eliminate those ugly shadows in a
photo-editing program, but just a few more minutes of setup can save lots of time at
the computer.

Figure 1.21 fixes the ugly shadow problem by diffusing the light source. The
solution: draping a shower curtain liner over the window. Not only are the shadows
gone, but the light looks more natural and helps fill in around the lunch box, bringing
in details on the side. Two minutes of clothespinning a shower curtain to a window
saved about 40 minutes of painstaking detailed mouse work at the computer.

Figure 1.21

Diffusing the light source cures

the ugly shadow problem.

Figure 1.20

The ugly shadows here can be

removed in a photo-editing pro-

gram with time and care.
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Don’t misunderstand this rule to mean that taking the proper picture is difficult!
It really isn’t. The extra few minutes you spend developing the shot makes a big differ-
ence in the end result. (And that’s what you want, right?)

This rule doesn’t imply that photo editors aren’t important. Even the pros use
photo editors because some things just cannot be done in a camera, some things are
just easier to do later, and some mistakes would take too much time to fix otherwise.

For example, in Figure 1.21, you might notice an odd little square shadow
behind the lunch box. In fact, you might not have even noticed the shadow at all when
you snapped the picture. Such a thing would take a while to puzzle over and try to fix
when the shot was taken, but it’s easy to fix in a photo-editing program.

In Figure 1.22, the square shadow is merely blurred away. It’s not eliminated
(though it could have been). Instead, a filter was applied that blurred the edges and
made the shadow less noticeable—and distracting.

Figure 1.22 Using photo-editing software to fix one, final obnoxious shadow

This book explains (in Chapter 4) when and how to use your photo-editing soft-
ware, without having to rely too heavily on it.
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The Results
When you do everything right, you make that emotional connection, and your photo-
graph leads to a sale. That’s the result you want.

The good news is that anything can be photographed well. There is no object,
item, or trinket that defies the camera and stubbornly refuses to take a good picture.
Everything can be fixed. With only a little effort and a few dollars in equipment (per-
haps even stuff you already have around your house), it’s possible to take a quality
pictures of things that people will want to buy.
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2
In This Chapter
How to set up your own photo studio
Things to get for your studio
Creative studio tricks

Your Own Photo Studio

Taking professional-quality photos to sell your

stuff means you’ll be spending a little more time

setting up the scene and the camera than you’re

used to. But don’t go nuts! Don’t march off to

the camera store and pick up $200 worth of

equipment. The fancy equipment, stands, and

those lights that look like umbrellas aren’t the

key to taking good pictures. If you recall from

Chapter 1, keep it simple.

Yes, it helps to set up your own little photo stu-

dio, but you don’t need to go hog-wild nuts and

spend a lot of money to make that studio hap-

pen. You don’t even need to sacrifice the sewing

room or part of the garage to get things done.

This chapter shows you what you need, how to

get it without spending a lot, and how to use

things found around your house to set up an

efficient and productive photo studio.
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A Place for Your Studio
You don’t really need a permanent photo studio location. In fact, for taking subjective
photos, setting up a context using things found around your home is probably best. But
even for objective photographs, a permanent studio or location isn’t necessary.

It’s best to have a defined space for your photographic effort when you’re taking
the pictures. You can use anything from the kitchen table, to a card table, to the work-
bench out in the garage. When you’re done, you can put away your photo equipment
and return the space to its previous use.

N o t e : There is no need to keep your photo studio up and ready all the time, that is, unless you’re taking

pictures all the time.

Stuff to Get
Suppose that you’re a rich, eccentric weirdo. You’re loaded with cash. But you have a
huge bowling ball collection from when you closed all the bowling alleys in New Jersey
and replaced them with various forms of adult entertainment. You want to sell those
bowling balls on eBay and reap a modest profit. You’re even willing to set up your own
photo studio with professional equipment because, well, you have the money. So what
exactly do you need?

Ha! You’ll never find out. That’s because it just isn’t worth the time to describe
esoteric photo studio equipment here. If you’re gullible, march off to the camera store,
and they’ll sell you the works. But you’re probably the type who’s in this to make
money and not spend it. Therefore, here’s the short list of things you’ll need to help
create your photo studio:

• A shower curtain liner

• Cheap lamps

• Clothespins and clamps

• Drawing paper

• White foam core

• A can of air

• A ladder

Surprised? Nothing fancy is really needed. Odds are you can find most of these
things around your house if you look hard enough.

N o t e : One item not listed but absolutely essential is a tripod. It’s best to think of the tripod as an inte-

gral part of your camera.Therefore, the tripod is covered in Chapter 3, which is about your digital camera.

You may not need all these, and there’s no point in rushing out to buy every-
thing now. The sections that follow describe in detail what these items are, what they’re
used for, and where to find them cheap. Wait until you start taking pictures later in this
book before you get any of them.
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The Miraculous Shower Curtain Liner

While the shower curtain is for show, it’s the liner that does all the work. It keeps the
water inside the tub and not all over the floor. Plus, it serves another purpose useful for
your photo studio: the shower curtain liner obscures light. It turns your stark naked
R-rated self into a fuzzy G-rated blur. It’s that miraculous light-diffusing quality that
comes in handy for your photographs as well.

For about $5 or so, you can buy a shower curtain liner. Don’t get one that’s fully
transparent or totally opaque. Instead, find a frosted shower curtain liner and cut it into
smaller pieces. You can then suspend those pieces in front of your light source to diffuse
the light and eliminate ugly harsh shadows. The idea is to re-create the type of light
you’d find on an overcast day. To a professional photographer, that is the best light to
shoot in. They call it God’s softbox. (A softbox is a professional lighting device that
retails between $200 and $700.)

On an overcast day, the light falls evenly all around a subject. Shadows are lim-
ited to where an object touches the ground, and their outlines are fuzzy. That’s the kind
of light you want to use when you take pictures of something you want to sell. A small
swatch of a shower curtain liner hanging over a lamp reproduces such light nicely.

Compare the images in Figures 2.1 and 2.2. It’s the same camera setup and the
same light source in each image. But in Figure 2.2, a small square cut from a shower
curtain liner was placed in front of the light source. Note how the image in Figure 2.2
opens up. It lacks the dark, contrasty nature of Figure 2.1. (A second light source, also
diffused, would be necessary to help cancel out the remaining shadows.)

Figure 2.1

An unfiltered, direct light
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Figure 2.3 shows an example of how such a light source can be set up. Notice
that the shower curtain liner is some distance from the light. This is necessary to keep
the material from melting and stinking up the place.

N o t e : If you have an overcast day, take advantage of it! Especially if you’re taking pictures of things out-

side, waiting for an overcast day can be to your advantage.This works even if you’re shooting images inside;

use the light from a window to help illuminate your subject matter. Overcast day = good light.When the

light you’re using is still too harsh, consider doubling the amount of shower curtain diffuser.Two layers of

diffuser can really spread that light around, but note that it also diminishes the total light available.

Figure 2.3

Setting up a shower curtain diffuser

Figure 2.2

Diffused direct light, using

the shower curtain liner
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Cheap, Old, Ugly Lamps

There is no point in buying expensive lamps or—heaven forbid!—theatrical lighting for
your photo studio. Instead, go to any hardware store and pick up the type of lamp
shown in Figure 2.4. Get about three or four of them to cover all the bases. Also get a
pack of 100-watt lightbulbs to populate the lamps. 

N o t e : Get white or frosted lightbulbs; do not get clear bulbs.

Honestly, nearly any type of lamp works, not specifically the type shown in Fig-
ure 2.4. The advantage of the type of lamp shown is that it has its own clamp, which
makes it easy to arrange and affix the lamp so that its position stays constant through-
out your photo shoot.

N o t e : Don’t use household lamps or desk lamps for your photo studio.The light from such lamps is dif-

ficult to throw in one direction and even harder to diffuse. Also, some desk lamps are limited to using only

low-wattage bulbs that cannot throw light effectively beyond two or three feet.

One type of light available in the camera store (though at a premium) is the
photoflood. These are standard-sized lightbulbs but which have a favorable color tem-
perature (equal to daylight) and are very bright. If you have such a bulb, use it! But
there is really no need to go out of your way or pay the extra money for such a thing.

Figure 2.4

A good lamp for your

photo studio
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Clothespins and Clamps

A professional photographer will tell you that there’s nothing handier than the standard
clothespin—the springy kind. They even have a photographer’s stock number for it:
C47. So if you want to sound like a pro, don’t call it a clothespin; it’s a C47.

Clothespins are perfect as tiny, temporary clamps, holding things in position. For
example, they can help affix a background to a paint can or phone book. Clothespins
can help keep items such as greeting cards open. And you can use them to help prop
things up (covered later in this chapter). Anywhere you need an extra set of fingers to
hold something, clothespins work in a pinch.

Another handy trick is to chain clothespins together to build structures. Clothes-
pins can be used to help keep shower curtain material away from a hot light, as shown
in Figure 2.5. Also note that Figure 2.5 shows how clothespins can be chained together.

N o t e : If you’re photographing small objects, consider using clothespins to hang those items up on a

clothesline for a humorous effect.

Another handy item to have around are clamps, such as the A-shaped wood
clamps available at any hardware store. You can use these when you really need to
hold something down or grip an item into place. And you can also use them to help
prop up heavier backgrounds or hold down lamps in positions where the lamp’s clamp
just won’t do.

Figure 2.5

Clothespins make great clamps,

and they’re inexpensive.
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Drawing Paper

Don’t worry; this book isn’t regressing to drawing images. No, it’s just that you can use
drawing paper to help set your photograph’s scene. Specifically, drawing paper helps
provide a setting for your image—something more interesting than a Formica tabletop,
for example.

You can use black paper and white paper, and if you look hard in the hobby
stores, you’ll find specialty paper, textured paper, and all sorts of fun and interesting
papers. The only limitation is the size; note that sometimes you’ll have to find large for-
mat paper in an office supply or hardware store.

As an example, Figure 2.6 shows a bracelet sitting atop some fancy paper, which
makes the image more interesting than the same shot against a plain background (see
Figure 2.7). It’s really an aesthetic choice.

Patterned paper is okay, but don’t use paper that overpowers your image. For
example, a black object on black or dark paper would be dumb in that it makes the
image difficult to see.

Figure 2.7

A bracelet against a bad

background

Figure 2.6

Fancy paper helps set off

this bracelet.
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Foam Core Board

Foam core is a special type of art material with paper on both sides and a thin layer of
foam in the middle. It’s usually about 1⁄4-inch thick and comes in sizes from a sheet of
paper on up to several feet square. It’s normally used as mounting material or for con-
structing models. For your purposes, foam core will be a light source.

Just as the moon reflects the sun’s light, you can use a sheet of white foam core
to reflect light from your main light source. This helps fill in the shadows, and it does
so in a natural way without overpowering the image as a second lamp might do.

Figure 2.8 shows the same object photographed in Figures 2.1 and 2.2. In this
evolution, a piece of white foam core was situated just to the right of the image (off
camera). That’s enough to bounce the primary light source back onto the object and
help fix the shadows.

The light-bouncing material doesn’t necessarily need to be a piece of foam core;
any white material will serve well to bounce light. But foam core is rigid, lightweight,
tough, and cheap—which is why it’s recommended.

Another way to use foam core is as a dark source. For example, you can posi-
tion a piece of black foam core so that it eliminates an ugly reflection or light bounce
on an object. (See Chapter 6 for some examples.)

A Can of Air

Clean things before you shoot them! Who wants to buy glassware with smears or finger-
prints on it? 

Figure 2.8

Foam core helps reflect

light and fill in shadows.
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The objects you shoot should be as clean as they can possibly be. This is a fine

example of saving time by taking proper care in setting up your image; although it’s
possible to remove fingerprints with photo-editing software, it’s a pain. Just clean your
stuff before you shoot it.

In some cases, rather than rub something with a damp cloth, which tends to
smudge, consider getting the dust off by using a can of compressed air. It’s just a handy
thing to keep around. You can get canned air at any office supply store.

N o t e : Obviously, old or distressed items need to retain that old and distressed look. Don’t bother clean-

ing up the antiques if that antique look is supposed to be there.

A Ladder

As any kid will tell you, ladders are for climbing. Occasionally, you might want to take
a shot from a higher altitude than your human body can reach. As an example, con-
sider Figure 2.9. The object being sold is a bicycle. It’s a glorious, overcast day, so the
shadows aren’t a problem. But what is a problem is the busy background. Although
you could remove that with time and care in a photo-editing program, a better solution
is to just whip out a handy ladder.

In Figure 2.10, you see the same bike as in Figure 2.9, in the same position on
the same day no less. But because the shot angle is elevated, the background noise is
reduced. That way the buyer can concentrate on the bike. Using a ladder is a great way
to capture larger objects outside.

Figure 2.9

Nice bike. Ugly

background.
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The ladder is also an excellent holder for things such lamps and lights.
The alternative to the ladder is to buy an expensive stand-and-clamp system. But

why do that when you can just clamp or affix one of your cheap ugly lamps to a handy
ladder, which is something most people have?

Alternatives to using a ladder to help you hold lamps include anything you have
in your house that’s freestanding and stable. For example, a torchiere lamp, while ill-
suited to this type of photography, can be used as a stand to hold a lamp; just clamp
the lamp to the torchiere’s base. You can also use chairs, barstools, or anything else
that’s stable and steady.

N o t e : Remember to use items you find around your house! Be clever! Think outside the box!

Helpful Studio Techniques
A magician can work his magic only when the audience obeys. For example, most
magic is performed for an audience that sits in front of the magician in a given space.
People aren’t allowed to get up and wander around the stage with the magician or even
sit behind him. If you did, you might see how the tricks are done, and there wouldn’t
be any magic. In fact, the whole show would appear rather dumb.

Like a good magician, a photographer shows you only what you want to see.
The results are amazing and impressive. But that’s because the camera captures only
what the photographer-magician wants you to see. If you were able to get up and look
at the same picture from another angle, you would see the tricks and the secrets.

Figure 2.10

By stepping up on a

ladder, you can easily

isolate the bike.
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The following sections describe some common tricks used in photography. These
are behind-the-scenes things and stuff you’ll need to know when you want to get that
perfect shot. It’s nothing magic, but there is a certain sense of “aha!” when you dis-
cover some of the sneaky ways photographers do magic for the camera.

Creating an Infinite Horizon

For creating the objective look, an infinite horizon is a must. That’s the type of shot
in which the object appears to exist in a universe all to itself. The surface on which
the object sits just goes on forever; there is no fold, crease, or join where that surface
meets the sky. This technique allows for full concentration on the object with no
other distractions.

You don’t need a lot of equipment or fancy footwork to make an infinite hori-
zon. Figure 2.11 illustrates how an infinite horizon is set up using a sheet of drawing
paper. Lay down the sheet, curving it up at the back. In Figure 2.11, a heavy book
helps prop up the paper. (Also notice how an A-shaped clamp holds down the other
end.) There can be no crease or line. Presto: you have an inexpensive infinite horizon.

N o t e : Professional photographers use something called seamless paper that is hung from a seamless

stand. But regular drawing paper works just as well.

Figure 2.11

Setting up an infinite

horizon
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Infinite horizons are great for taking objective photos of small- to medium-sized

objects, such as the butter dish shown in Figure 2.11. Larger objects present more of a
problem, however, as do objects that cannot be readily moved. For them, another tech-
nique is to use your photo-editing software to eliminate the background, essentially
reducing the image to the object only. This technique is covered in Chapter 4.

You need to remember two things when creating an infinite horizon. First, ensure
that there are no wrinkles or creases in the paper. Creases and dirt spoil the effect. And
second, the paper must be large enough to hold the object you’re photographing. Other-
wise, you’ll need to use your photo-editing software to remove the background.

Propping Things Up

Some items just look better when they are standing up. That’s because people prefer to
view items head on. For example, a book might naturally lie on a tabletop, but if you
take a picture that way, the book looks distorted, as shown in Figure 2.12. It also looks
flat and generally uninteresting.

People want to see things standing up, despite how nature prefers to arrange
things. Because of this, you must be sneaky—like a magician—and magically prop
things up but without being obvious. (That means no leaning things up against a wall
or box.)

In Figure 2.13, you see a side view of an infinite horizon setup photographing
two DVDs. To help keep one DVD propped up, a saltshaker is used. The other DVD
is assisted by a water glass. From the front, both DVDs look freestanding. Indeed, it
would appear as though the photographer carefully balanced the DVDs and then
rushed back to take the shot. But in actuality, the saltshaker and water glass are
there in Figure 2.14; you just can’t see them.

Figure 2.12

A book that hasn’t been

propped up
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The rule about propping stuff up is simple: use whatever works and doesn’t peek
out from around or behind the item being photographed. You can use anything handy
or heavy—clothespins, tape, blocks of wood, what have you. As long as the camera
doesn’t see what’s propping up the object, it will appear in the photograph to be stand-
ing by itself.

Figure 2.14

The buyer has no clue that these

DVDs are being assisted behind

the scenes.

Figure 2.13

Objects that normally fall over

are being propped up.
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N o t e : Avoid using your hands to prop things up! Some of the most comical images on eBay are of regu-

lar folks and their hands holding something up. Invariably the image’s focus becomes the human hands and

not the object being photographed. Besides, many people don’t like the idea of having someone handle the

object they want to buy.

Lighting Techniques

Lighting is essential to photography, so just because it’s listed last in this chapter
doesn’t make it the least of your techniques.

The idea behind lighting an object is to emulate the sun on an overcast day. The
light you use, whether from Our Mr. Sun himself or from a cheap lamp, should illumi-
nate your subject as naturally as possible. In fact, sometimes using the sun that’s avail-
able to you is one of the best ways to light an object.

For example, the object in Figure 2.15 is lit with natural sunlight coming in
through a window. That’s it! No fancy lights. And definitely no flash.

As covered earlier in this chapter, when an overcast day isn’t available, regular
sunlight through a window works well—providing that you diffuse that light with a
shower curtain liner. Just tape or clamp the shower curtain liner over the window to
create your overcast day.

Figure 2.15

Light coming from a

window lit this image.
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When the sun isn’t cooperating at all, bring out your lamps, again covered with
the shower curtain diffuser as illustrated earlier in this chapter. That helps break up the
direct light and eliminate a number of the shadows.

The final light source available to you is the white card, such as the foam core
material mentioned earlier in this chapter. You can bounce light whether it comes from
a lamp or from the sun.

Place the white card on the opposite side of the object, facing the light source.
Like the light source, keep the white card out of the frame; move it back if you can see
it in the image.

As an example, in Figure 2.16 (which you saw back in Figure 2.2), the direct
light is coming from a lamp to the left of the object. The white card is then placed on
the right, as illustrated in Figure 2.17.

N o t e : The light bounced off the white card won’t be as dominant as the original light source, so it’s

ideal to fill in the shadows and help balance the image.The result is something that looks utterly natural to

the human eye.

Figure 2.16

In this shot, the light is

coming from a lamp on

the left.
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Finally, keep in mind that lighting can be mobile. Set up the object. Set up the
camera to frame the image. Then work out the shadows and reflections by moving the
lights.

For example, in Figure 2.18, the lights had to be moved and rearranged several
times to fully eliminate all the odd reflections from the plastic cover on the action fig-
ure. But it was the lights that were moved, not the object or the camera.

Figure 2.18

Eliminating reflections

can take time.

Figure 2.17

Placing the white card to

bounce light

Object
(top view)

Camera
(on tripod)

Diffused light source
(sun or lamp)

White card to
bounce light
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Eventually the best position for the lights was found and the picture taken. The
lesson here is that you need to remember that lights can be moved and rearranged. But
keep the camera and the object stable. You’ll avoid a lot of frustration by following
that simple rule.
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In This Chapter
Selecting a digital camera
Don’t forget a tripod
Choosing the focus
Understanding aperture and shutter speed
Controlling depth of field
Setting up the camera
Setting image resolution
Lighting the subject

Basic Photography

Cameras are sold by boasts of their creative sim-

plicity: automatic focus, automatic exposure,

automatic just-about-everything. The camera

may be “smart,” but it’s not clairvoyant; to get

the results that sell, you occasionally need to

override the camera’s wizardry and exert a little

hocus-pocus of your own.

This chapter covers some basic photographic

concepts, information you’ll rely on later when

you learn how to set up those perfect product

shots that sell. It all starts with choosing the

best camera. Then you’ll learn what all those

knobs and buttons do and how to use them to

conjure the exact picture you want.
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Choosing a Digital Camera
Forget film. Digital is where it’s at when it comes to state-of-the-art photography. The
list of things you can do on film that you can’t do digitally is dwindling to the point of
obscurity. So right away, know that you need a digital camera. It’s part of the future.
It’s a must. 

Unlike trying to create your own economical photo studio (see Chapter 2), there
is no point in scrimping on what you’re going to pay for your digital camera. You’re
going to be using that camera to make money. So consider it an investment, one that
will pay for itself over time.

Based on the features recommended in the next few sections, you can expect 
to pay anywhere from $300 on up to $1200 for your digital camera—which is curi-
ously similar to the same price you’d pay for a comparable quality SLR camera a few
years back.

Don’t go hog wild! There is no point in buying a high-priced, professional digi-
tal camera or spending too much money here. Buy your camera based on the features
listed in this chapter. Avoid the temptation to dive into some top-of-the-line model
unless you plan to do more professional work with your digital camera. But on the
other hand, you don’t want to shortchange yourself. After all, your competition is buy-
ing a good digital camera as well!

N o t e : If you already have a digital camera but it’s more than two years old, you probably need a new

one. So much has changed in the past few years that even the moderately priced models of yesterday aren’t

up to the photographic tasks required by this book.

The Megapixel Question

In the world of digital photography, the emphasis on the megapixel is way overblown.
Indeed, it’s a great marketing term, but you don’t want to choose a digital camera
based on a megapixel rating alone. 

A megapixel is slang for 1 million picture elements. Mega means 1 million. Pixel
is a contraction of picture element, or those dots that make up a digital image. An
image composed of 1 million pixels is approximately the same size and resolution as
the information displayed on a typical computer monitor. But to print a quality digital
photo, you need more than 1 megapixel.

Digital cameras boast of megapixel ratings anywhere from the 3-megapixel
range on up to 8 megapixels or more. Obviously, the more megapixels, the better. An
image composed of 8 megapixels contains far more information than the same shot at
4 megapixels—but you’re going to be paying more for the 8-megapixel camera.

For the digital photographs you’ll be snapping in this book, a camera in the 
5-megapixel range will be just fine. Avoid anything less.
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N o t e : Some cameras proclaim higher megapixel ratings by using interpolated megapixel values.These

are higher resolutions made possible through software magic, but the results are less than impressive.When

shopping, look for true megapixel values, not interpolated.

Some Must-Have Camera Features

First, try to get an SLR digital camera. SLR stands for single-lens reflex, and it
describes the type of camera that lets you look through the viewfinder and see exactly
the image that you will take. Less-expensive digital cameras use separate viewfinders
and lenses, which means that what you see is never exactly the image captured. Invest-
ing in an SLR saves you time when framing an image. A typical digital SLR camera is
shown in Figure 3.1.

Second, get a camera that has manual focus. Avoid cameras with a fixed focal
length or those that use automatic focus with no manual override. You want to ensure
that the camera is focused exactly where you want it, not where the camera’s internal
computer guesses is best.

Third, ensure that the camera has manual overrides for the aperture and shutter
speed adjustments. Nearly all digital cameras have automatic aperture and shutter
speed, but you want to be able to adjust both or either value. For example, you might
want to set the aperture wide open or very tiny, and you might want to adjust the shut-
ter speed for a longer exposure if necessary.

N o t e : If you’re unfamiliar with these camera features, consider visiting a real camera store and not the

camera counter in one of those large we-sell-everything type of stores.Yes, you’ll pay a bit more, but for

your dollar, you can ask questions and get the advice of the folks who know about the real stuff.

Figure 3.1

The Canon Digital Rebel,

a decent digital camera
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Fourth, make sure that you can override or disable the automatic flash. This is a

common feature on most any camera with a built-in flash. (By the way, you don’t need
built-in flash for the projects in this book.)

Finally, get a large-capacity media card for your camera. You’ll find that the
mid-to-higher end “prosumer” cameras in this range often don’t come with media
cards—digital media being the “film” of a digital camera. Buy a high-quality, fast,
digital media card in the 256MB to 512MB range.

Get a Good Lens

When you buy the type of medium-to-high-end camera this book recommends, you’ll
discover that it may not come with lens; the lens is a required extra. Sometimes the
camera comes with a standard lens, but—especially at the camera stores—you’ll have
an option of which lens to choose.

Camera lenses come in five styles: normal, wide, macro, telephoto, and zoom.
Regardless of the style, all lenses are measured by their focal length in millimeters
(mm). Note that this is an optical measurement; the lens’s physical length is shorter
than its optical length.

Normal Lens

A normal lens renders an image roughly equivalent to what the eye sees. The objects
and perspectives are the same as any human would perceive them, as shown in Fig-
ure 3.2, which was shot using a 55mm lens.

Figure 3.2

An image shot with a

55mm lens
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For a standard 35mm film camera, a normal lens has a focal length of about
50mm. For a comparable digital camera, the focal length depends on the size of the
camera’s CCD (charge-coupled device), or the chip that reads the image. (This is related
to the camera’s megapixel resolution.)

The important thing to remember here is that the camera’s normal lens focal
length is different from that of a standard 35mm film camera. If you use a standard
film camera normal lens on your digital camera, it will not be a normal lens but will
tend to be more wide angle. Obviously this is important to know when selecting a lens!
Get a normal lens specific to your digital camera.

Wide-Angle Lens

A wide-angle lens has a focal length shorter than a normal lens. The effect is that more
information is visible through the lens—the field of vision is wider. It’s also a bit dis-
torted as shown in Figure 3.3, especially if you compare it with the same image shown
in Figure 3.2.

The focal length of a wide-angle lens ranges from just below the normal lens’s
focal length on down to what are called fish-eye lenses. Such a lens is used only for
special effects or area-wide photography. Indeed, wide-angle lens are pretty much an
outdoors/environment/architecture type of photographic tool; they have little use in
product photography.

Figure 3.3

The same image shot

with an 18mm lens
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Macro Lens

A macro lens is merely a closeup lens. But unlike the wide-angle lens, which also lets
you get close to your subject, the macro lens does not distort the image. Because the
macro lens’s range of focus is very close to the camera, usually about 1 foot or less, this
type of lens is ideal for taking pictures of small objects up close.

Vary rarely do you buy a macro lens by itself. Mostly they come as a feature of
a normal or zoom lens. But if you plan to take pictures of small objects—particularly
jewelry—you need a macro lens or at least the macro lens’s ability on the zoom lens
you choose. (Keep in mind that macro lenses for non-SLR digital cameras are available
separately, and you will need a lens adapter to attach them.)

Telephoto Lens

Telephoto lens have a focal length longer than a normal lens. This type of lens allows
you to photograph objects at a distance, bringing them in close. The distance is propor-
tional to the lens’s focal length; the longer the length, the farther the lens can see.

One issue to consider with a telephoto lens is that the longer they are, the less
light comes through. Therefore, such lenses are best used in bright light situations. Even
so, they can come in handy for product photography.

In Figure 3.4, you see the same image shown in Figures 3.2 and 3.3. In this
case, the telephoto lens helps bring in the sides of the image. The differences between
Figures 3.4 and 3.3 may be subtle, but in certain circumstances, photographers prefer
the results achieved with a telephoto lens.

Figure 3.4

The same image shot

with a 105mm lens
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N o t e : A specific use of a telephoto lens is as a portrait lens. For a standard 35mm film camera, the por-

trait lens has a focal length between 80 and 120mm. At that focal length, people’s faces photograph

extremely well and natural, which is why such a focal length is called a “portrait” lens.

Zoom Lens

Of all the lens types available, you’ll most likely be getting a zoom lens with your SLR
digital camera. Such a lens has multiple focal lengths, using a twisting ring to set the
focal length smoothly from wide to normal to telephoto.

Get a zoom lens that offers a good range of focal lengths without busting your
budget. Major camera companies offer a range of zoom lenses, from very wide to very
long, but all at a price. Instead of getting all the options, get a nice general-purpose
zoom lens. A standard zoom is probably offered with the camera. That will do fine.

Don’t forget the macro focus ability! If you plan to take pictures of small
objects, such as jewelry, you might want to pay more and get a standard zoom lens that
has macro focus. You’ll be thankful later.

Get a Tripod!
The tripod is one of the best, most useful, and necessary accessories to your digital
camera—so much so that it’s listed here in this chapter as opposed to Chapter 2, which
is about your photo studio. Always think of your camera with the tripod firmly
attached.

N o t e : Never take any product image without using a tripod!

The tripod provides a firm, stable, yet adjustable base for your digital camera. It
helps to ensure that once you’ve set up and framed your image, the camera—and the
image it takes—remains consistent between shots. If you have to adjust a light or prop
up a background, the camera takes the same shot over and over. That way you can
concentrate on the shot instead of holding the camera.

Figure 3.5 shows an example of how you can hold the camera still while work-
ing to fix various problems. Assume that the object is set up properly, framed, and
ready to go. The tripod holds the camera steady as you work to eliminate various nasty
shadows and ugly reflections. By keeping the camera still, the tripod ensures that once
a shadow was gone, it stays gone. Such a feat is impossible without a tripod.

With a tripod, you can also perform some handy camera tricks, such as a longer
exposure. If you try such a stunt with a handheld camera, the result is invariably jerky
or fuzzy. The tripod gives you the latitude to take those longer exposures when neces-
sary, which lets you capture the exact image you want.
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Figure 3.5 The tripod helped keep this shot steady while the photographer was careful to eliminate a host of nasty 

shadows and reflections.

In Figure 3.6, the object was rather dimly lit. To compensate, a longer exposure
was required. Only with a tripod could the camera be held steady for that length of
time, and with the crisp results you see in the image.

Figure 3.6

Can you tell this image was

taken using an exposure of

4 seconds?
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Finding the Focus
The focus is a point at some distance from the camera where an object appears sharp
and clear. When the focus is properly set on an item, that item is said to be in focus.
Objects before and after that distance are slightly to grossly out of focus, or fuzzy and
ill-defined.

Due to the nature of the human eyeball, people prefer to look at objects in focus
and ignore or pay less heed to objects out of focus. By using a specific focus, a photog-
rapher can control what your eye concentrates on in an image. The same image can
also contain out-of-focus objects—and the eye still sees them—but they’re downplayed
and given less importance.

In Figure 3.7, the eye naturally finds the starfish. That object is in focus. Other
shells and objects appear in the image, and they help to reinforce a tide-pool theme, but
being out of focus, they merely act as seasoning to the main dish, the starfish.

To find the focus for an object, you must first know what it is you want to focus
on. Obviously, that must be the item you’re selling, preferably the front side of that
item or the end closest to the camera. You can find this focus in two ways. The first is
to use the camera’s lens in the manual focus mode. You look through the eyepiece or
viewfinder and rotate the lens’s focus ring until the image appears sharply in the
viewfinder.

Figure 3.7

The starfish is in focus,

but the shells around it

are out of focus. The

human eye concentrates

on the item in focus.
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N o t e : In Hollywood, movie cameras are focused with the help of measuring tape.The distance between

the film plane (where the film is exposed in the camera) and the object being filmed (say, Mel Gibson’s

nose) is precisely measured.The camera’s focus is then set to that exact measurement.You can do this with

your camera as well, providing that the measurement on the lens’s focus ring is marked off in appropriate

lengths. If your camera is capable of manual focus, the film plane may be marked on the camera’s top using

the Φ symbol.

The second way to focus is using the camera’s autofocus mode, though a degree
of sophistication comes into play here. Some cameras focus by using infrared light. In
that case, the light must properly be aimed at the object being focused. Some cameras
may have a point-and-set focus system, and in that case, you use the camera’s
viewfinder to set the focus to whatever you’re looking at in the frame. This second
method is more accurate in that you can precisely select which part of the image to aim
and focus at.

Here are a few things to keep in mind about focus:

• If you’re using automatic focus, check to see if the camera has an Auto Focus
Lock or similar feature. That way, when the proper focus is set, the camera
remembers the distance and won’t change the focus between shots.

• When in doubt about the focus, take a test shot. View that image on your com-
puter screen and zoom in to confirm that the object is in focus.

• According to the design of the camera’s lens, only objects at a specific distance
from the camera will be in exact focus. However, you can increase the size of
this focus “field” by adjusting the lens’s aperture to create a deeper depth of
field. Refer to the section “Understanding Depth of Field” later in this chapter.

Controlling the Exposure
You can control how an image is exposed in two ways. Both methods manage the
amount of light entering the camera and exposing the film. (Or, in the case of a digital
camera, exposing light to the electronic CCD chip that interprets the image.)

The first control is the aperture. The second control is the shutter speed. These
items are normally set automatically. In fact, setting them manually was one of the
annoying things people disliked with old manual cameras. But you’ll want to under-
stand both aperture and shutter speed, and how they play a role in creating the image
taken, if you want full control over your photographs.

Setting the Aperture

An aperture is an opening. In this case, the hole through which light passes in the lens
on its way into the camera body. All camera lenses have apertures, and the better lenses
have an adjustable aperture so that you can make the hole as big or tiny as you like, as
shown in Figure 3.8.
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On today’s cameras, the aperture is adjusted electronically, but on a good digital
camera, it can be set manually as well as automatically. Long gone are the days when
the aperture was adjusted by twisting a special ring on the lens.

The aperture’s size is measured as a ratio called an f-stop. The ratio is defined as
the lens’s focal length divided by the size of the aperture, which is depicted in Figure 3.9.

For example, suppose you’re using a 50mm lens and the aperture opening is
12.5mm in diameter. That’s an f-stop value of 4, written as f/4; 50mm ÷ 12.5mm is 4.
By using this method (creating a ratio), all lens, regardless of their length or diameter,
can share common f-stop ratings.

If you can remember that an f-stop value is a ratio, you can better understand
that larger f-stop values mean smaller openings and that smaller f-stop values mean
larger options. Or if you work with wire, understand that f-stop values work like wire
gauges; the larger the value, the thinner the wire.

When the aperture is open as wide as it can go, the f-stop value decreases. Say
the widest that the aperture can open in a 50mm lens is about 38mm in diameter.
That’s an f-stop ratio of 50/38 or f/1.4. That’s considered a fast value because the lens
is letting in a lot of light.

Figure 3.9

A typical SLR lens, cross-section

Focus
ring

Aperture
opening

Aperture
size

Lens
focal length

Unknown
internal

lens guts

Figure 3.8

An iris diaphragm is used to adjust the

aperture inside the lens. The diaphragm

is open on the left for a wide aperture,

and it’s closed down (but not all the way)

on the right for a smaller aperture.Lens body

Diaphragm

Wide
aperture

Narrow
aperture
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Smaller apertures yield larger f-stop values. So an aperture that narrows down to

a diameter of only 2.5mm gives you f/22 in a 50mm lens. Very little light is coming
through the lens with such a high f-stop value.

As a ratio, the f-stop values are equivalent for all lens, regardless of the focal
length. For example, if you have a 200mm telephoto lens, an aperture diameter of
50mm is equal to f/4. Figure 3.10 tries to clarify this concept. Here are the common
f-stop values:

Focal Length/Aperture Ratio

1.4 2.0 2.8 4 5.6 8 11 16 22

N o t e : A lens’s focal length does not always equal the lens’s actual size. Due to fancy optics inside, the

lens is usually shorter than its given focal length. But optically, the focal length appears as measured.

Figure 3.10

Various lens focal lengths, aper-

tures, and f-stop ratings

50mm lens

25mm
Aperture
Opening

50mm
25mm

= f/2

24mm lens

12mm
Aperture
Opening

24mm
12mm

= f/2

50mm lens

4.5mm
Aperture
Opening

50mm
4.5mm

= f/11

120mm lens

15mm
Aperture
Opening

120mm
15mm

= f/8

light

light

light
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What is important with all this gobbledygook? Simply understand this: Large
f-stop numbers mean smaller apertures; small f-stop numbers mean wider apertures.
(In math, that makes sense because the larger the denominator, the smaller the fraction.
That is, f/4 is larger than f/22.)

Even if you understand all this stuff so far, the point of the f-stop has little to do
with the amount of light entering the lens. True, f/1.8 allows more light in than does
f/11. But so what? Changing the exposure time easily compensates for the presence or
absence of light.

The reason for an adjustable aperture is not about light at all. No, it’s about
focus. Specifically, the diaphragm controls something called the depth of field. That’s an
important issue for this book, and it’s covered later in this chapter.

N o t e : The maximum f-stop value is often used to rate how “fast” a lens is.You’ll note that different

lenses have different maximum f-stop values. One might sport f/2 while another might have f/1.4 or even

f/1.2.The lower the value, the “faster” the lens—but also the more expensive it is.

Using the Correct Shutter Speed

The shutter is the device that shields the camera’s film from the light of the outside
world. When the shutter is open, the film—or in a digital camera, the CCD chip that
captures the digital image—is exposed to the light passing through (and focused by) the
lens. When the shutter is closed, no light passes through. Normally the shutter is closed
except for when the picture is snapped and the film exposed.

N o t e : In an SLR camera, opening the shutter blanks out the viewfinder. For the brief time that the

shutter is open, you won’t see anything. Some folks notice this, and others don’t.

Very cheap cameras have a fixed shutter speed. Those antique Kodak Brownie box
cameras used a simple spring-loaded shutter that exposed the film for about 1⁄60 second
no matter what the light conditions. Even today, disposable cameras use the same type
of system.

Midrange cameras use a light sensor to electronically adjust the shutter speed to
certain preset values. Even high-end cameras use such a sensor, though the range of
shutter-speed values is wider. In fact, it’s that light sensor that automatically turns on
the camera’s built-in flash when necessary.

With the type of digital camera recommended for this book, the shutter-speed
value must be adjustable manually or have a manual override to the automatic adjust-
ment. Either way, the shutter speed’s value is measured in seconds or fractions of a sec-
ond. The value represents the duration that the camera’s shutter is open, allowing the
image to be exposed to light.

Common shutter-speed values (in seconds) are set in increments as described in
this list. Even so, some cameras may sport in-between speeds not listed in the table.
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Common Shutter-Speed Values

N o t e : Some cameras have a speed setting of B or Bulb. In that mode, the shutter is kept open as long

as the button is being pressed.The B mode is used for very long time exposures, for example, for nighttime

shots or photographs of lightning.

When set in automatic mode, a digital camera selects a shutter speed and aper-
ture value based on information from the light sensor. The speed value is set in con-
junction with the lens aperture to properly expose the image.

Note that there is a balance between aperture and shutter speed, which is neces-
sary in order for enough light to pass through the lens and properly expose the image.

When a smaller aperture is being used (f/11 or f/22), a longer exposure time is
required for the shutter speed. Wider apertures (f/2 or f/4) allow more light in through
the lens, so a shorter shutter speed can be selected. But there’s more to it than that.

Fast shutter speeds are best for capturing action images. For example, a sports
photographer wants to use the fastest shutter speed they can get away with. That’s
because most sports involve movement, and the idea is to freeze a moving object in
motion with a shutter speed of 1⁄500 or 1⁄1000 of a second. Anything slower, and the image
will blur—which might be an interesting effect, but often not what is wanted.

Slow shutter speeds can do two things for you. First, they allow you to capture
images in low-light situations. Combined with a tripod to hold the camera steady, you
can set up a 1- or 8-second exposure, bringing enough light into the camera to get
detail in even the darkest situations.

N o t e : Obviously, for longer shutter speeds, it helps if the object you’re photographing is relatively sta-

tionary. It’s also a must to mount the camera on a tripod. A human being cannot hold a camera still for any

shutter speed less than 1⁄6 0 of a second.

The second advantage of a slower shutter speed is that it lets you use a smaller
aperture to properly get a wide depth of field for your photographs. That subject is
covered in the next section.

For taking product shots, adjusting the depth of field is the best reason to mess
with the aperture and shutter speed. Beyond that, you might find yourself adjusting the
shutter speed to put more light on your subject. For example, if your photograph
comes out dark or needs more light, you can halve the shutter speed to let more light
expose the image. That’s simpler than hauling in more lights, and “keeping it simple” is
one of this book’s basic rules.

8 seconds

4 seconds

2 seconds

1 second
1⁄2 second
1⁄4 second
1⁄8 second

1⁄15 second
1⁄30 second
1⁄60 second
1⁄125 second
1⁄25 0 second
1⁄50 0 second
1⁄10 0 0 second
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Automatically Setting the Exposure

In cameras with automatic exposure, the camera sets both the aperture and shutter speed. First,
the light coming into the lens is measured and the exposure calculated. Second, an aperture is
selected along with a matching shutter speed to equal the exact exposure. How does the camera
know which settings to choose? It doesn’t. It just guesses.

On some automatic cameras, you can choose whether to prioritize the aperture or shutter speed.
You can do so manually or by choosing the type of photograph you’re taking. For example, the
camera may have a “sports” setting. In that mode, the shutter speed is prioritized and set to a fast
value. To compensate, the aperture is adjusted accordingly so that the film is properly exposed.
Likewise, the camera may have an indoors or low-light setting; in that case, the aperture is set
wide open and the shutter speed is set longer to compensate.

All these settings work because of the relationship between the aperture and the shutter speed.
For example, an automatic camera determines the exposure is f/5.6 at 1⁄125 of a second. The same
amount of light comes into the camera if you open the aperture to f/4 and increase the shutter
speed to 1⁄250 second. Likewise, you can close the aperture to f/8, but you must decrease the shut-
ter speed to 1⁄60 second. (See the following illustration.)

Continued on next page 

All settings expose the film with the same amount of light.

“Normal”
Faster shutter/

more open aperture Even faster shutter

“Normal”

f/stop shutter speed f/stop shutter speed f/stop shutter speed

f/stop shutter speed f/stop shutter speed f/stop shutter speed

Slower shutter/
more closed aperture Even slower shutter
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Automatically Setting the Exposure (Continued)

You make these kinds of adjustments for three reasons. The first reason is simply to drive you nuts.
It’s the reason automatic cameras are sold in the first place; back in the old days, you had to under-
stand this stuff plus use a separate device called a light meter to help you choose an exposure. It
was insane.

The second reason to adjust the values is to increase or decrease the shutter speed depending on
the subject. As was stated earlier, you might want a fast shutter speed when photographing sports
or something that moves quickly. Or you might want to capture flowing water, which looks better
when taken with a long exposure.

The final reason is to adjust the aperture and increase the depth of field. When you narrow the
aperture, you must slow down the shutter to compensate for the lack of light. Conversely, opening
the aperture to narrow the depth of field requires adjusting the shutter speed.

Shutter speed gets quicker, the aperture opens; shutter speed gets longer, the aperture closes.

Understanding Depth of Field
The optics inside a lens are designed so that objects at an exact distance from the cam-
era are in perfect focus. The better lenses have the focal distances printed right on the
focus ring. Whether you’re focusing automatically or manually, you can confirm the
distance by looking at the lens.

According to the lens’s markings, objects can be in focus from a few feet on up
to infinity. (Funny thing: beyond a certain distance, all objects are considered “in
focus,” which isn’t exactly true, but it’s how the human eye interprets and is comfort-
able viewing objects far away.)

Of course, you’ve taken pictures before, and you realize that the spot where
items are in focus isn’t an exact location. Oftentimes, objects immediately before and
behind the item you’re focused on appear to be in focus as well. That range before
and behind the object in focus is referred to as the depth of field. Figure 3.11 illus-
trates how this works.

In Figure 3.11, the camera is focused exactly on the front of object B. Even so,
because of the large depth of field, both object A, close to the camera, and object C,
away from the camera, appear to be in focus.

The depth of field seems like a wonderful concept, and it is. But what makes it
truly useful is that you can adjust it. You can make it shallow or deep. The key is the
aperture.
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Figure 3.11 A depth of field exists before and after the exact point where an object is in focus.

When the lens’s aperture is set wide open, such as f/4 or greater, the depth of
field is very shallow. Only the objects that the camera is directly focused on will be in
focus. Things in front of and behind the image will be out of focus.

In Figure 3.12, the dessert in the foreground has an extremely narrow depth of
field. The objects behind the dessert are out of focus, visible yet obscured. Yet this is
the effect that the photographer wanted, and it draws your attention to the items in
focus while downplaying the environment surrounding them.
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When the lens’s aperture is set narrow or closed, such as f/11 or smaller, the
depth of field is great. In that case, objects in front of and behind the item in focus also
appear in focus.

Now you should understand why it’s necessary to have a digital camera with a
manual override on the shutter speed and aperture. Only with such an override can you
manually adjust the aperture and set the proper depth of field. Remember: With a
larger aperture (f/4, f/2.8, f/2, f/1.4), you get a shallow depth of field. In Figure 3.13, an
aperture of f/1.8 narrows the focus to the pawn up front while the background pieces
are rendered out of focus. The shutter speed was adjusted faster to compensate for the
wide-open aperture.

With a smaller aperture, you get a great depth of field. Just about everything in
the picture will be in focus, as shown in Figure 3.14 in which the entire chessboard is
in focus. It’s the same shot setup as shown in Figure 3.13, though the aperture has been
closed to f/11 and the shutter speed cranked down to compensate.

Figure 3.12

A very shallow depth

of field
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Figure 3.14

Deep depth of field

Figure 3.13

Shallow depth of field
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N o t e : A good way to remember which aperture gives you greater depth of field is that people who

need glasses often squint without them. Squinting helps reduce the eye’s aperture, increasing the depth of

field to bring more items into focus.

Positioning the Camera
An important part of snapping the right image is making sure that the camera is in the
proper orientation, that the image is framed, and that the right amount of zoom is
applied. You want to set up the item being photographed, then set up the camera, and
then set up the lights. Only after that preparation are you ready to take the picture.

N o t e : Obviously having a tripod here is vital! Once set, the camera must not move. Otherwise, you

introduce a whole slew of new random variables into the equation. Isn’t there enough to worry about with-

out having to add in camera jiggle? Yep! Get a tripod!

Setting the Right Angle

Ideally you want to photograph your object head-on, showing the object in an upright
position but not directly facing the camera. You want to set the item off at an angle so
that a bit of one side is showing. If the item is small, showing some of the top is also a
good idea.

Simply set up the object in the environment or on an infinite horizon, whichever
you feel is best to set the emotional tone for your image. 

Unless the object is flat, you want to show that it has some depth, so angle the
object off to one side. The angle is really only necessary to show that the item isn’t flat.
In fact, when the item is flat, you just want to take an image of it head-on.

In Figure 3.15, the candle lacks depth and definition. Although you can make
out the frogs perhaps, the object’s full description isn’t really present. On eBay, you fre-
quently find a series of several such images: front, back, and both sides, when one
clever camera angle would do instead.

In Figure 3.16, you see the same object as in Figure 3.15, but with the camera
angle raised a bit and the object skewed to the right. This helps the buyer appreciate
the object’s height and depth, the object’s overall shape, and that it is, in fact, a candi-
date for purchase. Moving the camera gives the object dimension and weight that a
head-on, thoughtless angle doesn’t capture.

There are no specific rules as far as camera height is concerned. Obviously you
don’t want to go too high above an object or you make it appear tiny. And you don’t
want to go too far to the left or right without encountering the same head-on problem.
Yet as long as you can capture the object’s depth and overall shape, anything else as far
as setting the angle is concerned is simply a matter of taste and style.
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N o t e : If an item is cylindrical or spherical, you definitely want to set a higher angle than you normally

would.That will help capture the circular shape of the object.

Figure 3.16

A better angle on the same frogs

Figure 3.15

A dead-on angle makes this

candle appear flat and without

dimension.
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Zooming (or Not)

It’s most likely that your digital camera has a zoom lens. That’s great! But the zoom
does affect your image and has the potential to make even the most beautiful item
look ugly.

The main thing to avoid is the wide-angle setting on the zoom lens. That’s when
the lens is “pulled back” to reveal the most information. Such a wide angle distorts
items up close, making them look disproportional, as shown in Figure 3.17.

The opposite end of the zoom lens, the narrow angle, is much better for taking
product shots. When “zoomed in” all the way, the optics in a zoom lens tend to push
out the edges on an object. On a person, this makes their face look more natural. For a
product, it can help pull in details on the side, as shown in Figure 3.18.

Figure 3.18

The same setup as Figure 3.17, but

with the tripod set back and the cam-

era zoomed in. The objects appear

more natural.

Figure 3.17

With the lens set on wide angle, this

photograph appears distorted and,

well, ugly.
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The best way to encapsulate this information is to say that it is not necessary to
put the camera very close to the image you’re capturing. In fact, keeping the camera at
a modest distance and using the zoom lens to help get closer renders a better picture.

N o t e : The only time you want to avoid using a closer (zoomed-in) angle is when you need a tight

depth of field.That’s because the depth of field increases with the lens length. For the most dramatic shal-

low depth of field, do not zoom in on an object. But when you need the widest depth of field, zooming in

helps increase the field size.

Framing the Image

Finally there comes framing. That’s the act of looking at the edges of the image that the
camera previews. You first want to ensure that the image you’re photographing is well
inside the frame. You don’t want to commit the sin of “chopping off the heads” and
making your image look incomplete or sloppy.

Try to keep some distance between the edges of the frame and your object. You
don’t want the object to appear cramped. On the other hand, you don’t want the object
to be so tiny in the image that the viewer has trouble recognizing it.

Also watch the edge of the image to ensure that nothing annoying or unwanted
is in the background. For example, if your item is sitting on a nice sheet of pretty wrap-
ping paper, you don’t want to photograph the edge of that sheet and the ugly table
beneath it in the background.

In Figure 3.19, you see a combination of efforts described in this and previous
sections, all of which are applied to make a good image.

Figure 3.19

The proper lighting, depth of field,

angle, zoom, and framing are combined

to take this image.
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The image is set up right before the camera and lit using natural light that shows

off the shape of each cookie. The depth of field has been set to keep the background
out of focus, helping the buyer concentrate on the cookies. The image is framed so that
the stack of cookies is centered.

When you set up your shot, and you focus, frame, zoom, and set exposure, keep
in mind the background details, and prevent them from distracting from or lining up
with the object in the foreground. When items do match up, and tangents are created,
move the object or adjust the camera so that such a thing doesn’t happen.

N o t e : In order: set the camera, and then set the item being photographed. Zoom in on the item. Finally,

frame the image. After that, you can work on lighting and perhaps even adjust the angles, zoom, or framing

a bit as needed.

Setting Image Resolution
Your digital camera has an image-resolution setting. This tells the camera how many of
those silly megapixels to assign to the image being taken. For example, when snapping
birthday pictures for e-mail, you can choose the low, Web, or e-mail setting. That way,
the images look great on a computer screen, and they don’t take a day and a half to
send over the Internet.

For taking pictures of products that sell, you want to use the camera’s maximum
resolution. This won’t be the final resolution you use for the images, but for taking the
images, you want pixels! The more the merrier. That’s because more pixels equals more
information and the easier it is to edit the image later (should you have to) and to pro-
duce a higher-quality final result—even if that final result has a reduced resolution.

How big is too big? As long as the image can fit on the media card, it’s not too
big! Set up your camera to snap images at the highest resolution.

N o t e : When it comes to professional photography, information is the key.When shooting on negative

film, some pros slightly overexpose; when shooting on transparency film, they will slightly underexpose.

Both methods are used to get more of that “juicy information” on the film.The transparency method applies

to digital film; higher resolutions get more of those precious pixels into the image. Information is the key to

producing a quality end result. Or, to put it another way, you can’t fake what’s not there.

Lighting Your Object
Yes, you will need a modicum of light to illuminate the object that you’re photograph-
ing. It almost goes without saying. The inspiration here is the sun, which douses the
world daily with light and forms the basis on which we view things in the real world.
The better you can use or emulate the sun—especially the type of light produced on an
overcast day—the more natural your photographs appear. That’s exactly what you
want. Well, that, and to be able to properly see the subject.
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Shedding Some Light on Your Subject

You can light the object that you’re photographing in many possible ways, but there is
one definitely wrong way to do it: with your camera’s flash. If you can, disable your
camera’s built-in flash. Turn it off. Do away with it. Forgo it. That is the worst, most
unattractive light you can shed on your subject.

Compare Figures 3.20 and 3.21. Can you tell just by looking which was taken
using the camera’s automatic flash? Which looks more natural? Which item would you
rather buy?

Figure 3.21

The same setup as Figure 3.17,

but properly lit

Figure 3.20

The camera’s automatic flash

wrecks this image.
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N o t e : Refer to your camera’s manual for instructions on disabling the built-in flash.The flash control

may be on the camera’s LCD menu, or it could be a button labeled with a lightning-bolt–like symbol.

Instead of your camera’s flash, use lamps and diffusion material (covered in
Chapter 2) to illuminate your subject matter naturally. There is no right or wrong way
to do this, but there is a good way to start.

Use two lamps. Position each at a 90-degree angle to the left and right of your
subject at approximately a 45-degree elevation. Figure 3.22 attempts to illustrate this
approach. The end result may not be what you want, but you will find that the object
is evenly illuminated. And it’s a good place to start.

When you have the lamps set up, look through the camera to see your object.
Check to ensure that it’s properly lit. But also look for annoying glare. If you see
glare through the viewfinder, it will be there in the final image. Refer to the next
section.

Figure 3.22

A good way to start positioning

the lamps

Object
(top view)

Object
(side view)

90°

45°

Camera
(on tripod)

Camera
(on tripod)

Lamp Lamp
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Remember that you can also light an image with white paper or white foam
core, as recommended in Chapter 2. Prop up some foam core out of camera view to
help reflect or bounce some light from the main light source back onto the object
photographed.

Another helpful tool in lighting your subject is the sun itself. Feel free to take
advantage of a bright window.

Finally, don’t forget that you can move your lamps! That’s why it’s recom-
mended that you find and use lamps with handy clamps on the back. You can add
more lamps if you have them, or you can remove a lamp if it’s unnecessary or gets in
the way.

Eliminating Reflections and Glare

As you light your subject, you need to constantly check through the camera to ensure
that there are no obnoxious reflections or glare. You can deal with reflections in two
ways. First, move the light causing the reflection. Move it in small increments because
determining the angles and such is really guesswork.

Second, use black paper or black foam core to help block reflections off shiny
objects. After determining the source of the reflection, mask it by using the black
paper—essentially covering up the reflection’s source.

Figure 3.23 shows a thimble-sized glass with a glaring reflection inside the top
left of the lip. After checking in the camera, the source of the reflection was deter-
mined, and a piece of black paper hung to mask the light, effectively eliminating the
glare. The setup is shown in Figure 3.24, and the result is shown in Figure 3.25,
where the glare is gone.

Figure 3.23

A bad reflection detracts

from this image.
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Figure 3.25

The same glass, minus the glare

Figure 3.24

How the glare was eliminated by

using a black card

Object
(top view)

Window
(top view)

with direct rays

Object
(top view)

Window with
shower curtain liner

taped over panes
to diffuse rays

Black
card
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For other sources of glare, you’re going to need patience and a lot of trial and
error. You can choose to move either the subject or the lamps. However, when you’re
using more than one lamp, you’ll find it a lot easier to move the lamps than to con-
stantly move the subject. Sometimes it can help to remove a lamp and just go with a
longer exposure. (That means decreasing the shutter speed, say from 1⁄30 to 1⁄15.)

And do keep in mind that there is no proper position for the lamps. The infor-
mation provided here will help you get started. After that, it’s what looks good, what
works, and what produces the best image.

N o t e : Keep in mind that it’s always best to eliminate the glare before you take the picture, not to elimi-

nate it in the photo-editing program.

Dealing with Shadows

Shadows naturally fall from anything that you’re lighting and photographing, but
you don’t want the shadows to distract or to look like something else (puddles of oil,
for example). One reason for diffusing your lamps is to create a nice soft shadow
behind or to the side of your subject. That’s acceptable. But shadows directly on a
subject are not.

When you take a picture of a person out under the blazing noonday sun, that
person will have an obnoxious under-the-nose shadow. Most amateurs don’t notice
this, but it’s the bane of professionals. Such ugly shadows are also something you
should look for when you light your subjects.

The best way to eliminate a shadow is to add more light. But moving your lights
can also move or reduce the shadows. Move a lamp up higher, and the shadow gets
shorter. Lower a lamp or use a white card to bounce light, and you can help fill under
edges like a face under the brim of a hat.

N o t e : Do not light your subject from the bottom. It looks extremely unnatural.

Beyond the shadows on your object, remember that the object itself will be cast-
ing a shadow. This is fine and normal. Most items you light will have what’s called a
drop shadow. For the best look, keep the size of that shadow about 1⁄3 the size of the
object that you’re photographing.

You may recall the small clock you saw earlier in this chapter (see Figure 3.5),
which demonstrated the good use of a tripod. That shot also started out with some
nasty shadows from the daytime sun shining through a window (see Figure 3.26).
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Figure 3.26 The sun shining through the window (left) casts some shadows on our subject (right).

Remember your handy shower curtain liner? You may also use it to help with
natural lighting conditions and eliminating shadows (see Figure 3.27).

Figure 3.27 Another slice of shower curtain helps eliminate daytime shadows.

N o t e : It’s also possible to eliminate all shadows and surrounding material around an object in a photo-

editing program.This is demonstrated in the next chapter.

If you’re having a great deal of trouble eliminating a shadow, as a last resort you
can manually adjust the camera so that the image is overexposed. To do so, leave the
aperture setting the same but slow down the shutter speed, say from 1⁄60 second down
to 1⁄30 or 1⁄15. The extra exposure will help pull in detail for the shadow areas. The image
can then be adjusted using photo-editing software.

Shooting Objects Outside

When you’re outside, the sun is your lamp. And like the lamps in your photo studio,
the sun can be moved. Or, to put it another way, you can wait for a specific time of day
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when the sun is positioned just right for your photograph. This is perhaps the most
important decision to make when shooting outside: where is the sun? or what is the
best time of day to take the picture?

Again, wait for an overcast day to take a picture outside. That’s the best 
light you can have, and it utterly eliminates hard shadows. Figure 3.28 was taken 
on an overcast day. Notice the absence of annoying shadows. In fact, there is 
almost no shadow at all, which means that all concentration is on the tray and
chopsticks.

Figure 3.28 A good picture taken on an overcast day

When overcast days aren’t possible, the best time of day to take pictures is dur-
ing what professional photographers call the magic hour. It’s a chunk of time, any-
where from 20 to 40 minutes long, just after the sun goes down. At that time, the light
outside is very soft. The sky seems to glow. And there are no shadows. This is when
most car advertisements are shot. It’s a great time of day to capture a large object or
anything that you need to take a photograph of outside.

N o t e : If you do plan to photograph a car, be aware of reflections. Nothing is more distracting than an

ugly reflection on a car’s door or in a window. In fact, there are professionals who only photograph cars.

Doing it right is a rare talent.

4381ch03.qxd  12/4/04  0:20  Page 67

TEAM LinG - Live, Informative, Non-cost and Genuine !



4381ch04.qxd  12/4/04  0:57  Page 68

TEAM LinG - Live, Informative, Non-cost and Genuine !



69

4
In This Chapter
Photo-editing basics
Fixing color, tone, and balance
Sharpening
When you want to blur
Compositing
Watermarking

Photo Editing

The digital darkroom is anything but dark. Gone

are the days when developing film was a chemical

process. No more baths. No more fixer. No more

groping in the dark to thread film reels, maintain-

ing dust-free cabinets, or washing your prints.

Photography is now totally digital. 

The images in your digital camera are already

fully developed. There they sit ready for immedi-

ate use, but most of the time it’s necessary to run

them through some type of photo-editing applica-

tion. You use that software to refine, crop, rotate,

or make adjustments that hone the image to get

the perfect result—tasks that would be tedious

and nearly impossible in the chemical labs of old.

This chapter covers some popular photo-editing

techniques you can use to help fix up and enhance

your images. 
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Basic Photo-Editing Techniques
Today’s photo-editing software is capable of amazing things. Most programs boast
about libraries of routines, filters, techniques, tools, and a host of helpful options
designed to let you do just about anything possible with your image. Mastering such
software takes years. No one book could possibly cover everything these programs
do, but the good news is that you don’t have to use all the tools to get the results 
you want.

It’s perfectly okay to use just the basics of your photo-editing program. That
is, you should understand how to save, zoom, rotate, crop, and resize and have a
working knowledge of a few other handy tricks covered in this chapter. That’s prob-
ably all you need to know to get the results you want—especially if you followed this
book’s advice and did most of your work with the camera as opposed to “fixing it
later.”

These basic tools are available in just about every image-editing program. The
steps that follow are specific to Adobe Photoshop Elements 3, but the end result should
be the same: a better version of your image.

N o t e : See Chapter 7 for information on getting the images out of your digital camera and into your

computer.

Zooming Your Image

The basic tool in any photo-editing program is the Zoom tool. Zoom is different
from most other photo-editing tools in that it does absolutely nothing to modify 
the image. Instead, it merely changes how you see the image on your computer’s
monitor.

When an image is first loaded into your photo editor, the Zoom tool may auto-
matically reduce the image size so that the whole picture appears on the screen. The
zoom percentage is displayed either on the application’s title bar or on the title bar of
the window containing the zoomed image.

In Figure 4.1, the image is shown in the window at 68 percent resolution.
Because the image would be too large to fit on the entire screen at 100 percent resolu-
tion, the program automatically zooms out to show you the entire thing.
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Here’s how you use the Zoom tool to magnify an image and inspect details:

1. Click the Zoom tool button, or in Photoshop Elements, press Z on your 
keyboard.

Note how the mouse pointer changes to the Zoom tool , a magnifying glass
with a + (plus). The plus means “zooming in!”

2. Click the Zoom tool on a specific part of the image to make that part appear
larger. And you zoom in on that part of the image.

N o t e : You can use the mouse pointer to direct the zoom.Where you click the mouse becomes the cen-

ter of the next window.

3. Continue clicking until you can see the boxy color squares, or pixels that com-
pose the image.

Most photo-editing programs let you zoom in to about 1600 percent. That’s 16
times magnification on the image.

When you’re done zooming and can zoom in no further, the plus disappears
from the mouse pointer’s magnifying glass. That’s the all-done signal. 

N o t e : At some point, when you’ve zoomed in enough, you can use the Hand tool to slide the image

around inside the window.The keyboard shortcut for the Hand tool is to press and hold the spacebar.Then

use the mouse to grab and drag the image around.

To zoom out, continue with these steps:
4. Choose the Zoom tool again (if needed).

Figure 4.1

Images shown in a

photo-editing pro-

gram can be

viewed larger or

smaller by using

the Zoom tool.
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5. Press and hold Alt (Windows) or Option (Mac) on your keyboard to change the
mouse pointer’s magnifying glass, adding a minus sign. That means “zooming out!”

6. Click the mouse to reduce the image in size and decrease the zoom percentage.

You can continue to use the Alt+click or Option+click technique to zoom out, but
there is also a shortcut for zooming: press Ctrl+0 or #+0. That’s the Fit On Screen com-
mand that quickly lets you “step back” and view the image as it best fits on the screen.

The Fit On Screen command also appears in the View menu, which you should
check out for other handy commands that help set the size of the image you see on the
screen. Table 4.1 lists the handy commands found in Photoshop Elements.

� Table 4.1 Zoom Commands in Photoshop Elements

Command Keys (Windows) Keys (Mac) What It Does

Zoom In Ctrl+= #+= Enlarges the image in the window (but does not
change the image’s size)

Zoom Out Ctrl+– #+– Reduces the image in the window

Fit On Screen Ctrl+0 #+0 Zooms the image to fit entirely inside the window

Actual Pixels Alt+Ctrl+0 #+Option+0 Displays the image on a 1:1 ratio of its pixels to
your monitor’s pixels.

N o t e : If you need to zoom in tight on a specific area, select the Zoom tool and then click and drag the

mouse over that area.The area you select with the mouse/Zoom tool is then displayed as large as it can be.

Most photo-editing programs also sport a Zoom input box where you can man-
ually enter a zoom percentage, or you can use a slider or preselect zoom percentages
from a menu to set the zoom.

No matter how you do it, you use the Zoom tool to make the image appear
larger or smaller on the screen. But do remember that this zooming about does not
change the image’s size, any more than looking through a magnifying glass at an insect
changes that insect’s size.

“Why Doesn’t the Image Appear on My Monitor at 100%?”

Knowing why the image you see on your monitor is so large has to do with the image’s resolution.
The issue is pixels, or those tiny dots that compose digital images. With some images, the pixels are
packed in really tight, say 600 or more to the inch. Some images have a lower resolution.

Your computer’s monitor has a resolution of either 72 or 96 pixels per inch, depending on whether you
have a Mac or PC, respectively.When you display an image taken at a resolution of 600 pixels-per-inch
(or dots-per-inch, or dpi) on a monitor that can show only 72 pixels per inch, the result is one huge
image. By using the Zoom tool, you can reduce the image’s visible size in your photo-editing pro-
gram, so that you can see it all on the screen at once.This works regardless of the image’s resolution.
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Rotating Images

There is no rule that says you have to hold a camera level with the ground, though tra-
dition and common sense make people do just that. Still, the camera does have two
legitimate orientations: landscape and portrait. A basic photography class teaches you
to use the landscape mode for taking pictures of left-right things (such as landscapes)
and the portrait mode for taking pictures of up-down things (such as people).

When you take a picture in portrait mode, however, your digital camera prob-
ably won’t recognize that it’s been turned 90 degrees. So when you view the image in
your photo-editing program, it appears sideways. The way to get it back to a proper
orientation is to rotate it.

Photo-editing programs come with a Rotate tool, but that’s primarily used to
rotate items in layers for special effects. When it comes to rotating an image from land-
scape to portrait mode (or vice versa), you’ll want to use the traditional Rotate com-
mands found in a menu. In Photoshop Elements, the commands are on the Rotate
menu (choose Image > Rotate). The five handiest commands are shown in Table 4.2.

� Table 4.2 Common Image Rotating Commands

Command Visual Transformation

90° Left to

90° Right to

180° to

Flip Horizontal to

Flip Vertical to

N o t e : To help you remember the difference between Flip Horizontal and Flip Vertical, add the words

around axis to the command name.The Flip Horizontal command flips the image around a horizontal (left-

right) axis.The Flip Vertical command flips the image around a vertical (up-down) axis.

Most photo-editing programs also have a Free Rotate command. Again, that
works best for special effects and is not specifically designed to change the orientation
of the image you’re editing.

For example, you’ve taken an image in portrait mode, which the camera doesn’t
understand, so the result in your photo-editing program is shown on its side, as
depicted in Figure 4.2. To fix it in Photoshop Elements, you can choose Image >

Rotate > 90° Right to display the image in its proper orientation.

Figure 4.2

An image taken in portrait mode,

which needs to be rotated
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Cropping Portions of Images

Cropping is the official name for what you do when you take a pair of scissors to your
photographs. By cropping, you make the image smaller, pull in the sides or top or bot-
tom, eliminate unwanted elements, and reduce the image to what you primarily want
the viewer to focus on.

To crop an image, you use the Crop tool , which has a universal icon. You
drag the mouse over the image to select the part you want to keep, roping it off from
the part you want discarded or cropped away.

To crop an image, follow these steps:

1. Select the Crop tool. In Photoshop Elements, you can press the C key on your
keyboard as a shortcut. The mouse changes to the Crop tool icon. The “hot
spot” is in the center of the cropping tool.

2. Drag the mouse over the area of your image that you want to keep. This works
just like dragging and selecting; start at the upper-left corner and drag the mouse
down to the lower-right corner. Don’t worry about being precise; you can adjust
the crop lines later.

Figure 4.3 shows an image with a chunk selected for cropping. The area to be
cropped appears darker than the area that remains. Also notice how the cropped
area grows eight tiny handles, on the sides and corners of the cropping area. You
can use those handles to fine-tune the cropping area.

3. Use the handles to refine the area. With the mouse, drag one of the eight handles
in or out to resize the cropping region.

N o t e : Not all images you snap will be perfectly horizontal or vertical.When you crop, some background

may still be exposed.To help eliminate that, crop on the inside of the area or region you’re selecting.The idea

is to eliminate all the background.

4. Press Enter to cut the outside, unselected area from the image.

If you change your mind, choose Edit > Undo. Or if you change your mind while
cropping, press Esc to cancel the selection.

Figure 4.3

An area of this image is

selected for cropping.
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Details, Details

When you need a closeup of some detail in your image, first use the Zoom tool to zoom in on that
detail. Second, crop the image to contain that detail. Third, resize the image to a good size. You can
then use both the full image and the detail when trying to sell the product.

Resizing Images

One of the major goofs of folks new to digital photography is not properly sizing their
images. A full-size high-resolution image direct from your camera chews up a lot of
memory and occupies a goodly chunk of hard-drive space. That’s just fine. But you
won’t be selling many items when your visitors on eBay have to wait 20 minutes for a
17MB graphics file to show up in their web browser. You need to resize the image so
that it doesn’t consume a lot of space, is therefore quicker to download, and appears in
a decent size on their computer monitor.

Resizing is simply the act of reducing the number of pixels long and tall in your
image. The end size you want really depends on the destination. I generally recommend
a size of between 300 and 400 pixels on the image’s long end for e-mail or the Web.
Other sources may have other recommendations. If you’re saving an image for a partic-
ular purpose, check to see what’s recommended before you resize.

To resize an image, follow these steps:

1. Choose the Image Resizing command from your photo-editing program. In Photo-
shop Elements, choose Image > Resize > Image Size to open the Image Size dialog
box, shown in Figure 4.4.

2. Ensure that the image’s width and height values are constrained to keep the
image from being distorted when it’s resized.

3. Enter a new value for the width. For example, if you want to reduce the image
width to about 300 pixels, type 300 in the Width box.

When the values are constrained, an equivalent number of pixels automatically
appears in the Height box. You need not manually calculate that value.

4. Click OK to close the dialog box and to set the image to the new size.

Figure 4.4

Resize the image using

this dialog box.
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You’ll have to adjust the zoom as the new image appears at the same zoom per-
centage, but because you reduced the image’s size, it’s now smaller on the screen.

N o t e  : After reducing the image’s size, a good command to choose for viewing the image is Actual Pix-

els. In Photoshop Elements, choose View > Actual Pixels.

If you’re required to size an image based on its file size as opposed to its dimen-
sions, use the values at the top of the Image Size dialog box to help you confirm approx-
imately how much space the image file uses. In Photoshop Elements, for example, it
might say “175.8K (was 18.0M),” which means that the image now uses 175KB of disk
space whereas the original image was 18MB in size.

N o t e : Generally speaking, you don’t want to use the Resize command to make an image larger.This

book recommends taking your pictures at the highest resolution that your digital camera is capable of.

When you do that, you’ll be reducing image size in your photo-editing programs. Although the program can

increase the image size, the results are terrible and not the way you want to showcase the stuff you sell.

Golly! I Goofed!

The easiest way to undo a mistake in a photo-editing program is to press Ctrl+Z (Windows) or
#+Z (Mac), the Undo keyboard command. This shortcut is common to all computer programs.
However, there may be some things that cannot be undone, or perhaps a sequence of things is
done but undoing them turns out badly. In that case, the only thing to do is use the Revert
command.

The Revert command discards the current document and all its changes and modifications and
simply reloads the document you’re working on. Any changes made since the document was last
saved are gone. Such an act is like starting over afresh, and often it’s necessary, which is why most
photo-editing programs come with such a command.

In most photo-editing applications, the Revert command is right there on the File menu. In Photo-
shop Elements, however, choose Edit > Revert To Saved.

Saving in a Specific Image Format

When you’re done torturing your image, or even well before things are just as you
want, consider saving your image to disk. You can choose from many file formats, and
the final format really depends on where your image ends up. For example, if you’re
saving your images to be used by other applications on your computer, the TIFF file
format works well. Printing bureaus also love TIFF, but be sure to check with them to
ensure that you get all the tiny, obscure TIFF options set properly.
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For the Internet, the best format is JPEG. It saves the image in a manner that
preserves all the color and flavor, but allows the image to be compressed to save space.

N o t e : You want to save your image in a new file; do not overwrite the camera original. Keeping the

original is a good thing; see Chapter 7 for more information.

To save your image in a specific format, follow these steps:

1. Choose File > Save As to open the Save As dialog box. The Windows version is
shown in Figure 4.5, and the Mac version in Figure 4.6. Both of them look dif-
ferent, but the steps in each are identical.

2. Set a folder or location in which to save your image file.

The operating system will prefer its own images or the My Pictures folder. It’s
better to keep together images of the items that you plan to sell, so you’ll most
likely want to use another folder or create a new folder. Chapter 7 has the details.

3. Name the image. Use a different name, one other than the original camera image.
In fact, when your camera is in the habit of giving your images numbers for
names, use this opportunity to give your image a nice, short, descriptive name.

4. Choose a format from the Format list. Choose TIFF or JPEG, depending on
where the image is ending up.

Figure 4.6

The Mac Save As dialog box

Figure 4.5

The Windows Save As

dialog box
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5. Click the Save button. A dialog box opens, prompting you for further file format
options.

6. Enter any format options.

For example, for JPEG, you’ll set the quality. High or maximum values are rec-
ommended. In Photoshop Elements, a size preview—as well as download time informa-
tion—is provided at the bottom of the JPEG Options dialog box.

TIFF images also have options, which are set in the TIFF Options dialog box.
Most of the time, you can get away with clicking OK, though if you’re working with a
source that requests certain TIFF options—such as LZW compression—you can set
those options in the dialog box.

Remember that as you continue to edit after saving, you’re editing the saved file,
not the original. This is a good idea; keep the camera original on disk untouched. That
way, if you ever really screw up, you can start over again with that image. 

N o t e : As you work, resave your image to disk. Choose File > Save or press Ctrl+S or #+S.

In What Order Should These Tools Be Used?

When you’re photo editing, you should do as much image manipulation as you can before you
crop, resize, change the resolution, or save your image in another file format.

Remember, the key is information. If you’re adjusting color levels or editing your image, you want
lots of those juicy pixels to play with. The more the better! Only when you’re done with your edit-
ing chores should you crop, reduce resolution, and perform other tricks that get rid of all those nice
pixels.

Fixing the Color, Tone, and Balance
One of the weaknesses of human eyes is that they interpret almost any light they see as
white. On a bright sunny day, inside a classroom, by the fireplace, or at the kitchen
table, all that light looks white. In the real world, however, light comes in a spectrum
of colors. This is evident when you view your digital images and discover that they’re
suddenly tinted green or orange. No, there’s nothing wrong with your camera; that’s
just the real color of the light present.

Especially if you’re using common lightbulbs in the lamps that are recom-
mended in Chapter 2, you’ll soon discover that all your images are cast with a dull
orange hue. That’s probably not the professional results you were expecting. But fret
not. Handy commands are available in your photo-editing software to fix problems
with tone, contrast, brightness, and other light issues. These are covered in the sec-
tions that follow.
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The Nifty Auto Smart Fix Command

Photoshop Elements has one command that does it all. It’s automagic! Choose Enhance >

Auto Smart Fix, or press Ctrl+M (Windows) or #+M (Mac). In a flash, your image is
electronically wiped clean of all foul color imbalances, contrast, brightness, or other
strange defects of light and mystery. Yes, it’s the magic button you’ve been waiting for.
(If only such a thing existed to clean up your word processing, eh?)

Yes, there is nothing wrong with this type of quick fix. In fact, only if you really
know what you’re doing should you mess with any detailed image adjustments.

Then again, sometimes Auto Smart Fix just isn’t that smart. Remember that
Ctrl+Z (Windows) or #+Z (Mac) is the Undo key. You might want to try some of the
effects in the following sections instead of Auto Smart Fix. Picking and choosing
which effects to use might render a better end result.

Fixing Off-Color Images

The best way to address issues related to the image’s overall color is to set the color
balance. This is how you can offset the orange tint generated by household lightbulbs
or the greenish tint produced by fluorescent lighting.

For example, suppose you have an image such as the one shown in Figure 4.7.
To fix that orange tint in Photoshop Elements, choose Enhance > Auto Color Correc-
tion. The orange tint is removed, yielding the result in Figure 4.8.

Similar commands to Auto Color Correction can be found in other photo-editing
programs. The name may be different, but the result is the same.

N o t e : Using a command such as Auto Color Correction yields a better image than general-purpose

commands such as Auto Smart Fix.

Figure 4.8

The same image as Fig-

ure 4.7, but after a quick color

correction

Figure 4.7

Ugly orange in this image

comes from the standard

lightbulbs used.
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Setting the Levels

Unlike color balance, which affects the entire image, levels can be adjusted to affect
specific tones, shadows, highlights, or colors in an image. By using a command to “set
the levels,” you can adjust specific elements in your image without affecting others. In
fact, setting the levels may be all that’s needed to fix a discolored, flat, or just plain
wrong-looking image.

To automatically set the levels in Photoshop Elements, choose Enhance > Auto
Levels. You’ll notice the image immediately clears up: shadows are dark, highlights are
light, and the colors look right.

You can also manually set the levels in Photoshop Elements. Follow these steps:

1. Choose Enhance > Adjust Lighting > Levels to open the Levels dialog box, as
shown in Figure 4.9. This dialog box is similar in both Windows and on the Mac.

2. Ensure that the Preview check box is selected to see the effects your changes
have updated in real time on the image you’re editing.

3. Choose RGB from the Channel spin box. RGB affects all colors in the spectrum.
You can also choose individual colors to adjust from the Channel spin box.

4. Click the Set Black Point eyedropper. It’s the first eyedropper in the lower-right
corner of the Levels dialog box.

5. Locate the darkest spot in your image or the spot where black should be the
blackest, and click it. The eyedropper “picks up” that color and immediately
shifts the image so that the part you clicked is now the blackest. You’ve just set
the black tones for the image.

6. Click to choose the Set White Point eyedropper from the Levels dialog box. It’s
the last eyedropper.

7. Click the whitest spot in your image to set the white values.

At this point, the image should look good. You can continue by choosing the Set
Gray Point eyedropper and clicking a midtone value in the image. Or you can
individually adjust each of the colors present in the Channel spin box. But what
you see on the screen should look good now.

8. Click OK to confirm and keep the changes that you’ve made.

Figure 4.9

Setting individual levels

for an image
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N o t e : You can click the Reset button to undo the changes and continue to mess around in the Levels

dialog box. Or you can click Cancel to cancel everything.

Fixing the Brightness and Contrast

Contrary to popular myth, adjusting the brightness on an image after it’s taken does
not increase the amount of light on the subject. You can do this only when you take the
picture, and then it helps to slightly overexpose if you want more light. But in a photo-
editing program, brightness and contrast serve two different but often related functions.

Brightness controls the overall light and dark values in an image, as well as the
intensity of the colors, making the whole image watery and light or intense and dark.
Contrast sets the difference between each light and dark value, to where full contrast
yields an image with all-black or all-white parts or an image with no contrast that is a
medium muddled gray.

As with other values set in your photo-editing program, the best way to set the
brightness and contrast is to have it done automatically. In Photoshop Elements, you do
so by choosing Enhance > Auto Contrast.

It’s also possible to manually adjust the brightness and contrast. In Photoshop
Elements, choosing Enhance > Adjust Lighting > Brightness/Contrast opens the Bright-
ness/Contrast dialog box, as shown in Figure 4.10. With the Preview option checked,
you can manually adjust the sliders beneath Brightness and Contrast to see what effect
it has on your image.

N o t e : It’s probably a good idea not to mess around in the Brightness/Contrast dialog box. Unless you

really know what you’re doing, you’ll adjust brightness until either all the true darks or all the true whites

are gone from the image. Similarly, misadjusting the contrast can remove important detail from an image or

transform a good picture into a muddled mess.

Targeting Brightness and Contrast

Of course, brightness and contrast aren’t entirely evil. Sometimes you can target which
parts of an image to brighten up and fix, while leaving the rest of the image untouched.
Indeed, when folks get into trouble with brightness and contrast is when they apply
these features to the entire image.

As an example of targeting an effect such as brightness and contrast, take a look
at the image in Figure 4.11. 

Figure 4.10

Setting brightness and

contrast
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It’s not really a bad image, but the display on the iPod just blends in with the rest
of the device. It doesn’t stand out. It needs to be a wee bit brighter and maybe have a
teensy bit more contrast. Here’s how to do that without affecting the rest of the image:

1. Select the Lasso tool. You can use the Rectangular Marquee tool, but the image
is at an angle, and the Rectangular Marquee tool just won’t properly grab it.

In Photoshop Elements, pressing L selects the Lasso tool. Better still, hold the
mouse button down on the Lasso tool until a menu appears from which you can
select the Magnetic Lasso tool.

2. Select the part of the image that you want to modify. Using the Magnetic Lasso
tool, click to start your selection, and then move the mouse (don’t drag it) to
select the part of the image to modify. Click the mouse again to stop selecting.

3. Choose Enhance > Auto Contrast. You can also choose Enhance > Adjust Light-
ing > Brightness/Contrast and then use the Brightness/Contrast dialog box to fix
the selected area. Only the part of the image you selected is fixed, as shown in
Figure 4.12.

4. Press Ctrl+D or #+D to deselect and remove the selection.

Figure 4.12

The screen stands out now.

Figure 4.11

The screen on this iPod

doesn’t stand out.

4381ch04.qxd  12/4/04  0:57  Page 82

TEAM LinG - Live, Informative, Non-cost and Genuine !



83

■
S

H
A

R
P

E
N

IN
G

 T
H

E
 F

O
C

U
S

Sharpening the Focus
Ideally you want to ensure that the image you snapped was in focus. This is that extra
care this book recommends you take before the image is snapped: check the focus. But
even then, nature and the elements might be working against you. Perhaps the best shot
you got that day was slightly out of focus. Or maybe you want to know a photogra-
pher’s secret about how to make a good picture look even better. Then what you need
to know about is the Sharpen filters in Photoshop Elements.

The filters are what make Photoshop Elements, and its big brother Photoshop,
famous. By using the power of the computer, the filters can magically transform an
image from one thing to another, making it look as if you’ve slaved for hours to get
things just right. Sneaky, yes. But very practical.

So here’s a little trick that really helps boost the clarity and crispness of an
image. It’s the Sharpen filter that takes some of the blur from an image and can really
make it pop.

To best witness the Sharpen filter in action, open an image that has some detail
to it. Any product shot will do. A shot of some postage stamps was used for an example
in Figures 4.13 and 4.14.

Choose Filter > Sharpen > Sharpen. Almost instantly, the image clears up and
crystallizes. It just looks better! Figures 4.13 and 4.14 are zoomed in so that you can
see the detail. But when seen even at regular size on the monitor, the image just pops.

Figure 4.14

The same image as Fig-

ure 4.13, but after using

the Sharpen filter

Figure 4.13

Zoomed-in original

camera image
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N o t e : Some cameras have a built-in Auto Sharpen feature. If possible, try to disable it.The best time to

sharpen is when you’re editing an image in a photo-editing program, which gives you more control and

options than the software included in your camera.

Blurring Stuff You Don’t Want Focused
Just as most photo-editing programs have a Sharpen filter, they also sport a Blur filter.
That’s right: a Blur filter can be applied to areas of a photograph that you want delib-
erately out of focus.

Normally you can use the depth of field in the camera to set what you want
in focus or out of focus. But that may not be practical in all situations, or the condi-
tions under which the photograph is taken may not lend themselves to put certain
objects out of focus. Regardless, you can use your imaging software to add the
visual fuzz.

In Photoshop Elements, you choose Filter > Blur > Gaussian Blur. The Gaussian
Blur filter uses the mathematical properties of the bell curve to soften the colors and
tones in an image or in the selected portion of an image. Follow these steps to apply a
Gaussian Blur to a specific part of your image:

1. Select the item that you do not want blurred. Use any of the selection tools
available: Rectanglar Marquee, Lasso, Magnetic Lasso. Select only the object
that you want to keep sharp and in focus.

N o t e : If you make a mistake and select the wrong thing, press Ctrl+D or #+D to remove the selec-

tion and start over.

2. Choose Select > Inverse to deselect the object you’ve chosen and that you want
in focus. This also selects everything else instead—what you want to blur.

3. Choose Filter > Blur > Gaussian Blur to open the Gaussian Blur dialog box,
which is shown in Figure 4.15. This wonderful dialog box sports a handy pre-
view window. You can use the + or – controls to zoom in or out of the preview
window. You can also use the mouse inside the preview window to help drag the
image about. Be sure that the Preview box is checked!

4. Adjust the slider to increase or decrease the blurriness of the selected area. The
farther you drag the slider to the right, the burrier things become. Use the pre-
view window to check your work.

5. Click OK when the blurriness is to your satisfaction.

4381ch04.qxd  12/4/04  0:57  Page 84

TEAM LinG - Live, Informative, Non-cost and Genuine !



85

■
B

L
U

R
R

IN
G

 S
T

U
F

F
 Y

O
U

 D
O

N
’T

 W
A

N
T

 F
O

C
U

S
E

D

Figure 4.15 You can apply the Gaussian Blur to make portions of your image appear out of focus, so that your 

main image stands out.

In Figure 4.16, you see how the Gaussian Blur effect was applied to help draw
focus to the blocks that spell out a message. Only a tiny amount of blur was required
to direct focus away from the other blocks.

Figure 4.16 A modicum of blur helps set the focus for this image.

You’ll also note that the blocks in Figure 4.16 use humor to help sell. That
would almost be enough, but blurring the unimportant blocks helps to drive the mes-
sage home even more.
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Bye-Bye Background
A grand trick to pull is to yank an object from its environment and render it by itself.
Normally, you set such an object on an infinite horizon. But sometimes that’s just not
practical, especially for large objects. The trick is to use photo-editing software to elim-
inate or obscure the background. You can then ensure that focus is on the object itself
and not on its environment.

As an example, Figure 4.17 shows a lamp in an environment that’s not going to
help it sell one iota. Suppose it weren’t possible to put the lamp on an infinite horizon
or in any other, better location. Therefore, the solution is to use the photo-editing pro-
gram to remove the background.

The key here is to properly use the photo-editing software’s selection tools to
remove the background. That does require some effort.

You’ll probably use a combination of tools to select and eliminate large areas.
One trick to try is the Magic Wand tool. Use it to select parts of the background that
have similar color or tone. You can adjust the tolerance on the toolbar. Plus you can
extend the selection to similarly colored areas of the image by choosing Select > Similar.

Figure 4.17

The shot of this lamp is

ruined by the busy envi-

ronment.
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Another tool to use is the Eraser. You’ll probably want to set the Eraser very fine
and use the Zoom tool to get in close and erase parts of the background in tight areas.

N o t e : Save your work often as you go about removing the background!

After some time and elbow grease, you’ll eventually end up with the same object
but no background, as shown in Figure 4.18. It may not be as simple and effortless as
setting up the infinite horizon, but at times it’s often the only way to get rid of a pesky
background.

N o t e : You can save some time in advance when you need to use this trick by removing as many obsta-

cles as possible. For example, in Figure 4.17, you can remove the chair and place mat, making it easier to

select the lamp and delete the background.When the background is of a consistent color, it’s easier to

select. But it takes some experience to recognize this. Remember, anything that can be done ahead of time

to save you from toiling in a photo-editing program is a good thing.

Compositing an Image
Artificially doctoring your images, especially the stuff you sell, is an official no-no. Not
only does the buyer trust that you’ll accurately represent your product, but laws just
about everywhere are designed to protect the buyer from outright fraud. So while your

Figure 4.18

The same shot as

Figure 4.17, but with the

background removed
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photo-editing program might fully and easily be able to mask that chip in your photo-
graph of Grandma’s china, it’s something you shouldn’t attempt.

In one area, however, you might want to consider using a bit more of the power
of your photo-editing program. The idea here isn’t to fool the buyer, but rather to under-
score this book’s main theme, which is making your product look good. That is, creating
a composite image.

What Is a Composite Image?

A composite is like a special effect in a movie. It’s combining two separate images to
make a final shot. This comes into play for products you sell when you’re showing
images on screens or monitors. The object with the screen is photographed first, and
then the monitor is photographed separately. Finally, the two images are combined, or
composited, one atop the other, to make the end result.

Compositing is necessary because monitors, screens, TVs, and LCDs generate
light. They are a light source. Not only that, TV screens and computer CRT monitors
flicker. Your eye won’t pick up the flicker because of a phenomenon known as persist-
ence of vision, but an unblinking camera notices the flicker without discretion. This
explains why some photographs you have of TV sets, computer monitors, or even digi-
tal clocks show only part of the image on the screen.

To get things right and properly show the image, you can either show the device
with its monitor turned off—and, indeed, many advertisements do show TVs and com-
puters that way—or you can take the extra step and composite the image. You take
one picture of the object with the screen off. Then you take another picture just to cap-
ture the screen. The two are then combined, or composited, inside your photo-editing
program.

The result of compositing an image is a product shot that looks natural. Its
lighting is fine because the object’s light source was turned off. And the image appears
fine because that shot was taken separately. The buyer never needs to know, and the
image isn’t a scam because nothing was really “fixed” other than properly rendering
the shot the way the eye normally sees things.

N o t e : Even though compositing is a common practice, it is fraud to misrepresent your product.This

chapter’s example shows you how to composite a shot to remove the flicker that occurs when you take a

photograph of a monitor on a fully functioning video camera.

Taking the Product Shot

Your first step is to take a photograph of the object as you normally would. In Fig-
ure 4.19, the camcorder is set up just as any other product shot would be composed.
An infinite horizon is used, and the lighting is diffused and from the back left. Notice
that the camera’s preview screen is open and ready for use—but there is no image.
That’s important. For the initial product shot, do not show an image.
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Notice also that the light source in Figure 4.19 is behind the product. Because
it’s diffused, the light is nice and soft and fills in the cracks and shadows, helping to
define the camcorder. But also by placing the light behind the object, you immediately
lose any chance of having an ugly reflection on the monitor.

N o t e : If you do end up with a reflection on the screen, use the techniques described elsewhere in this

book to remove the reflection.

Capturing the Screen Image

After capturing the product, the next step is to capture the image that would normally
appear on the screen.

N o t e : Nothing must move between the shots!

Ensure that the camera is tightly on the tripod so that the camera does not
move. Then carefully turn on the item or do whatever is necessary to get the image up
on the screen or monitor. Don’t move anything!

Back at the camera, you want to adjust the exposure for the screen, not the entire
image. This takes some thinking, so pay attention! LCD screens don’t require much extra
exposure time, but still consider doing an exposure longer than 1⁄30 second or so. CRT
monitors and televisions require at least a one-second exposure to get their image to

Figure 4.19

The LCD screen is off for this

initial product shot.
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display properly. When in doubt, go for that long exposure! Remember, more informa-
tion is better! Lots of bits!

N o t e : When taking a shot of a TV, try to find an image that isn’t rapidly changing. Because the exposure

time is longer, an action sequence will appear mushy when you use a long exposure. Instead, wait for a slow

part of a program or until there is a landscape shot or something that will stay around for a few moments.

Do not use the pause button on your VCR or DVD either, as such images appear unrealistically artificial.

You might also want to open the aperture just one stop to slightly overexpose
the image. So to review: Set the shutter speed as described, depending on the image
source. Then, open the aperture one stop, for example, from f/11 to f/8. You may
have to set your camera on full manual mode for this, but the results will be worth it.

In Figure 4.20, you see the same setup as for Figure 4.19, but with the cam-
corder’s LCD on. Note how the image is overexposed compared with Figure 4.19? This
is because the image is being exposed for the LCD, not the entire camera. Otherwise,
the shot is the same, the camera is in the same position with the same framing, and the
lighting is the same as in Figure 4.19.

N o t e : Consider taking a few shots at different exposures just to be sure that you’ve properly captured

the image. Doing so now saves you from having to re-create the image later if you aren’t happy with the

images.

Figure 4.20

This photograph is exposed to

best capture the image on the

LCD screen.
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Creating the Final Result

When you have both the product shot and the monitor or screen image shot, you’re
ready to use your photo-editing software to composite them. This is really an easy and
amazing thing to do. The following is an overview, assuming that Photo 1 is the prod-
uct image and Photo 2 was exposed to capture the monitor or screen.

1. Open Photo 2 in your photo-editing application. Start with the image that is
properly exposed to capture the monitor or screen.

2. Choose the Polygonal Lasso or Magnetic Lasso tool. 

3. Select the monitor or screen images. If you don’t get all of the screen on the first
try, press #+D or Ctrl+D to unselect, and start over.

4. When you’re happy with the selection, choose Select > Feather to open the
Feather Selection dialog box, as shown in Figure 4.21.

5. Set Feather Radius to 10 pixels. Feathering causes the selection’s edges to become
“fuzzy,” which helps it better match when pasted into the product photograph. In
Figure 4.22, you see the copied selection from Figure 4.20. Notice how the edges
are fuzzy? That’s feathering in action. 

6. Click OK to feather the selection.

7. Choose Edit > Copy to copy the selected portion of the image.

8. Open Photo 1. This is the image that you took of the product with the screen or
monitor off.

9. Choose Edit > Paste to paste in the monitor from the previous image. In Photo-
shop Elements, the pasted image appears in a new layer.

10. Use the Move tool to position the pasted image.

N o t e : You might want to use the Zoom tool to zoom in on the image, ensuring that you position things

properly.

Figure 4.22

The copied image, with

feathered edges

Figure 4.21

Set a feather radius of 10 pixels here.
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Figure 4.23 shows the end result. It’s a combination of what you see in Figures 4.19
and 4.22, carefully pasted and merged together. Such an image can only be made
through compositing.

Figure 4.23 The final, composited image

11. Save the file in the photo editor’s native format. In Photoshop Elements,
choose File > Save As. Use the Photoshop file format (PSD). Similarly, in what-
ever photo editor you’re using, use that same application’s format to save the
image. This preserves the layers so that you can go back and reedit the image
later, if needed.

12. Choose Layer > Flatten Image. You need to collapse the layers in your photo-
editing program so that you can save it in the JPEG format for the Web. (If you
forget this step, most good photo editors will remind you when you save, either
as you save or by not letting you save in the JPEG format.) 

13. Save the image for the Web. 

See the section “Resizing Images” earlier in this chapter for how to save your
images for the Web. You can now use your composited image to help sell the product,
looking better than it would with the monitor or screen turned off.
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Creating a Watermark
Traditionally, a watermark was part of the paper. (You remember paper?) Many of the
fancier papers held an embedded image, one that you couldn’t see when the paper was
lying flat, but when held up to the light, the watermark image was visible. The water-
mark was a way of proving that the document was printed on high-quality paper, but
also confirmed that the person was writing on the “right” side of the paper.

Currently, the rage in watermarks is with money; hold a crisp new bill up to
the light, and you can see an image that isn’t visible otherwise. Governments do this
because watermarks are difficult to photocopy. In a similar manner, you can add
watermarks to your images to help prevent others from using them.

The following sections show you how to create various watermarks for your
images. Remember that any image on the Internet can be easily downloaded and used
by someone else—despite being illegal. By adding a watermark to your images, you can
help discourage copying, as well as ensure that those images you see elsewhere were
first created by you.

eBay’s Watermark Feature

eBay offers a watermarking service for your pictures, either using the eBay camera
image watermark, which appears in the lower-right corner of your image, or using your
eBay user ID.

Currently, eBay does not charge for adding the watermarking feature to your
images, though remember that eBay does charge you extra for more than one image
per item.

Of course, you might want to provide a more personal watermark for your
image, one that you can use not only on eBay but anywhere on the Internet you put
your image. Take a look at how to create your own in the following sections. 

Creating a Simple Text Watermark

In Adobe Photoshop Elements, follow these steps to produce a simple text watermark
on your images.

1. Open and prepare the image. Work with the image as necessary, described else-
where in this chapter. The image should be all fixed up, cropped, resized, color
corrected, and have all other photo-editing activities completed. In fact, you
might have already even saved the image to disk. That’s fine. Watermarking
should be the last step.

2. Select the Text tool. In Photoshop Elements, the shortcut here is to press the T
key. You’ll see things change in Elements, reflecting the Text tool’s options, as
shown in Figure 4.24. Pay attention to the Font, Size, and Alignment buttons on
the toolbar.
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3. Choose white as the Text tool’s foreground color. The quickest way to do this in
Photoshop Elements is to press D and then X on the keyboard. Pressing D sets
the default colors of black foreground and white background. Pressing X then
switches them.

4. Click in the bottom center of the image to set the starting point for your water-
mark text.

5. Type the watermark text. If the text is too big or too tiny, press the Backspace
key to back up and erase, or highlight the text to make changes as you would in
any text-editing software, and then choose a larger text size from the toolbar.
Likewise, if the font isn’t to your liking, press the Backspace key to erase and
then choose a new font to start over.

6. When you finish typing the watermark, click the Move tool . It’s in the top-
left column of the tool palette. It looks like an arrowhead next to a plus-shaped
arrow. By selecting this tool, you exit text-typing mode.

N o t e : If you want to do something extra fancy here, you can emboss your text.This gives the watermark

more of a three-dimensional look, though it works best on larger text.To emboss the text, choose Filter >

Stylize > Emboss to open the Emboss dialog box. Click OK to simplify the type (but be aware that this makes

the type uneditable in the future).Then click OK after you’ve messed around with the Emboss dialog box.

7. Position the watermark. You can use the mouse and the Move tool or the arrow
keys on your keyboard for more precise movement. You can place the water-
mark anywhere in the image, though traditionally it goes in the lower-right cor-
ner, but not too close to the image’s edges.

Figure 4.24

Note the Text tool

options on the toolbar.
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N o t e : Some folks put the watermark right in the center of the image, over the object being photo-

graphed.This is a sure-fire way to help prevent image theft, but such a move also detracts greatly from the

quality of the image.

8. Choose Windows > Layers to display the Layers palette.

9. Choose the layer with your watermark text in it. The layer in the Figure 4.25 is
labeled “Watermark,” which is also the white text that you can see over the
image in Figure 4.20. 

10. Set the opacity for the watermark’s layer. Use the slider in the Layers palette to
adjust the opacity of the watermark layer down to about 25 percent—or what-
ever makes the watermark still visible but not obnoxiously so. (For some images,
depending on the background, you may have to adjust the slider to values above
50 percent.)

11. Flatten the image. JPEG images are composed of one layer, but Photoshop Ele-
ments uses two layers to add text to an image. Therefore, before you save, you
need to flatten the image.

N o t e : At this point, you might want to save the image in the native Photoshop Elements format, just so

you can preserve the second layer with the watermark.That way you can go back and re-edit the watermark’s

text if you like. Remember that this would be a third graphics file format in which to save the image: the cam-

era’s original, the JPEG for the Internet, plus the Photoshop Elements file format for editing the watermark.

To flatten the image, click to select the Background layer in the Layers palette.
Then click the More button on the Layers tab to see a special pop-up menu.
Choose the Flatten Image command from that menu.

12. Save the JPEG file back to disk. The new copy of the image on disk now has the
watermark.

Figure 4.25

The watermark is posi-

tioned and ready to be

made semitransparent.
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Using Your Company Logo As a Watermark

Adobe Photoshop Elements is up to the task when you’d rather use a graphic image, such
as your corporate logo, instead of text as a watermark. All you need to do is open the
corporate logo or other graphic file in Elements. Copy the image, or select and copy the
portion that you want to use.

For example, if the background is white, select the background with the Magic
Wand tool. Then choose Select > Inverse, which selects everything in the image but the
background. Choose Edit > Copy to copy the desired logo. You can then close the
image window.

Next, open the product image in which you want to create the watermark. Paste
in the logo by choosing Edit > Paste. Resize the logo watermark and reposition it as
necessary. 

At this point, you can continue with steps 8 through 12 in the previous section
to create the watermark. You can see a sample of a logo watermark in Figure 4.26.

Figure 4.26

An example of a logo

watermark on a photo
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Using a Digital Watermark

You’ll note that Photoshop Elements refers to a special digital watermark called Digimark. This is a
special “invisible” watermarking technology marketed by an outfit called Digital Marketing, Inc.
(www.digimark.com). This is a professional service, and they charge money for digitally encod-
ing your images. It is not a part of the Photoshop Elements program. For now, or until your images
become world famous, consider using the watermarking techniques described in this book before
you’re making enough money to do things with Digimark.

4381ch04.qxd  12/4/04  0:57  Page 97

TEAM LinG - Live, Informative, Non-cost and Genuine !



4381ch05.qxd  12/4/04  1:19  Page 98

TEAM LinG - Live, Informative, Non-cost and Genuine !



99

5
In this Chapter
Understanding the subjective approach
Shooting small items: jewelry
Setting up for medium-sized objects
Photographing larger objects subjectively

Creating Images 
with the 
Subjective Approach

One person’s junk is another’s treasure. What

may look to you like an old chunk of metal is

in fact a heavy, antique brass door hinge. Yet

only when the old chunk of metal is put into

context can you properly recognize and appre-

ciate its value.

The best way to showcase unfamiliar objects is to

photograph them in context, using the subjective

approach. Placing a common object into context

also helps it look good. A bowl. A glass. Cuff

links. An espresso machine. Putting those objects

in context builds an association; the image

becomes part of a fantasy that helps the poten-

tial buyer emotionally connect with the object.
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Using the Subjective Approach
The bottom line is sales: you want to sell something. This involves having something to
sell, but it also requires an important and often missing piece: the buyer. How much do
you know about the buyer? The more you know, the easier it is to sell them something.

Begin by asking questions. What does the buyer want? Why do they want it?
What need does it fill? The more you know about your buyer, the better you can
deliver what the buyer wants. Even though you cannot possibly get into the buyer’s
head, the point here is to try. Put yourself in the buyer’s mood, and then craft a photo-
graph to sell to that mood.

Ask yourself, is the buyer going to be familiar with this object? If not, it helps to
put that object in a context where it will be familiar. For example, not everyone is
familiar with a napkin ring or knows what it does. A napkin ring might look like jew-
elry or artwork to such a person. The sense of scale or perspective might be lost, and
the buyer might need to know how large the piece is. Rather than photograph the ring
on a Formica countertop next to a ruler, put it context.

When the buyer is familiar with an object—say, a set of glassware, dishes, or
something else commonly used—create a fantasy for that buyer. Try to guess who they
are and when they’ll be using the item. In your photograph, build a moment for the
buyer to soak in. A set of espresso glasses is just more glassware to look at on eBay.
But an image of a glass with a steaming cup of espresso perhaps sitting by a biscotti or
the morning paper evokes a time and place. It builds a connection. The buyer thinks,
“That could be me enjoying that fine sip of espresso some morning.”

When the object is dull, give it a life; place dull and ordinary objects where you
think the buyer would find themselves comfortable. To help build that environment,
keep asking questions: Who will buy this? How do they see themselves using this?
Where would they place it? What kind of fantasy can I build for this person? Answer
those questions and you’ll set the perfect subjective environment for not only the item
you’re photographing but for the buyer as well.

Shooting Small Objects
Small objects are some of the most difficult things to photograph. Even the professional
product photographer has problems taking pictures of teensy, tiny things. You will as
well, so the more you know about the problems beforehand, the easier you can deal
with them. But be aware that it’s going to take time and patience to do things properly.

Of the many challenges you’ll encounter when photographing jewelry, the first is
lighting. You’ll need a lot of light, not only because the object is small, but because of
reflections. For example, cut gems have many facets and each facet reflects light from a
different direction. No one wants a dark spot on any face of a gem.

Another tough thing is moving the tiny objects. For that, you’ll need a pair of
tweezers or often a toothpick to gently and slightly move the itsy-bitsy objects into
proper position.

Finally, the camera must be up to the task. What you really need is a macro lens,
or one that has a focal range that’s only inches before the camera. (Many zoom lenses
have macro ability.)
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If you’re up to the task, further be aware that most small objects, especially jew-

elry, should really be photographed using the subjective approach. The following sec-
tions show several examples, but feel free to experiment. Try new things. See what
works and what doesn’t, and your own taste as well as how you perceive the buyer,
will be the judge here.

Above all, keep at it. Don’t give up easily, but don’t waste too much time trying
to get the effect you want. The information in the sections that follow will be of help.
Eventually, with care and practice, you’ll take that shot that sells.

Preparing an Environment for Jewelry

When you think of jewelry, you think of elegance, wealth and, above all, beauty. Your
photograph must enhance and enforce these attributes, beyond just properly capturing
the object itself. Because of this, all jewelry should be photographed using the subjec-
tive approach.

Selecting the proper background is of prime importance. You want to avoid the
plain and the stark. Instead, choose something warm and elegant. Avoid a background
that overpowers the image. For example, you don’t want a powerful background pat-
tern to literally swallow a tiny pair of earrings. Avoid the ugly and cheesy as well, such
as the poor example in Figure 5.1.

Figure 5.1 Bad environment. Bad lighting. Bad shot.

In Figure 5.1, you see a bracelet that looks as if it were literally dropped on a
tabletop. The background looks cheap, like one of those ugly, utilitarian folding tables
you’d find at a rummage sale. Ugly. Ugly. Ugly. Not only that, the picture was taken
using a flash, and so what harsh shadows there are don’t help define the image. Like a
cheap bracelet sold at a yard sale, don’t expect to make much money with the photo-
graph shown in Figure 5.1.
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Backgrounds can come in many shapes and sizes. While you want to avoid
something ugly and non-flattering to the jewelry, you should feel free to experiment
with different backgrounds; sometimes the craziest ideas work best. For example, in
Figure 5.2, an orange necklace is positioned on a piece of slate. The image could have
been taken outside on an overcast day or in a studio with diffused lights.

True, the background in Figure 5.2 is cold. But yet the necklace is bright orange.
A warm background in that case might overwhelm the viewer, or it could detract from
the necklace. Placing the necklace on the cool, gray slate lets its natural warmth comes
through. And the flat of the slate contrasts with the beads in the necklace, helping to
reinforce their shape.

Elegant materials also work well for the background. Silks, satins, velvets—all in
warm colors and arranged well can really help offset jewelry in a stunning way. But
most photographers take that safe route. As an alternative, and just to be a little crazy
and different, consider something outrageous to help make your jewelry stand out.

Figure 5.3 was taken with a background discovered at an art store. Blue and green
go together (just look at the horizon). The blue turquoise in the necklace works well
against the textured green background. That background is dried grass that comes on spe-
cial paper and is available in any art supply store. Not only does the color help showcase
the turquoise, it adds a contrasting texture to the stones, reinforcing their smoothness.

Figure 5.2

This warm necklace isn’t lost in

the cool background.
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Beyond the unique background material, the necklace was photographed from a
higher angle so that you can appreciate its shape and design. It’s laid out in a kidney-
shaped pattern, which is more interesting than the traditional oval. The lighting is natu-
ral, through the windows, which are reflected in the stones. Do note that the windows
were draped with a shower curtain liner to help diffuse the light and spread it evenly
about the necklace.

The same background and effect used in Figure 5.3 is also used in Figure 5.4 to
help sell a bracelet. In fact, you could set a whole jewelry collection against the same
background, which not only is unique but would help identify buyers with your jewelry
store on eBay.

Figure 5.4

A fun way to showcase a

bracelet

Figure 5.3

A wild concept: a turquoise

necklace on dried grass
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Working with Small Jewelry

As the jewelry gets smaller, don’t make the mistake of overwhelming the buyer with
your subjective environment. The dried-grass paper and stone used in the previous sec-
tion are fine for larger pieces. But when you get down to the tiny stuff, such back-
grounds overwhelm things such as rings and pins, literally swallowing them up. Even
so, the idea is still to convey a sense of elegance and evoke the kind of mood necessary
for selling the jewelry.

N o t e : Don’t overwhelm the buyer! Your photograph merely provides the sparkle on the shine that’s

already present in the jewelry itself.

Figure 5.5 shows two small pins or brooches. The background is simply a piece
of red silk, red being a warm color. The lighting is diffused so there are really no shad-
ows, which helps eliminate any starkness. And the camera is very close, using a macro
lens to keep close items in focus.

Figure 5.5 A butterfly pin and a shoe pin

N o t e : Silver and red make a powerful combination, as do gold and black.

In Figure 5.6, a pair of rings is set on a sheet of white plastic. You’ll note that
the white plastic reflects the ring somewhat, which makes the shot more interesting
than if a nonreflective surface had been used.
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The lighting in Figure 5.6 is soft, diffused to the point where there are no shad-
ows. In fact, such a setup could be taken under low-light situations, which means the
image might have been exposed for 1 or 2 seconds. Also, the depth of field is set quite
shallow, highlighting the rings themselves and obscuring the background.

The simple white environment might be considered cold, yet it meshes well
with the simple designs on the rings themselves. You could imagine that a person
wanting a thick, silver ring with a basic design doesn’t want their life filled with com-
plication anyway, hence the plain nature of the photograph. Yet it still is a subjective
environment.

Finally, in Figure 5.6, notice how the rings are positioned. The one on top is
angled perfectly so that you get an idea of the shape and depth. There is no need to do
this with the bottom ring; the shape is automatically assumed to be identical to the top
ring. When showing two identical objects in this manner, it does help to have them
both oriented differently.

N o t e : Avoid the temptation to have someone wearing the jewelry.To do such a thing properly, you

must hire a professional jewelry model, and they don’t come cheap.Therefore, don’t waste your time using

real humans to showcase your jewelry on eBay.

Don’t be afraid to have fun with the jewelry and indeed with all your product
shots. Some of the latest trends in professional photography involve lots of “thinking
outside the box.” New and unusual things are being tried all the time, and oftentimes it
takes no effort to employ something new or unusual—just a trip to the art supply store.

Figure 5.6

Rings up close with dif-

fused light
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Midsized Objects (Smaller Than a Breadbox)
A whole class of objects are hand-sized, or designed to be picked up and used. These
include anything you hold or can hold—dishes, cups, glasses, but also the various
knickknacks, statuettes, and other small objects. They’re all photographed in much the
same way. The only difference, as far as the subjective approach is concerned, is into
which environment you place the objects. Or, to put it another way, how to use the
environment to help reinforce that emotional connection with the buyer.

The subjective approach doesn’t imply realism; it merely suggests an environ-
ment that helps to showcase what you’re selling. It can be realistic, or it can be a fan-
tasy, as shown in this section’s examples.

Incorporating Fantasy Environments

A cup is a cup is a cup is a cup, right? You’ve seen one, you’ve seen them all? That
might be what the buyer is thinking, but as the seller you can craft a picture that prop-
erly evokes an image in the buyer’s mind. Think cup, think drink. Making that connec-
tion helps lead to the sale because you’re telling that buyer that your coffee cup will
better suit their caffeinated beverage fix than the other guy’s boring coffee cup picture.

The coffee cup in Figure 5.7 is really nondescript. Honestly, there is nothing spe-
cial about the cup itself, but can you see how that’s not entirely true of the image? That
photograph is designed to sell by appealing to the coffee drinker’s soul.

Figure 5.7

Now that is a cup of Joe.

4381ch05.qxd  12/4/04  1:19  Page 106

TEAM LinG - Live, Informative, Non-cost and Genuine !



107

■
M

ID
S

IZ
E

D
 O

B
JE

C
T

S
 (S

M
A

L
L

E
R

 T
H

A
N

 A
 B

R
E

A
D

B
O

X
)

The camera is set up properly in Figure 5.7 to capture the cup’s shape. The angle
is high so that you get a feel for the circular cup. The cup’s handle is set perpendicular
so that it’s readable as well. The lighting is all natural, coming through the windows.
It’s Mr. Sun! But our Mr. Sun is also being diffused, thanks to a shower curtain liner
over the window.

Rather than set the cup on a boring old tabletop, a special wrapping paper
design was chosen just for fun, but also because it works well; the colors balance per-
fectly with the coffee cup’s color, and the dots help reinforce the shape.

Finally, there are the coffee beans. Sure, the cup could have been filled with cof-
fee. But how do you make that look hot? Rather than worry about capturing the
steam, or—heaven forbid—the flavor, raw coffee beans were used. The beans were
coated with some olive oil to give them a shine and also imply richness. (The beans are
“wet,” and coffee is wet, not dry.)

The spoon provides the final kicker, enticing the buyer to want to pick up that
spoon and dig into those beans! It’s a simple shot, but those extra items—the wrapping
paper, beans, and spoon—help you sell more than just the coffee cup. You sell a feeling;
you sell a drink.

Photographing Steam

Here is one simple piece of advice for photographing steam: don’t even try.

It makes sense to get some steam in an image, for example, to show that a cup of coffee is really
hot or perhaps to show a clothing steamer or other gizmo that produces steam. The reality is
something else.

Steam is composed of water, which is transparent. It’s very difficult to light. Steam is most visible
with a dark background, and that doesn’t always work with the objects you’re photographing.
Indeed, sometimes it can take a professional photographer days to get the lighting set properly to
capture steam in an image. Often the steam you see in a picture was digitally added later—again
by a professional.

On the other hand, sometimes you can be lucky and capture that steaming cup of something hot
or steam being ejected from a hot iron without even trying. If you can do it, give yourself a cookie.
Otherwise, there are no simple tricks and no soothing words of advice, other than good luck!

Figure 5.8 does for tea what Figure 5.7 does for coffee. It evokes a feeling or a
time of day, and it invites the buyer to have a deep sip of hot tea from that particular
cup. After all, the real purpose is to sell the teacup.
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When comparing Figures 5.7 and 5.8, note that the cup in Figure 5.8 is far more
elegant than the standard coffee cup in Figure 5.7. Because of this, the camera angle is
lower to showcase the design around the edge of the cup, which is one of the cup’s fea-
tures and selling points. Yet the camera angle is still just high enough that you can
appreciate the round shape of the cup. It has depth. Even more enticing, the angle is
just barely high enough that you can perceive the tea. Notice how the color of the tea
nicely matches the gold in the cup and saucer.

Just as the coffee cup shot has its beans, the teacup image uses a spent tea bag
and crumpled wrapper. The effect is that the tea is prepared, and the viewer is invited
to have a sip. It also helps reinforce that the liquid in the cup is tea and not rusty water
or flat beer.

Beyond the low camera angle, the lighting in this shot is completely natural. But
what you cannot tell is that it was a very low-light situation. To get the proper expo-
sure, the shutter speed was set to 8 seconds. That allowed enough light in to expose the
image without having to ruin the effect of the natural light in the room.

Note also that the depth of field is shallow for the picture, utterly obscuring the
background.

Finally, the teacup is set on a mirror that perfectly reflects its beauty, which is
like getting two images instead of one. It’s also an example of finding a unique material

Figure 5.8

Sit back, relax, and enjoy

this cup of tea.
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on which to set an object. But notice how the mirror reflects only the teacup and not
anything else that might prove distracting.

Adding a little environment to an image can help the buyer set up how they’ll
use the object in their head. Figures 5.7 and 5.8 are primarily fantasy environments,
which help reinforce the object being sold without subtracting from it. In Figures 5.9
and 5.10 (in the next section), the environment becomes more natural and realistic.

Using Realistic Environments

For more familiar, practical objects, a fantasy environment may not help as much as it
distracts. Sometimes leaving an object in its found environment is best. But you must be
careful not to include too much environment, or you’ll overwhelm the buyer. This sec-
tion contains a few examples for your rumination.

In Figure 5.9, the salt-and-pepper shakers are on a dining room table. Although
you could build a complex tableau around them, including perhaps a steaming baked
potato or elaborate table centerpiece, such items would most likely pull the buyer’s
concentration away from the salt-and-pepper shakers themselves. In this case, all that’s
needed is that surface, which the buyer can assume to be a kitchen tabletop.

Figure 5.9

A pair of salt-and-pepper

shakers
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The lighting in Figure 5.9 is natural, coming right in through the kitchen win-
dow. But notice how the objects were set so that the light helps define their outline; the
light comes from the right-rear side. If the same image were shot from the right, the light
might just glare off the objects.

The camera angle and zoom are set in Figure 5.9 so that no distracting items
appear in the background. That keeps the focus on the salt-and-pepper shakers, but yet
still puts them in an environment. The wooden tabletop could be the buyer’s tabletop.
It’s subtle.

Similar to Figure 5.9, Figure 5.10 shows a simple setup that effectively uses 
a tabletop to evoke a feeling and makes a connection with the buyer. In this case,
however, the glass is partially filled with wine, and a wine bottle appears in the 
background.

As with the shots of the coffee and tea cups (Figures 5.7 and 5.8, shown earlier),
the angle in Figure 5.10 is high, which lets you value the shape of the wineglass. The
light is natural, from a side window that’s been diffused with a shower curtain liner.
The depth of field is set so that the wineglass is in focus, but the wine bottle is not.

Figure 5.10

An inviting glass of vino
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N o t e : Remember that there isn’t really a need to show the entire lot, especially when the lot consists of

multiple items. In Figure 5.10, you only need one wineglass, but the photographer/merchant might be try-

ing to sell 24 of those glasses.

Notice also that Figure 5.10 really isn’t that busy. Sure, you could have gone
nuts perhaps with grapes or a cornucopia, but keep in mind how such stuff overwhelms
an image. No, all that’s needed is just the wine in the glass. In fact, this is most likely
one of a set of glasses for sale, but only one needs to be shown to help drive the sale
home. Remember: less is more.

If you’d rather have more detail in the picture, be certain that the detail helps to
reinforce the image and not detract. For example, take a look at the eggcups shown in
Figure 5.11. The environment is now fading from the realistic one used for Figures 5.9
and 5.10 and borders on the fantasy environment used earlier in this chapter.

Figure 5.11

Eggcups in a borderline

realistic/fantasy environment
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The shot in Figure 5.11 isn’t really that complicated. The two eggcups are set
up, one behind the other as opposed to side by side. This, combined with the wide-
open aperture, adds depth to the photograph and keeps it interesting. It’s also another
example of “thinking outside the box”; most eBay images would have shown the
eggcups side by side or would have included all 12 in the set!

The dried flowers, spoon, napkin, and tablecloth help bring out the warm tans
and browns of the eggcups. They also help evoke a feeling and set a mood. You’ll notice
that even though the cups are used for food, there isn’t any food in the image. Instead, a
comic touch was added by placing an alabaster egg in one of the cups. Beyond being
funny, that alabaster egg brings an elegant mood to the photo. Yet it also shows some-
one who might not immediately recognize the eggcups that they are, indeed, eggcups.

Figure 5.11 is also a great example of using natural, but diffused, light from
behind an object. The shutter speed was set long to ensure that enough light was avail-
able to capture the image.

Figure 5.12 illustrates the same type of simple elegance as found in Figure 5.11.
In Figure 5.12, a crystal knife rest is being sold. The place setting is necessary to help
illustrate how the knife rest is used—the perfect example of a subjective shot. Other-
wise, someone might think what’s being sold is really a doorbell or a miniature dumb-
bell. Yet when put in context, it’s obvious what the object is.

Figure 5.12

A knife rest with a knife,

well, resting
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The lighting in Figure 5.12 is entirely natural sunlight coming in through a win-
dow. The light is diffused with a shower curtain liner. Note that the diffusion is what
helps illuminate the various facets of the crystal. A narrow depth of field was chosen to
keep the focus on the knife rest. Other items in the picture are present and help set the
mood for the photo, as well as identify how the object is used, but they don’t detract
from the knife rest.

You might use Figure 5.13 in two ways, either to sell the flatware or to sell the
napkin. This photograph was taken outside on a very overcast day. The depth of field
is narrow, and the table that the objects are sitting on is interesting, yet doesn’t pull
focus from the napkin and forks.

This book does drive home the point of “less is more.” Specifically, with the
wineglass example, you really need only one wineglass to sell the lot. Yet in Fig-
ure 5.13, we show four forks. The reason here is simply playfulness. As long as the
multiple items can be arranged or displayed in some interesting manner, as with the
eggcups in Figure 5.11, showing more can work.

For example, Figure 5.13 wouldn’t work as well if the image showed only a
standard flatware setting (spoon, knife, and fork). Notice that the forks are pointing
the “wrong way,” toward the buyer. The end result is a more interesting shot than of,
say, eight knives, eight forks, and eight spoons splayed out on someone’s kitchen table.

Figure 5.13

Napkin and forks
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Avoiding the Hideously Realistic

Any object, small or large, can be photographed subjectively. All you need is that object
in an environment you believe to be appealing. The keyword is “appealing,” and that
means different things to different people. To achieve the proper level of appealing, you
truly must understand the buyer and then apply the best subjective technique for that
buyer. Sometimes the techniques work; sometimes they don’t.

For example, Figure 5.14 is definitely subjective, but it’s also disgusting. No one
really wants to look at someone else’s toothbrushes, even if they are as presentable as
those shown in the photograph. (There are no toothpaste blobs, for instance.) Beyond
disgusting, the image is distracting. A flash was used, which further makes the sterile
white environment unrealistic. Figure 5.14 shows no fantasy. In fact, it could be some-
one’s worst nightmare.

Figure 5.14

The toothbrush holder does

not scream,“Buy me!”
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A better example for this type of object is to consider two of this book’s rules:
“keep it simple” and “less is more.” Figure 5.15 shows the same toothbrush stand, also
in an environment—but not so much environment as to make the subject unappealing.

Figure 5.15 almost borders on the objective approach, save for the black-tiled
background. In fact, that’s merely a sheet of tiles available at any hardware store. More
important, the black helps offset the object’s white base and silver top. Any ugly reflec-
tions off the black tile were fixed using black paper as masking.

The lighting in Figure 5.15 is natural; sunlight passing through a window is dif-
fused through a shower curtain liner.

And be careful to note that the camera angle is elevated, which helps show the
shape of the base as well as the top part of the holder.

Borderline Objective Approach

Figure 5.16 illustrates an attempt to sell a cake stand using the objective approach. It
really doesn’t work for a variety of reasons. The biggest reason is that in the objective
environment, you really can’t tell whether it’s a cake stand, a small table, a birdbath, or
something similar. The object isn’t ugly, but its use isn’t obvious.

Figure 5.15

A better presentation for

the toothbrush holder
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Another problem with Figure 5.16 is that a flash camera was used to take the image.
See the ugly shadow behind the cake stand? Also notice the glare. It isn’t really terrible, but
with a few moments of extra preparation, this photo can be made so much better.

In Figure 5.17, the camera flash was eliminated. The photographer used the nat-
ural light coming in through the kitchen window. This took maybe two or three min-
utes to tape a shower curtain liner over the window. Compare Figures 5.16 and 5.17.
Which would be more appealing to a buyer?

Figure 5.17

Improving the cake stand’s lighting

using natural light and no flash

Figure 5.16

Not the best way to showcase a

cake stand; in this case, the flash

doesn’t help.
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You might also believe that something else is wrong with this image: it’s set up
on an infinite horizon (see Chapter 2). That device is primarily used in the objective
mode. Even so, it’s possible to make this a subjective shot on the infinite horizon. The
trick, as with other subjective shots, is to help the buyer along by showing them how
the object is used. In this case, in Figure 5.18, you simply add the cake.

Normally you wouldn’t want to mess with food in a product shot. Food is
tricky to shoot, and the folks who prepare food for photographing make lots of
money because they know what to do. (For example, the cake in Figure 5.18 would
have been frozen solid before the piece was cut out.) Even so, using food in this man-
ner is perfectly okay.

See how a piece was cut from the cake? This was done for two reasons. First, it
helps illustrate that it is, indeed, cake on the cake stand. Second, and more important,
it invites the buyer to have a piece of cake. An uncut cake might bring back memories
of childhood where it was “bad” to be the first person to cut the cake. But a missing
piece implies that eating the cake is okay. “Here, have some!” it says.

Adding the cake, unfortunately, does hide the true shape of the cake stand’s top.
That’s easily fixed, however, by raising the camera angle, as shown in Figure 5.19.
You’ll notice that the higher angle also makes the cake look better—all that rich choco-
late. Mmmm….

Figure 5.18

A cake stand with cake
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Solving Tough Problems by Having a Bit of Fun

Like jewelry, transparent things are tough to shoot. You might think that placing such
an object into an environment would help, but usually what you end up with is a shot
such as Figure 5.20, in which it’s really hard to see what’s for sale.

If you look closely, you can tell that Figure 5.20 is showing a mason jar. But
why force your buyer to look that hard? Yes, it goes without saying that this is a prime
example of how an object can get lost in an environment, even if that environment is
trying to help sell the object, which is what the kitchen background is trying to do in
Figure 5.20.

A simple solution for the mason jar is to move the camera in closer, as shown in
Figure 5.21. The depth of field was also tightened, to ensure that the background
doesn’t overwhelm the image. The photograph’s exposure time was lengthened to help
get enough light onto the mason jar without creating too much glare.

In the end, Figure 5.21 is still a better shot than Figure 5.20. A serious problem
remains in that the shot is boring. It’s lifeless. It’s too white. It probably looks like
every other mason jar for sale on eBay. The solution is to have a bit of fun.

What can you put into the mason jar that will help it sell? Preserves? That
would work, but it’s not fun enough. Plus it doesn’t solve one of the image’s basic
problems: a lack of color.

Figure 5.19

The last, best cake stand

shot from above
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Figure 5.21

A mason jar shot with a

tight depth of field

Figure 5.20

What’s for sale here?
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In Figure 5.22, you see the insane, think-outside-the-box solution: jelly beans.
Same jar. Similar setup. A piece of black paper (a “dark source”) was placed to the left
of the jar to help cut down the light a bit. Color is infused into the image by adding
jelly beans. The only problem now is that the buyer will probably want to pay more
just so they can get the beans with the jar!

Capturing Large Objects
Some objects are bulky or just downright heavy and therefore cannot be moved out of
their environment. Things such as exercise equipment (weights, for example), TV con-
soles, furniture, large appliances, sporting equipment, and other bigger-than-a-breadbox
items are best shot either subjectively or alone by removing the background in your
image-editing program. Removing the background is demonstrated in Chapter 4 with
examples shown in Chapter 6. But most of the time, you’ll probably find that the back-
ground environment for the object is just fine or can easily be improved with a modest
amount of tidying.

Figure 5.22

A colorful solution
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Figure 5.23 shows a rather large, Japanese-style lamp. That’s how the object
normally sits in the room, and it looks just fine. The photographer pulled the lamp out
into the light so that it would show up better. But note that the light is just regular win-
dow light. The exposure time was increased, but that’s about the only special effect on
the shot. Otherwise, it looks good.

Figure 5.23 The lamp in window light

Or maybe the lamp doesn’t look good. One way to confirm that is to modify the
setup, take a second shot, and compare the two. Figure 5.24 is exactly the same as Fig-
ure 5.23, but with the lamp lit up.
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Which image is better? Again, it depends on your taste and also how you think
the buyer would better appreciate the image. Perhaps you would use both images on
eBay: Figure 5.23 to show the lamp’s basic shape and design and then Figure 5.24 to
show that it is a lamp and not a cleverly wrapped, gigantic wine carafe.

Step back.
Breathe.
Think.
Perhaps you can do something else with your image. Is there something else to

try? If you’re not satisfied, change some element. In Figure 5.25, the photographer
drew the curtains. This creates the valued soft light, creating a slightly different view of

Figure 5.24

The lamp with its lights on
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the lamp than shown in Figure 5.23. The exposure was longer to compensate for less
light. Both Figures 5.23 and 5.25 are similar. Which one do you choose? That depends
on which image you like or which one you feel sells the item better.

Figure 5.26 complements Figure 5.24; it’s the same shot but with the curtains
drawn. Does it work better for you? Do you think the buyer would be more apprecia-
tive of one or the other?

Maybe Figure 5.26 better expresses how the lamp works with its lights on in a
dark space. If so, cut back on the exposure time to make the image appear darker, as
shown in Figure 5.27. Maybe that better expresses the type of mood created when the
lamp is on.

Figure 5.25

The lamp with the cur-

tains drawn
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The two images in Figures 5.26 and 5.27 are identical. The only difference
between them is the longer shutter speed of Figure 5.27. The photographer didn’t really
know how much longer to increase the exposure time; he used various shutter speeds
and experimented until the shot finally turned out the way he intended. This is a popu-
lar technique. Don’t be afraid to try it: just keep making adjustments and taking pic-
tures. Eventually you’ll end up with the type of exposure you want.

Figure 5.26

The lamp with its lights on and

the curtains drawn
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The bottom line here is to feel free to experiment. Try things! If something
doesn’t work, get rid of it; in fact, you can quickly delete unwanted photos right there
inside your camera. When two or more images are close and you can’t decide, feel free
to use your personal preferences to select one or just use them both.

Figure 5.27

The same shot as Figure 5.26, but

with a longer shutter speed
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6
In This Chapter
Understanding the objective approach
Shooting flat objects
Using the correct infinite horizon
Making tradeoffs when fixing images
Photographing clothes

Creating Images with
the Objective Approach

Witness the scrutinizing gaze of the die-hard col-

lector and the discriminating connoisseur. They

may appear cool and calculating, but beneath

the poker-faced exterior plays the same sort of

emotional orchestra that drives the impulsive

buyer to a frenzy. The emotional need may even

be greater because the collector doesn’t need as

much as they want.

This chapter discusses the objective approach to

photographing those items you want to sell. For

the buyer, the context is obvious; you don’t need

to do any convincing. The emotional connection

is already there. Your job is to present the object

practically as a thing of worship, playing right

into the buyer’s wants.

■
C

R
E

A
T

IN
G

IM
A

G
E

S
W

IT
H

T
H

E
O

B
JE

C
T

IV
E

A
P

P
R

O
A

C
H

4381ch06.qxd  12/4/04  1:49  Page 127

TEAM LinG - Live, Informative, Non-cost and Genuine !



128

C
H

A
P

T
E

R
6

:
C

R
E

A
T

IN
G

IM
A

G
E

S
W

IT
H

T
H

E
O

B
JE

C
T

IV
E

A
P

P
R

O
A

C
H

■

When the Objective Connection Comes into Play
You don’t need to mess around with context when you’re trying to sell something
familiar to someone who already wants the item. They know why they want it. They’ve
already fantasized about how they’re going to use it. Instead of pouring a big bowl of
reason before them, you must do what they want and show them the item itself. Clear.
Focused. Raw. After all, scrutinizing the thing is part of the fun for this type of buyer.

As with the subjective approach (covered in Chapter 5), good salespeople must
know their customers. The more you know, the better you can sell your item. But for
objects on the objective side, it also helps to know a bit about the object itself and
which parts to showcase.

For example, a coin collector wants to know the details. They want to see how
far down the Indian’s cheekbone has been worn on the buffalo nickel. A movie fan
really doesn’t like those folds and creases in the poster, but if they exist, the potential
buyer wants to see how bad they really are. The antique toy collector knows the colors
on the Buck Rogers ray gun are faded and that there may be a tinge of rust—but how
much? You need to consider these details if you plan to make the emotional connection
with your buyer. The more you know about what they want, the better you can show-
case what you have to sell.

Try to guess what the buyer is interested in. Ask yourself questions about who
the buyer is, what they want, and what they’re looking for specifically. Then create the
image that gives the buyer the best representation of what it is you’re trying to sell.
Show them what they want.

Your job is to present the item for sale clearly. You want as much of the image
in focus as possible. You want it bright. You want the colors perfect. And you don’t
want any distractions; unlike the subjective approach, the item need not be in a context
or emotionally connected. Assume the buyer already knows what they want; they just
want to confirm that your item is the one they want.

It’s Flat
Most of the items photographed objectively are flat. These include things like tickets,
baseball cards, paper money, coins, brochures, programs, posters, maps, photographs,
stamps, magazines, documents, certificates, and a whole hoard of associated, two-
dimensional items. You photograph them all in the same basic—and admittedly bor-
ing—way: hang the item on a wall and snap the picture.

Okay, maybe you don’t always hang the item on a wall, but the mental image is
the same for a flat object. You can show it best by taking a shot dead-on. Any fancy
angles serve to distort the object and add unnecessary perspective; when you’re shoot-
ing something flat, it needs to look flat!

N o t e : If you’re selling an item inside a frame, keep the object inside the frame and ensure that the

photograph is in the image.
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Start by positioning the object flat on the wall. Don’t damage the item! Don’t

hang it with tape or punch a hole in it with a pushpin or nail. In fact, it doesn’t need to
be a wall. If you have an easel you can use or something else on which to prop up the
item vertically or at least at such an angle that the camera can capture the image head-
on, that’s okay.

The only tricky part is the lighting. Especially for a poster or something
mounted in a frame, you need to ensure that there is enough light on the object and
that the light doesn’t reflect into the camera.

The best way to set up the lights, at least from a starting perspective, is at 90-degree
angles to each other on either side of the image, as depicted in Figure 6.1. Then look
through the camera to ensure that there are no reflections or unwanted glare.

Don’t put the camera too close to the object. You want to always avoid taking a
wide-angle shot. Instead, keep the camera back a ways, and zoom in a little to help
frame the object. Always use a tripod!

In Figure 6.2, we have a framed set of collectors’ postage stamps. It’s just hang-
ing on a wall with the lights positioned left and right as described in Figure 6.1. You
can even see the shadows cast by the lights on either side of the image.

Notice how in Figure 6.2 that the camera wasn’t too tightly framed on the
image; there is plenty of “air” around the object. That’s fine because, like many photo-
graphs, there is a need to do some touch-up in the photo-editing program. In this case,
the photographer did three things to the image:

• Adjusted the color balance to account for the yellow light from the lamps

• Applied a Sharpen filter to punch up the images on the object

• Cropped the photograph so that the wall was removed and only the framed
photo remained

Figure 6.1

A good starting point for

positioning your lights

Object

Wall

90°

Camera
(on tripod)

Lamp Lamp
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Each of these techniques is covered in Chapter 4. The end result is what you see
in Figure 6.3. You’ll notice how well the three photographic effects helped to enhance
the image and make it beautiful: the color is more pure, especially the white; the images
are sharper; and with the wall/background gone, concentration is entirely on the frame
and the collection of stamps.

Figure 6.3

The finished result

is a stamp collec-

tion that someone

would want to buy.

Figure 6.2

The flat object

hangs on a wall, lit

properly.
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N o t e : The shot in Figure 6.2 is in focus.The difference between Figures 6.2 and 6.3 is merely a good

example of how well the Sharpen filter does its job.

Is this cheating? No way! Cheating is making something bad look good. We
would be cheating if, in this example, the stamps were damaged or off-color and we
used photo-editing software to mask the damage and disguise the color. Doing such a
thing for items you plan to sell on eBay could be considered fraud, so don’t do it!
Instead, use the tools that this book recommends to properly showcase the stuff you
have in the best possible way.

Remember, you can apply the techniques covered in this section to anything flat.
The procedure works the same way:

1. Set up the object so that the camera takes the photograph head-on. You don’t
want any distortions.

2. Properly light the image using two lamps, left and right, offset 90 degrees to
each other. You might have to adjust the lamps up/down left/right to eliminate
any glare.

3. Don’t frame the image too tightly, but do step back and zoom in on the image.
You want to avoid taking any wide-angle shots that merely serve to distort the
object.

4. Use the photo-editing software to fix any weird colors created by the lights, to
sharpen the image, and to crop out the background.

Using Infinite Horizon for Collectors’ Items
Collectors love to scrutinize. They want to see as accurate an image as you can give
them, so why not serve their needs and give them what they want?

To keep the focus on the image as best as possible, definitely use the infinite
horizon. Also, keep the paper selection to black or white unless you can really justify
how colored paper improves the object and makes a connection. (Then again, in that
case, you’re probably more interested in a subjective approach.)

The following sections illustrate infinite horizon examples that you can apply to
any small-to-desktop–sized objects.

A White Infinite Horizon Example

Most objects work well with a white infinite horizon, such as the camera shown in
Figure 6.4. The background is almost completely gone, yet the camera’s shadow still
keeps that object looking realistic and not stuck in a void. The bottom line is that there
is nothing else in the image to distract the collector who might want this particular
camera.
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In Figure 6.5, the image is color-corrected using photo-editing software as dis-
cussed in Chapter 4. And in the final step, Figure 6.6, the image is tightly cropped,
which really pulls in the details on the camera.

Figure 6.6

The image is tightly cropped.

Figure 6.5

Color correction is added.

Figure 6.4

The raw shot of a camera
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N o t e : The image in Figure 6.6 is cropped, not enlarged. It looks like it might have been enlarged

because the original image was taken at the camera’s highest setting. Because of the quantity of informa-

tion available at that setting, the image can be cropped between Figures 6.5 and 6.6, and the effect is that it

actually looks as if the image were made larger. It wasn’t.

A Black Infinite Horizon Example

The choice between black and white infinite horizons is more than aesthetic. Some
objects just get lost on a white background. For example, the camera in Figure 6.6
wouldn’t be as crisp on a black background—or really any other color. A white object,
on the other hand, can benefit greatly from a black infinite horizon. But before doing
something good, how about an awful example, as shown in Figure 6.7.

Here’s what’s just plain awful about Figure 6.7:

• It’s a wide-angle shot, which distorts everything in the image. See the screwdriver,
how it looks bent? It’s not bent in real life. Wide angle = bad! Remember that.

• The object is lying flat, which further distorts its shape.

• The screwdriver is distracting.

• The light is overhead so the object’s shadows are nonexistent, making it look flat.

• The environment detracts.

• The image isn’t framed or cropped.

• The item won’t sell for as much as it possibly could, causing the seller to be very
depressed and potentially vote Libertarian in the next election.

Figure 6.7

What not to do
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The white object in Figure 6.7 begs for an infinite horizon. Because it’s white, a

black infinite horizon makes sense. Figure 6.8 shows a start, with the object placed
on black paper to form an infinite horizon.

Despite the good start, several things are still wrong with the image in Fig-
ure 6.7. That’s okay. This is how the photographer needs to work. Keep looking
through that lens! When you do, you’ll find the following:

• The lighting is okay on one side. It’s just sunlight coming through a window,
and the window has been draped with diffusion material (a shower curtain
liner). But the light isn’t strong enough to keep the entire object evenly lit.

• The iPod’s display is muddled, difficult to see.

• There is an ugly reflection in the display.

You can fix each of these issues, but one at a time.
First, place a piece of white foam core to the left of the image to help bounce

light onto the iPod. You’ll notice how the card is positioned in Figure 6.9. Also notice
that the infinite horizon is propped up using a paint can. Likewise, the iPod itself is
propped up with a film can filled with washers (it’s difficult to see in Figure 6.9), and
the white foam core is propped up with a spray paint can. You don’t need any fancy
studio equipment or expensive setup.

To fix the reflection, cover the object being reflected with a piece of black paper.
This isn’t visible in Figure 6.9, but the results are shown in Figure 6.10.

Figure 6.8

The beginnings of an

infinite horizon setup
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You’re now ready to shoot the image. Notice that the light is now even, the
reflections are gone, and the infinite horizon helps offset and balance the white of the
iPod. The setting is objective, but not unnatural.

The final touch to improve the image is to run it through photo-editing soft-
ware. There you can enhance the screen, as was demonstrated in Chapter 4, with the
end result looking pretty snazzy, as you can see in Figure 6.11.

Figure 6.11 The final resultFigure 6.10 A piece of black paper has effectively removed

the ugly reflection.

Figure 6.9

The setup for the

iPod shot
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Beyond Black and White Horizons

Not everything is black and white. Yeah, there are shades of gray, but also bright blues,
sunset oranges, and even lemony yellows. Feel free to go beyond black or white infinite
horizons when the mood hits you. Experiment. Toss out what doesn’t work and stick
with what does work.

In Figure 6.12, you see an example of something that really doesn’t work. The
white laptop on the white infinite horizon is just all wrong. It’s white against white!
The laptop gets lost. Plus the shot shows no depth or dimensions. Remember that the
objective view assumes that the buyer knows what they’re getting. But in this case, they
may not believe their eyes.

A simple solution in this case is to turn the laptop and take a picture of it at a
skewed angle—which is the traditional laptop photographic orientation and is shown
in Figure 6.13. The lighting is dominant from one side. It’s diffused. And there’s a white
card out of sight on the right to bounce light back. The white-on-white aspect isn’t as
severe in this approach, but the image could still use some improvement.

Yes, when it comes to making things better, a little daring—a modicum of
insanity—often works. In this case, some purple wrapping paper did the trick, replac-
ing the white infinite horizon as shown in Figure 6.14.

You cannot accuse the laptop in Figure 6.14 of being “lost” in the image. No,
the grape infinite horizon adds a bit of fun while keeping the image toned down for the
objective buyer.

Figure 6.12

Wrong angle,

wrong color
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Figure 6.14

An inspired improvement

Figure 6.13

A better setup
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Give a Little, Take a Little
Some objects will fight with you. It’s a battle of give and take; you fix one problem,
and another crops up. You move the lights to the left and then back to the right. At
some point, you simply have to make a decision and win one battle or the other. Even
professionals face such a dilemma every day.

For example, take a look at the clock in Figure 6.15. It’s set up on a nice, white
infinite horizon. The light is natural, diffused sunlight coming in through a window off
on the left. No white card is required to bounce or fill. The image is just fine as it
is…but there is an ugly reflection across the center of the clock face. Can you see it?

To fix the ugly reflection, a piece of black paper—a dark source—was employed
as described in Chapter 2. The setup is shown in Figure 6.16: you can see the infinite
horizon propped up on a coffee table using a stack of books. The other end is held in
place using a standard hardware clamp (again, described in Chapter 2).

Figure 6.16

The clock shot setup

Figure 6.15

A nice shot of a clock—

almost!
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The black paper was positioned to help eliminate the bad reflection. By looking

through the camera, the photographer was able to properly position the paper until the
reflection was gone. The paper was then taped and clamped into position (see Fig-
ure 6.17), and a new shot was taken.

Although the reflection is missing in Figure 6.17, something else is missing as
well: that glorious, aged detail found in the clock’s copper bottom. Contrast the copper
bottom from Figure 6.15 with the bottom of the clock in Figure 6.17. The distressed
details—which could be important to a collector—are utterly missing when the ugly
reflection is fixed. Also, the image is darker.

Which one do you go with? Again, it depends on what you believe to be in the
mind of your buyer. If you think the buyer would appreciate the distressed look of the
clock’s copper bottom, leave in the ugly reflection. If you think the reflection is bad
enough to lose a sale, take it out. There really is no right or wrong.

N o t e : Don’t waste time waffling over decisions about whether one way is better than another. Just

choose. A professional photographer has the time, equipment, and dedication to make everything right.You

just need to get the shot taken.

Shooting Clothes Using the Objective Approach
Forget about using models to showcase any clothing you want to sell. Even if you
know an amateur model and they’re willing to donate their time, it just isn’t worth
the effort. Remember: keep it simple. For selling clothes on eBay, simply use the
objective approach and showcase the clothes you want to sell. This doesn’t mean you
must avoid being creative. That plays a role as well, as the photographs in this sec-
tion demonstrate.

Figure 6.18 illustrates a classic blunder, not only for selling clothes but for sell-
ing anything. Some of the worst pictures on eBay have people in them.

Figure 6.17

The clock without the bad

reflection, but less of the clock
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Human eyeballs are geared toward looking at and appreciating the human form,
especially the face. Psychologists tell us this is why we see human shapes in clouds, on
cliffs, or in tree bark. No matter what, when you put a human into a photograph, the
eyeball naturally wants to look at that human form and not at anything else. In Fig-
ure 6.18, you notice the person holding the overalls before and after you notice the
overalls. Not only that, the poor gal’s head is cut off.

Generally speaking, the best way to shoot clothes is simply to lay them out on a
solid background. In Figure 6.19, you see the same overalls as in Figure 6.18, but with-
out the person or the background. The overalls are merely lying on a large sheet of
white paper. To make this shot more interesting, the clothes are set at an angle. Dif-
fused lighting is used left and right of the image—similar to how flat items are shot
against a wall, but in this case the overalls were put on the floor.

Figure 6.19

A better way to sell clothes

Figure 6.18

How not to sell clothes—or anything

for that matter
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The photograph in Figure 6.19 serves the buyer well. They can see the design,

the color, and the fabric and can make an educated buying decision. Nothing distracts.
After all, you’ve got to assume that someone is merely in the market for a pair of over-
alls they will be supplying their own child.

Figure 6.20 shows another example of how clothing can be shot in a fun and
unusual way. Rather than just lay the shirt down on a blue background, oranges were
added for a wild touch. Nothing is secret here: in addition to providing a nice contrast
with the blue paper background, the oranges add a sense of playfulness to an otherwise
boring image.

Unlike the overalls in Figure 6.19, the dress shirt in Figure 6.20 is folded. A tie
was added and twisted a bit so it would be the same length as the shirt. The cuffs were
pinned into position. The setup time was minimal. Indeed, the photographer found the
sacks of oranges in the studio and added them at the last minute just for fun. And the
effect works, making the shirt look more appealing than if the oranges were not there.

Figure 6.20

A typical shirt, made

more interesting
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In This Chapter
Transferring images to your computer
Using media cards
Creating a storage place for your digital photos
Organizing your photos on the hard drive
Archiving images

Storing Images

In the old days, photographs were printed and

returned in envelopes. After living in a drawer or

languishing on the kitchen table, the photos eventu-

ally found their way into albums. Some people with

ample time and creativity even make a ritual out of

scrapbooking their pictures with artifacts and mem-

orabilia. That can still be done today, providing that

you print your digital pictures. But most of the

time, the images are stored in a digital format.

Like dust bunnies under the couch or a certain

material farm animals manufacture in bulk, digi-

tal images accumulate over time. This means that

eventually you’ll be digitally hip-deep in your

images. This presents a problem that your com-

puter is more than able to address—providing you

follow the tips, techniques, and recommendations

in this chapter.
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From the Camera to Your Computer
Like an undeveloped roll of film, the images you take with your digital camera do no
good remaining in the camera. The idea is to get them out. Unlike the film world, how-
ever, no processing is involved. The pictures taken and stored in your digital camera are
already stored as files—just like in the computer. Your goal is simply to transfer the
files from the camera to your computer.

Once the images from your digital camera are on the computer, you can do
magnificent things with them: edit them, print them, send them via e-mail, upload
them to the Web, and so on. But you must get the pictures from the camera into the
computer first.

The happy news is that digital camera manufacturers are aware that the images
must be removed from the camera. They provide one of two ways to get the image out:

• A direct cable connection

• A media card

Of the two, you’ll find that the media card works best. The direct cable connec-
tion tends to be slow and generally involves extra steps or using some special transfer
software. But with the media card, working with the images is just like working with
any files on your computer.

N o t e : If you purchased the kind of camera that this book recommends, it most likely uses a media card

for storing images. Because of that, and because the direct cable connection is different for each camera,

that method of moving images from the camera to the computer is not discussed here.

Media Card Madness

Good digital cameras use some type of media card as storage. The media card’s techni-
cal name is flash memory, which refers to the type of computer memory inside the
card. Flash memory requires no power to maintain its contents, and it can be erased
and used over again and again. This makes it handy as a long-term solution for digital
cameras.

As you might expect, many types of media cards are available, and they go by
various names, depending on their format, size, shape, flavor, and other quantifiers:

• Compact Flash

• Memory Stick

• MultiMediaCard

• Secure Digital

• XD Picture Card

Whether you have one or the other depends on which format the camera’s man-
ufacturer deemed best. But despite the subtle visual differences, all media cards are flat,
wafers that slide into and pop out of your digital camera.
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Beyond the individual type, media cards are judged by their storage capacity.
This is measured in megabytes (MB), the byte being the standard unit of computer stor-
age. One megabyte is about 1 million bytes. Other standard computer storage measure-
ments are listed in Table 7.1. Use the values to get a general idea; there is no point in
memorizing the exact numbers.

� Table 7.1 Common Computer Storage Capacity Measurements

In English Approximate Bytes Exact Bytes Quantity Abbreviation

Thousand 1,000 1,024 Kilobyte KB

Million 1,000,000 1,048,576 Megabyte MB

Billion 1,000,000,000 1,073,741,824 Gigabyte GB

Trillion 1,000,000,000,000 1,099,511,627,776 Terabyte TB

As a visual storage yardstick, a typical image on eBay uses about 50KB of stor-
age. (And that’s typical of most images you see on the Internet.) Therefore, the stan-
dard media card has more than enough room for those images. But, then again, those
aren’t the types of images that your camera snaps or that this book advises you use for
taking the pictures.

A 1 megapixel image uses about 1MB of storage. So today’s 4 to 6 megapixel
cameras take 4MB to 6MB images at their highest setting. It’s that highest setting that
you want. Snapping a dozen pictures of those fuzzy dice that you want to sell is going
to require 6MB times 12 pictures to store, or about 72MB of media card storage.

The common storage capacities for media cards are 32MB, 64MB, 128MB,
256MB, 512MB, 1GB, 2GB, and higher. The larger the media card’s capacity, the more
digital images it can store. For example, to store 12 pictures at 72MB each, you’ll want
to use a media card with at least 128MB capacity. You can guess, however, that you’ll
probably want to store more than 12 images at a time, so something along the line of
512MB or higher would be more appropriate.

N o t e : A 1,024MB media card holds the same amount of information as 1GB. Some manufacturers pre-

fer to use 1,024MB; others cut to the chase and say 1GB. A 2GB card can also be labeled as 2,048MB.

Your camera is smart enough to keep track of the space available and used on
the media card. It should display the number of images that you can store on the card,
which depends on the image resolution you set. And don’t forget that you can always
delete images from the card right there in the camera, should space become tight.
(Then again, it shouldn’t be tight if you bought the right capacity media card in the
first place.)

N o t e : Buy the highest-capacity media card that you can afford.Then buy another media card to use as

a second or alternative card.
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Like everything else in computers, a high-capacity memory card costs more than

one of lower capacity. But rather than look at the straight cost, consider the megabyte-
per-dollar cost when comparison shopping. In that perspective, a 256MB card at $42 is
double the cost per megabyte of a 1,024MB card at $72. Even a 2,048MB, or 2GB,
card at $184 is cheaper on a per-megabyte scale than a 256MB card at $42.

One reason that two media cards at the same capacity may be priced differently
has to do with speed. The more expensive cards can often transfer data more quickly
than cheaper cards. If you plan to take a lot of pictures, that can save you some time.

Finally, it’s not really necessary to buy a whole stack of media cards as you
would a stack of CD-R disks. For most people, one or two media cards will do. That’s
because you can transfer the images from the media card to your PC for long-term
storage. You can then erase, or reformat, the card and use it over and over again.

The Media Card Reader

The media card that your digital camera uses is set up and read to be mounted on your
computer system just like a new disk drive. The key to making this happen is getting a
media card reader. When you’re taking a lot of photos, you need one.

A specific media card reader is required for each of the different types of media
cards. If your computer didn’t come with a built-in media card reader, you’ll want to
buy a media card reader. Obviously you want a reader that accepts the type of media
card that your digital camera uses. Or you can get a multiple media card reader that
accepts every possible type of media card or only the most popular types.

The good news is that these media card readers are cheap! Most are in the $20
range, with the more expensive models supporting several kinds of memory cards—plus
maybe a USB hub or floppy drive thrown in for good measure.

N o t e : Before you buy a media card reader, confirm that it accepts the same type of card as used in your

digital camera. Also check to see how the reader connects to your computer. Most use the USB interface, but

they may not come with a USB cable. If the reader uses the Firewire, or IEEE, port, ensure that your computer

has such a port available.

Mounting the Media Card

This is perhaps the easiest step of all: to access the digital pictures on your media card,
simply plug it into your computer’s media card reader. Both Windows XP and Mac OS X
are designed to instantly recognize the media card. They then mount the card, adding it
to the list of available disk drives in your computer system.

In Windows XP, you might see a window alerting you to the media card’s addi-
tion to your computer’s file system. In Figure 7.1, the window asks what you want to
do, such as run Adobe Photoshop Elements. In this case, the end result you want is to
copy the images from the media card, so choose the Open Folder To View Files option
and then click OK. 
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In the Open Folder dialog box, find the images on the card. The location
depends on the type of card and camera, but most of the time you’ll find the images in
the DCIM folder and then in a folder using part of your camera’s name. At this point,
you can copy all the images just as you would copy files. Here is a suggestion:

1. Press Ctrl+A to select all the image files in the folder.

2. Choose Edit > Copy To Folder to open the Copy Items dialog box.

3. Locate the proper folder for the files.

For information on creating the proper folder, see the “Building a Place for Your
Images” section later in this chapter.

N o t e : If the Removable Disk dialog box (shown earlier in Figure 7.1) doesn’t appear, open the My Com-

puter icon on the Desktop. Locate the media card in the list of Removable Drives, and open it.

In Mac OS X, the mounted media card appears on the Desktop along with other
disk drives, but has a removable disk icon . You can access the media card’s files by
clicking that icon or by opening any Finder window, as shown in Figure 7.2.

Figure 7.2

Digging into a media

card on a Mac

Figure 7.1

Windows XP wonders

what to do with your

media card.
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Browse the media card’s folder until you find where the images are stored. For

many digital cameras, that location is a folder inside the DCIM folder (shown in
Figure 7.2). The image folder may contain the digital camera’s brand name.

N o t e : The media card might contain many folders. Be sure to browse them all until you find the images

you want.

When you find the images, copy them all to the Mac’s main hard drive.
Here’s how:

1. Press #+A to select all the image files in the folder.

2. Choose Edit > Copy n Items. (Replace the n with the exact number of image files
you’re copying.)

N o t e : You can also press #+C to copy all the selected icons.

3. Using the same Finder window, browse to the location on your hard drive where
the pictures will be stored.

For more information on this folder, see the “Building a Place for Your Images”
sections later in this chapter.

N o t e : Do not move the image files! Copy only! You want to keep the originals on the media card as a

backup.

Copying the digital image files from the media card into a more permanent loca-
tion on your computer’s hard drive is necessary for several reasons. First, it ensures that
the original image on the media card remains untouched as a temporary backup. Sec-
ond, working on an image file stored on a hard drive is much faster than working
directly on the flash memory card. Third, the hard drive just makes a better long-term
storage location. That’s because you’ll eventually be reformatting the media card to
reuse it.

After the images are safely moved to the hard drive, you can reformat and reuse
the media card. Even so, it’s a good idea to wait and first review the images on the
hard drive to ensure that they’re usable and ready to go. No need to rush things.

Unmounting the Media Card

After you extract the images from your media card, be careful to properly unmount it,
detaching the media card from your computer’s disk system. If you do not, you could
mess up the card and scramble the images—something you really don’t want to do.

To remove a media card using Windows XP, follow these steps:
1. Locate the Safely Remove Hardware icon in the Notification Area. You might

have to click the Show Hidden Icons chevron to find this icon.
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2. Click the Safely Remove Hardware icon.

3. Choose the media card from the list that appears. Figure 7.3 shows such a list.
Be careful with the names here. If you’re using more than one type of removable
media, ensure that you select the proper one!

4. When the message appears that the card can be removed safely, go ahead and
yank the sucker out. If you see a warning that the disk is in use, some program
is probably accessing the media card. To fix the problem, close all open program
windows and even other windows. Then try these steps again.

To properly dismount a media card in Mac OS X, locate the disk in any Finder
window (see Figure 7.2, shown earlier). Click the Eject icon to the right of the disk.
As soon as the disk disappears from the list, or its icon vanishes from the Desktop, it’s
okay to yank out the media card.

You can also unmount the media card in OS X by Control+clicking its Desktop
icon. This displays a pop-up menu, from which you can choose the Eject command.
When the media card’s icon is gone from the Desktop, it’s okay to remove the card
from the reader.

Building a Place for Your Images
Keeping your images organized is key to your digital photography sanity. The opposite
is madness: you’ll find that your computer has a single folder with perhaps several hun-
dred (or thousand) image files. They’re all named with the same annoying random
number scheme that the camera gave them. Trying to find that one image you want
will take you weeks. It’s best that you try now to avoid that.

The Main Pictures Folder

Both Windows and Mac OS X have a built-in home plate for your image files. 
In Windows XP, it’s called the My Pictures folder , and it’s found right there

in the main My Documents folder. 
In Mac OS X, the folder is called Pictures , and it’s found right there in your

home directory. 
Both the My Pictures and Pictures folders are excellent starting places for

your digital image storage needs. From those basic locations, you need to create
even more folders. Use the folder as the tool to help keep your images organized.
The operating system provides the material and tools, but you must provide the
effort to make it all work.

Figure 7.3

Ejecting a digital media card
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Creating a Main Folder for the Stuff You Sell

Start by creating a home base for your digital images. The My Pictures or Pictures
folder is fine, but you want yet another home base, one for the digital images that
you use to sell. As an example, create an eBay folder inside your My Pictures folder.
Here’s how:

1. In Windows, open the My Documents folder, and then open the My Pictures
folder to see its contents. In OS X, open any Finder window, and then click the
Pictures shortcut to see the contents of that folder.

2. In Windows, choose File > New > Folder to display a new folder icon named
New Folder. In OS X, choose File > New Folder to display the New Folder icon,
which is named Untitled Folder.

3. Type a new name for the folder, such as eBay.

When you type the folder name right after step 2, there is no need to select the
folder icon or use the Rename command; the new folder’s icon is already prepped for
renaming. Even so, to rename a folder in Windows, select the folder and press F2. You
can then type the new name.

To rename an icon in Mac OS X, click to select the icon, press Enter, and then
type the new name.

You can use these steps to create any folder on your computer, as mentioned in
the sections that follow. For now, the new folder that you just created, the eBay folder,
will be the main storage point for all the images you’ll be creating and using to sell
stuff on eBay.

If you plan to sell your stuff on other web auction sites or places such as Ama-
zon or Yahoo!, create folders for those locations as well.

Organizing and Using the Folders

Creating a main folder for the images of items that you plan to sell is only the begin-
ning. Your next step is to create even more folders. Here you have to make a decision:
Do you organize the folders by project or by date? Or do you perhaps use a mixture of
both? Either way, the idea is to keep things organized so that you can find what you
need quickly when you need it.

For example, suppose that you’re only an occasional seller on eBay. If so, con-
sider organizing your images by project. Suppose the first thing you sell is your old LP
collection. Here are the approximate steps that you would take to keep those images
organized:
1. Take the pictures with your camera. Thanks to all the information in this book,

the pictures are excellent and properly showcase your stuff.

2. Open your computer’s My Pictures or Pictures folder, and then open the eBay
folder.

3. Create a new folder for the pictures based on the project. In this case, call the
folder LP Collection.

4. Copy the images from your digital camera into the LP Collection folder.
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This keeps those images together and organized. (And there’s more to do, as

covered in the following sections.) By keeping this up, you’ll always know where your
images are.

Continue this process for everything you sell: create a folder, name that folder to
describe its contents, and then copy your images to that folder. When you sell your old
science fiction novels, create a Science Fiction Novels folder for those images. When
you sell those golf clubs, create and use the Golf Clubs folder. Figure 7.4 gives an idea
of what’s going on here.

N o t e : It may be tempting as an occasional seller to just dump all your pictures into one folder.Try not

to! After all, if some items sell and others don’t, you might want to reuse the images of those things that

didn’t sell. By keeping items in separate folders, you make finding things easier.

When you sell a lot of stuff, it might be a better idea to organize your folders by
dates and then perhaps individual categories. Figure 7.5 illustrates this approach. Indi-
vidual folders are created for each year and then for each month beneath those folders.
Within each month’s folders are other folders for the items you sell that month.

Figure 7.5

A more complex folder

organizational strategy

eBay

2004 2005 2006

May June July

2007

Gargoyles China Set Coins Musical
Instruments

Figure 7.4

A simple folder organization strategy

for organizing your images

eBay

LP Collection Science Fiction
Novels

Golf Clubs Baby Clothes
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Naming Your Images

Almost immediately upon copying the images to your computer’s hard drive, in the
properly created folder (per the previous sections), the next step is to give the image
files a proper, descriptive name.

In Windows, the command to rename a file is File > Rename, or you can select
the file’s icon and press F2. In OS X, to rename a file, select it, press Enter, and then
type the new name.

N o t e : When renaming an image file, be careful not to change the filename’s extension.That’s the last

part of the filename, beginning with a period and usually containing three or four characters: .JPG, .CRW,

.JPEG, .TIFF, .TIF, and so on.The operating system uses the filename extension to recognize the file as an

image or a graphic.

The problem you’ll run into here is that it helps to know what the image is so
that you can give it a proper name. Your camera most likely names the raw images
based on some storage scheme or a dating scheme or just by using the most confusing
naming system possible. So you need to preview the image before renaming it.

In Windows, to preview an image in a folder, choose View > Filmstrip or View >

Thumbnails from the folder’s menu. This mode previews not only images on the bot-
tom of the screen, but lets you see an individual file’s image quite large up top, as
shown in Figure 7.6.

Figure 7.6 Previewing image files in Windows
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For example, Figure 7.6 shows an image of a vase. The image file’s current name

is IMG1600.JPG. A better name would be vase.jpg. A better, more descriptive name
would be leaf vase with flowers.jpg. Use Windows to rename this and all the files you
plan to use.

In the OS X Finder, choose View > Columns from the menu. In this mode, when
you click an image filename, a preview of the image appears in the column on the right,
as shown in Figure 7.7. Using that example, which shows a blender, you would probably
want to rename the image file from IMG666.JPG to blender.jpg. A better, more descriptive
name would be redblender.jpg.

Figure 7.7 Previewing an image on the Mac

Together with the new filenames and their folders, you should be able to easily
locate any saved image on your hard drive.

N o t e : Neither Windows nor Mac OS X can preview all camera image types. For example, the operating

system may not understand the “raw” format used by many cameras at their highest resolution. Such a

format is understood by photo-editing software, such as Adobe Photoshop Elements.You can use Elements

to load your image files and then quickly resave them back to disk in the same format, but with a new,

better name.
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Saving the Image in Two Formats

After you create the folder, copy the images, and give them new names, the next step
is to use your photo-editing software to touch up and fix each image. This is a required
step: even if the image is perfect, you’re still going to need to use the photo-editing
software to resize the image properly for the Web, as well as save it in the recom-
mended format (usually JPEG).

The best way to save the fixed or resized image is under a new filename. This
way, you can keep the image in both original and edited forms, each having its own
unique yet similar name.

For example, suppose you begin with an image named 9356701.JPG. That’s the
way the image file came from the camera. The image is of a barber pole that you’re
planning to sell on eBay. Here’s what to do:

1. Copy the image into the proper folder on your hard drive. For example, the Bar-
ber Pole folder beneath the eBay folder.

2. Rename the image to BARBER POLE.JPG.

3. Open your photo-editing program.

4. Load the image BARBER POLE.JPG.

5. Immediately save the image back to disk in the TIFF file format.

TIFF is the best format for the long-term storage of images. It’s better than
JPEG, and it’s compatible between major applications. Do not use the Photo-
shop, PSD, Raw, EPS, PDF, or other tempting file formats. They are not as
common as TIFF.

6. Edit your image or resize it, whichever is required.

7. Save the resulting image in the file format needed. For example, for eBay, that
would be a JPEG image. Also name the file so that you know it is ready for
eBay, for example, BARBER_POLE_EBAY.JPG or even BARPOLE_EBAY.JPG. That way,
you’ll still be able to associate the original and eBay copy of the photos, but
know which is which just by looking at the names.

Remember that the names are for you. If you want to name the pictures after lot
numbers or catalog numbers, that also works. But remember to give different names to
each image.

N o t e : If you want to keep the files sorted, consider adding a numeric prefix to the renamed files. For

example, a file named 00_jacket.jpg will sort higher in a list of files than jacket.jpg does.That way,

you can freely assign descriptive names to your images, but use the prefixed number to help keep things

sorted the way you like.
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By retaining the camera’s original image, you give yourself a second chance to

edit it and use it again, say, in another format. It’s much better to continue to deal with
an original than a copy. For example, suppose eBay wants the image resized to a 50KB
JPEG, but you plan to use the same image in a newspaper ad, and they want a 300 dpi
TIFF image. When you still have both images, you’re far better off. But archiving is
more than that.

See Chapter 4 for information about saving images in different graphics file
formats.

When to Delete Images or Folders

After the item is sold, paid for, shipped, and received, you can delete the images.
Obviously, if the item is no longer in your possession, its image is no longer necessary.

When you’re organizing images by folder, you can save time by deleting the
item’s folder. That not only removes the folder but all the folder’s contents as well.

For items that don’t sell, keeping the folder and the image files is best. That
way, you can reuse them or fill the folders with new pictures should you decide to try
another approach to selling your items.

Of course, one school of thought says never delete your images. Just as you
wouldn’t delete old letters or documents, you might consider keeping or archiving the
photographs. Refer to the next section.

Archiving Images
These are the Digital Dark Ages. Because so much of this culture’s information is
stored electronically, without a printed copy ever being made, we run the risk of leav-
ing nothing substantial of our work for posterity to examine. Eventually, over time, all
those electronic particles on a hard drive will realign themselves with the earth’s mag-
netic poles. Data on a CD-R is good for only a few years. And images on the Web
come and go like tumbleweeds.

If you want to keep your digital images around for a long time, you’re going to
have to make an effort at it. The process is referred to as archiving, and it’s the art of
storing stuff long-term and keeping your images from becoming lost.

N o t e : Yes, you can always print your images. For family and even photos, there’s nothing better that

you can do with your digital images.

The best way to protect your images is to keep multiple copies. You’re already
doing that if you’re following the advice in this chapter. Your hard drive should contain
the original image file from the camera, resaved as a TIFF file, and the edited version
that you used on eBay or for whatever other purpose.
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Beyond saving the original on the hard drive, consider storing the original images

on another source. Professional photographers pay lots of money to keep their images on
server farms, where the images are saved multiple times in multiple locations. This is a
great solution, but it’s rather expensive for the nonprofessional.

For the amateur, there are three common archiving solutions: CD-Rs, the Inter-
net, and external hard drives.

CD-R disks are easy to create on those computers that have CD-R drives. Do
use the CD-R disks, which are cheaper than CD-RWs. Every few months or so, archive
those images you want to keep to a CD-R. That gives you the necessary two copies:
one on the hard drive and a second copy on the CD-R.

After a few months, make another CD-R. Include all the data on the original
CD-R, plus the new stuff you’ve created. Keep both the original CD-R and the most
recent for a few months when, again, you repeat the process.

Eventually you can dispose of (or recycle) the older CD-Rs. But by keeping up
fresh copies, you ensure that a backup image is always available.

N o t e : CDs are not eternal! Recent tests have discovered that data tends to corrupt on a CD after only a

few years. After 10 or more years, a CD-R can lose all its data.The solution is to continually make archives on

CD-Rs, keeping the new copies and throwing the old ones away.

Another backup location worth considering is the Internet. If you already have
storage available from your ISP or an online disk service, use it! Ensure that the disk stor-
age is routinely backed up to your satisfaction. And remember: the more locations
you use for archiving on the Internet, the better your chances that the images will 
be safe.

Besides raw disk storage, you might also consider one of the many photographic
repositories available. Most of them are for image sharing, allowing you to post JPEG
images for others to browse or ogle over. Instead of those, you really need to consider
raw disk storage; you’ll be archiving TIFF images, which aren’t designed for casual
Internet viewing.

N o t e : Search the Internet for “disk storage” or “photo storage” to find a few sites to choose from.

Finally, there is the second hard-drive option. External hard drives are cheap,
roomy, and available everywhere. They’re also the easiest way to store extra copies of
your images because the hard drive is added to your disk system like any other disk
drive. Unlike a CD-R, there is no “burning” step, and unlike the Internet, you don’t
have to wait for manual uploads or FTPs.
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Get a hard drive that uses either the USB 2 or Firewall (or IEEE) connection.

That way you’ll be assured that any of today’s computers can access and get at the
hard drive’s information. Avoid trying to encrypt or password-protect the external
drive; just keep the files on there as plainly as possible so that any computer in the
future can gain access.
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Getting the Image 
to eBay

The folks at eBay provide lots of hints to help

you get your image properly formatted and

ready for posting on their system, helping you

to sell your item. This appendix distills some of

that information for you. 

First, Some Basics
There are two simple rules for your online photo files:

• Save the image using the JPEG or GIF graphics format.

• Ensure that the image is less than 50KB in size.

Between JPEG and GIF, use the JPEG format, which is richer
for showcasing the kind of quality photographs this book prepares
you to take. JPEG photographs also have a quality rating; save your
image using the Good or Excellent setting, which is usually 8 out of
10, with 10 being the highest quality.

The 50KB size limit is to your advantage. Not everyone on
the Internet has a 3Mbps cable Internet connection. Many people
still use dial-up modems. You don’t want any buyer, regardless of
their Internet connection speed, having to sit and wait for your
image to download.

Consider the 50KB size limit only a guideline. If you want a
bigger image to show more detail, use it. But do be aware that larger
images take longer to display.

As far as getting the image to eBay, you can use one of their
photo services, or you can use your own web space or space on a
picture server to make the image available. eBay lets you post one
picture at no cost, but more pictures—and more features—will cost
you money. Also, the alternative requires a knowledge of FTP, or the
technique of sending raw files on the Internet.
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Resizing Your Image
Saving an image at 50KB in size really means that you need to resize it, or reduce it so
that the resolution settings—whatever they may be—equate to 50KB. This is easy
enough to do in Photoshop Elements because the Image Size dialog box shows you the
file size at the top, as shown in Figure A.1.

To change the image size, first ensure that all your work is done on the image at
its original camera resolution. Fix the color balance, crop, rotate, and take of all those
basic tasks as described in Chapter 4. Then follow these steps in Photoshop Elements to
complete the process:

1. Choose Image > Resize > Image Size to open the Image Size dialog box. The cur-
rent width and height values in pixels are shown in the top section. 

2. Select Width or Height, whichever is greater, and enter 300. There is nothing
magic about 300; it’s just a value to start with. After you type 300, the values in
the other boxes change, as does the file size at the top of the dialog box. If the
file size value is still too large, try a smaller value, say 250 and then 200. Even-
tually you’ll get down low enough to display the file size close enough to 50KB.

3. Click OK to resize the image. Don’t be shocked if the resized image appears very
tiny on your monitor! This is common, but it’s not bad:

4. Set the image’s zoom to 100 percent. In Photoshop Elements, choose View >
Actual Pixels. View the image. How does it look? Are you happy? If not, make it
larger. Remember, the 50KB limit is to your benefit. A 100KB image will take
twice as long to appear for some people. If you want to fix things, choose Edit >
Undo Image Size, and start over. Otherwise, your image is ready for saving.

Another thing to keep in mind, and they even say this in the picture area on
eBay: buyers love detail! If you took your image to show off detail, by all means go
with something larger than 50KB.

Figure A.1

Reducing the size of an

image in the Image Size

dialog
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Saving in the Proper Format
Here are the steps to save your image to disk as a JPEG using Photoshop Elements.
These steps assume that your image has already been fixed up and resized and is
ready to go:

1. Choose File > Save As to open the Save As dialog box.

2. Find the proper folder in which to save your image. See Chapter 7 for more
information on organizing your images into folders.

3. Double-check the filename, ensuring that it’s short, sweet, and to the point.

4. Choose JPEG from the Format list.

5. Click the Save button to open the JPEG Options dialog box, as shown in Fig-
ure A.2.

6. Set the quality to High or 8. You can ignore the rest of the settings in the JPEG
Options dialog box.

There is really no point in going higher on the quality. The eye cannot really tell
the difference between a JPEG image saved at 8, 9, or 10, but higher-quality val-
ues mean a larger image file on disk. That shouldn’t be a concern, however,
given that you still have the original camera raw or TIFF image on your hard
drive, per this book’s instructions in Chapter 7.

7. Click OK. With the image saved, you can now close its window and optionally
quit Photoshop Elements if that is your wont.

After saving the image to disk, go out to the folder in which it was saved. (Use
your computer’s operating system.) View the file’s size in that folder. You might be sur-
prised to find that it’s a lot smaller than the photo-editing program said it would be. If
so, freely go back into your photo-editing program, and, with the original image, create
another JPEG copy but at a larger size. After all, if eBay is giving you the 50KB, you
might as well take full advantage of it!

N o t e : Eventually you’ll get good at selecting a proper size for your image. I find that about 300 pixels

on the longest edge generally produces a file size of 50KB for most JPEG images saved at quality level 8.

Figure A.2

Setting various JPEG

image format options
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Uploading a Free Image to eBay
At no cost, eBay lets you put one picture per item on their website. You can add more
pictures if you like, or you can subscribe to their picture-hosting service, all at addi-
tional fees. (This is true as this book goes to press; it doesn’t account for various deals
or specials that might be offered from time to time.)

To add your photograph, you must complete the information for your item that
you want to sell, filling in each page as required. At some point, you’ll see the Basic
eBay Picture area, where you’ll find a Browse button. That’s the key to getting the
image from your computer to eBay. Here is how it works:

1. Click the Browse button to open a dialog box that works just like the Open dia-
log box in any program.

N o t e : Some web browsers may not be able to perform the functions outlined in these steps. It’s recom-

mended that you use Internet Explorer 4 or later for the best results.

2. In the dialog box, locate the folder in which you put your picture.

3. Click to select your picture’s filename in the dialog box. The picture must be
prepared for uploading to eBay as described in this appendix.

4. Click the Open button. At this point, the dialog box closes and you’ll be back
on eBay’s seller configuration web page.

At some point, you’ll be able to locate a link or button that lets you preview
your item’s page. The image isn’t really transferred (uploaded) until you either preview
the page or complete the entire process.

Remember: nothing is finally set until you tell eBay that you’re ready to com-
mit. If you change your mind, it’s easy to use your web browser’s Back button and
start over.
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Graphics 
File Formats

Here are some common graphics file formats.

Though this book speaks of only JPG, GIF,

TIFF and RAW, you may encounter these other

formats on the Internet or in your photo-editing

application. This appendix explains what the

formats are, lists their file extensions, and pro-

vides a brief description. Of course, all that

should make sense at first glance. But this

book’s design requires some introductory text,

which is what you’re reading now.
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Format Extension Description

Windows Bitmap BMP This is the format that Windows originally used to display graphics
images and the format still used by the Paint program in Windows.
The files saved in this format are uncompressed and therefore really
large.That makes them ill-suited for the Internet, e-mail, or really
anything outside Windows itself.

Encapsulated Postscript EPS This is a great format for exchanging complex drawings between
applications that understand the EPS standard. EPS files are all
plain text, which means they can be compressed easily. But outside
the graphics applications arena, you won’t see many EPS files.

Graphics Interchange Format GIF This is the second most popular format for image files on the Inter-
net. GIF images don’t take up much space, so they’re good for e-
mail.The only liability is that GIF images can be only 256 colors
“deep.” Consequently, their representation of real-world images
(such as people, landscapes, and so on) isn’t so hot.

Joint Photographic Experts Group JPG, JPEG This is the most common graphics file format and is excellent for
representing real-world images. JPEG images can also be option-
ally compressed, making them ideal for the Web and e-mail. A
problem with JPEG, however, is that compressing the images often
results in a loss of information, which is especially evident when
choosing low-quality settings or saving over two or three genera-
tions (opening and resaving) of an image.

Portable Network Graphics PNS This standard, or ping as it’s commonly known, is the graphics file
format standard of the future. PNG has all the advantages of both
GIF and JPEG, making it ideal for the Internet: the images look
good, they compress well, they can be animated, and technically
the standard is far better than either GIF or JPEG.The only draw-
back is that PNG is new and therefore not as widely supported.

Photoshop This is the standard image format used by Adobe’s Photoshop and
Photoshop Elements graphics-editing programs. It’s truly the best
format in which to save your graphics files if you use Photoshop,
but few other applications recognize or use the standard.

Camera raw This format is used by digital cameras. It contains the “raw” camera
image—the exact pixels captured by the camera’s gizmo without
any regards to in-camera adjustments such as white balance, tonal
controls, or other modifications.The file size is huge; after all, the
RAW format is just raw bytes. A 5-megapixel camera generates a
5MB RAW image file.

Tagged Image File Format TIF,TIFF This format is one of the oldest and most common graphics file
formats. Just about every major application supports TIFF graphics,
which means that it’s an excellent format to choose for saving
images long term (far better than JPEG). But because TIFF files are
so huge, they are not good at all for the Internet or for sending by
e-mail. For example, a JPEG image that is only 35KB in size could
be an equivalent 1.5MB TIFF image.

RAW
NEF
RAF
ORF
MRF

PSD
PDD
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Numbers

55mm lens, 40–41

A

Actual Pixels command (Photoshop Ele-

ments), 72, 76, 160

amateur photography, 2–4

angle of camera position, 56, 57

aperture, 46–49, 47, 48

for capturing LCD screen or monitor dis-

play, 90

and depth of field, 54

manual overrides, 39

approaches to taking photograph, 9–10. See

also objective approach to taking photo;

subjective approach to taking photo

archiving images, 155–157

Auto Sharpen feature of camera, 84

Auto Smart Fix command, 79

autofocus mode, 46

B

background

for jewelry, 101–105, 102, 103, 104

removal, 86, 86–87, 87

white paper as, 10

black card, to eliminate glare, 64

black level, setting, 80

blurring areas, 84–85, 85

BMP file format, 164

brightness and contrast, 81–82

Brightness/Contrast dialog box, 81, 81

buyer, knowledge of, 100

C

C47, 24

cable connection, for image transfer, 144

Camera raw format, 164

can of air, 26–27

Canon Digital Rebel, 39

cars, avoiding reflections, 67

CD-R disks, for archiving, 156

clothes, photographing, 139–141, 140, 141

clothespins and clamps, 24

color, tone and balance, 78–82

Auto Smart Fix command, 79

brightness and contrast, 81–82

setting levels, 80–81

compact flash, 144

company logo, as watermark, 96, 96

competition, on eBay, 5

compositing, 87–93, 92

combining separate shots, 91–93

computer, transferring images from camera 

to, 144–149

Index
Note to the Reader: Throughout this index boldfaced page numbers indicate primary discus-

sions of a topic. Italicized page numbers indicate illustrations.
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connection between photo and viewer, 2

context, 99, 112, 112

contrast, 81–82

Copy Items dialog box (Windows), 147

cropping, 132, 133

in photo-editing software, 74–75

D

deleting images, 155

depth of field, 46, 49, 52–54, 53, 55

zoom lens and, 59

diaphragm, 47

diffuse lighting, shower curtain for, 21–22, 22

Digimark, 97

digital cameras, 38–43

critical features, 39–40

depth of field, 52–54, 53, 55

exposure, 46–50

aperture setting, 46–49, 47, 48

shutter speed, 49–50

focus, 45, 45–46

image resolution, 60

lens, 40–43

megapixels, 38–39

positioning, 56–60

transferring images to computer 

from, 144–149

tripod, 20, 43–44

Digital Marketing, Inc., 97

digital watermark, 97

distractions, avoiding, 6, 7

doctoring photos as fraud, 87–88, 131

drawing paper, 25, 25

drop shadow, 65

E

eBay

competition, 5

transferring images, 159–162

file format, 161

resizing for, 160

upload process, 162

watermark, 93

Edit menu (Photoshop Elements)

> Copy, 92

> Paste, 92

> Revert To Saved, 76

embossed text, 94

Encapsulated Postscript format, 164

Enhance menu (Photoshop Elements)

> Adjust Lighting > Brightness/

Contrast, 81

> Auto Color Correction, 79, 79

> Auto Contrast, 81

> Auto Levels, 80

> Auto Smart Fix, 79

EPS file format, 164

equipment, 20–28

can of air, 26–27

clothespins and clamps, 24

drawing paper, 25, 25

foam core board, 26, 134

ladder, 27, 27–28, 28

lamps, 23, 23

shower curtain, 21–22, 22

Eraser tool (Photoshop Elements), 87

exposure, 46–50

aperture setting, 46–49, 47, 48

automatic adjustment, 51–52
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for capturing LCD screen or monitor dis-

play, 89–90

shutter speed, 49–50

external hard drives, for archiving, 156–157

F

f-stop, 47, 48

Feather Selection dialog box (Photoshop Ele-

ments), 91

file format, 163–164

for eBay, 161

GIF, 159

JPEG, 77, 159

saving to multiple, 154–155

saving to specific, 76–78

TIFF, 76, 154

File menu (Photoshop Elements) > Save As, 77

file name extension, 152

film plane, measuring distance to object, 46

Filter menu (Photoshop Elements)

> Blur > Gaussian Blur, 84

> Sharpen > Sharpen, 82, 131

> Stylize > Emboss, 94

fish-eye lens, 41

Fit On Screen command (Photoshop Ele-

ments), 72

flash, 61, 61–62

overriding or disabling, 40

shadows from, 116

flash memory, 144

Flip Horizontal command, 73

Flip Vertical command, 73

foam core board, 26, 134

focal length of lens, 40

focus, 45, 45–46

aperture setting and, 49

depth of field and, 52

manual, 39

folders for images, 77, 149–155

folder for sale items, 150

main folder, 149

organizing, 150–151

framing image, 59–60

fraud, doctoring photos as, 87–88, 131

Free Rotate command, 73

fuzzy objects, focus and, 45, 45–46

G

Gaussian Blur dialog box (Photoshop Ele-

ments), 84, 85

GIF file format, 159, 164

gigabyte (GB), 145

glare, eliminating, 63–65

Graphics Interchange format, 159, 164

H

Hand tool (Photoshop Elements), 71

hard drives, for archiving, 156–157

humans

in clothing photo, 140

in jewelry photo, 105

I

Image menu (Photoshop Elements)

> Resize > Image Size, 75, 160

> Rotate, 73

Image Size dialog box (Photoshop Elements),

75, 75, 160
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images

decision to delete, 155

file format, 163–164

GIF, 159

JPEG, 77, 159

TIFF, 76, 154

naming, 152–153

resolution, 60

saving

to multiple file formats, 154–155

to specific format, 76–78

transferring to eBay, 159–162

file format, 161

resizing for, 160

upload process, 162

“infinite horizon” effect, 10, 29, 29–30

Internet, for archiving, 156

interpolated megapixel values, 39

J

jewelry, 101–105, 102, 103, 104

JPEG file format, 77, 159, 164

JPEG Options dialog box (Photoshop Ele-

ments), 78, 161, 161

L

ladder, 27, 27–28, 28

lamps, 23, 23

landscape orientation, 73

Lasso tool (Photoshop Elements), 82

Layer menu (Photoshop Elements) > Flatten

Image, 92

layers, preserving, 92

lens, 40–43

Levels dialog box (Photoshop Elements), 80, 80

lightbulbs, 23

lighting, 32–35, 34, 60–67

bouncing, 7

eliminating reflection and glare, 63, 63–65

for flat objects, 129, 129

positioning, 62

shadows, 65–66

for small objects, 100

with sun, 66–67

white card as diffuser, 33, 34

low-lighting, shutter speed for, 108

M

Mac OS X

mounting media card, 147, 147–148

unmounting media card, 149

macro lens, 42, 100

magic hour, 67

Magic Wand tool, 86

Magnetic Lasso tool (Photoshop Elements), 

82, 91

manual focus, 39, 45

media card, 144–146

mounting, 146–148

size of, 40

unmounting, 148–149

media card reader, 146

megabytes (MB), 145

megapixels, 38–39, 145

memory stick, 144

mirror, 108, 108

monitor, resolution, 72

mounting media card, 146–148

Move tool (Photoshop Elements), 94
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MRF file format, 164

MultiMediaCard, 144

My Pictures folder (Windows XP), 149

N

naming images, 152–153

NEF file format, 164

normal lens, 40–41

O

objective approach to taking photo, 9–10

for clothes, 139–141, 140, 141

flat objects, 128–131, 130

“infinite horizon” effect, 131–137

black background example, 133–135,

134, 135

color background example, 

136–137, 137

white background example, 

131–133, 132

use for, 128

objects, limiting number, 7–9, 8

opacity of watermark, 95

Open Folder dialog box (Windows), 147

ORF file format, 164

outside shooting, 66–67

overcast day, 67

P

PDD file format, 164

persistence of vision, 88

photo-editing

background removal, 86, 86–87, 87

basic techniques, 70–78

cropping, 74–75

resizing, 75–76

rotating, 73

saving to specific file format, 76–78

zooming, 70–72

blurring areas, 84–85, 85

color, tone and balance, 78–82

Auto Smart Fix command, 79

brightness and contrast, 81–82

setting levels, 80–81

compositing, 87–93, 92

sharpening focus, 83–84

undoing mistakes, 76

watermark, 93–97

company logo, 96, 96

digital, 97

eBay feature, 93

text watermark, 93–95

photo-editing software, vs. setup, 13–14

photoflood, 23

photography

amateur vs. professional, 2–4

rules for quality, 6–16

less is more, 7–9, 8

minimizing photo-editing, 13–16

simplicity, 6–7

subjective vs. objective approach, 9–10

thought in setup, 10–12

Pictures folder (Mac OS X), 149

pixel, 38

PNS file format, 164

Polygonal Lasso tool (Photoshop Elements), 91

Portable Network Graphics, 164

portrait lens, 43

portrait orientation, 73

positioning camera, 56–60
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professionally taken photographs, 2

propping things up, 30, 30–32, 31

PSD file format, 164

R

RAF file format, 164

RAW file format, 164

Rectangular Marquee tool (Photoshop Ele-

ments), 82

reflection

avoiding, 89

eliminating, 63, 63–65, 138, 138–139

resizing

for eBay, 160

in photo-editing software, 75–76

resolution of image, 60, 72

Revert command, 76

rotating, in photo-editing software, 73

S

sales

emotional aspects, 4–5

photograph as tool, 4

Save As dialog box (Photoshop Elements), 

77, 77

saving to specific file format

multiple formats, 154–155

in photo-editing software, 76–78

“Say cheese,” 4

screen display on products, composite photo

for, 87–93

seamless paper, 29

Secure Digital, 144

Select menu (Photoshop Elements)

> Feather, 91

> Inverse, 84

> Similar, 86

setup, 10–12, 11, 12

vs. photo-editing software, 13–14

shadows, 65–66

avoiding, 15, 15–16, 16

with foam core board, 26, 134

with shower curtain, 21–22, 22

sharpening focus, 83–84, 130, 131

shower curtain, 21–22, 22

shutter speed, 49–50

for capturing LCD screen or monitor dis-

play, 90

manual overrides, 39

sizing photos for e-mail or Web, 75

SLR (single-lens reflex), 39

steam, photographing, 107

storing images

archiving images, 155–157

decision to delete, 155

folders for, 149–155

folder for sale items, 150

main folder, 149

organizing, 150–151

naming images, 152–153

saving in multiple formats, 154–155

transferring from camera to computer,

144–149

studio

equipment, 20–28

can of air, 26–27

clothespins and clamps, 24

170

IN
D

E
X

■

4381IDX.qxd  12/2/04  2:00  Page 170

TEAM LinG - Live, Informative, Non-cost and Genuine !



drawing paper, 25, 25

foam core board, 26, 134

ladder, 27, 27–28, 28

lamps, 23, 23

shower curtain, 21–22, 22

helpful techniques, 28–35

“infinite horizon” effect, 29, 29–30

lighting, 32–35, 34

propping things up, 30, 30–32, 31

location, 20

subjective approach to taking photo, 

9–10, 100

large objects, 120–124, 121–125

midsized objects, 106–120

avoiding unappealing realism, 114–115

borderline objective approach, 115–117,

116, 117

fantasy environments, 

106, 106–109, 108

realistic environments, 

109, 109–113, 110

transparent objects, 118, 119, 120

small objects, 100–105

jewelry, 101–105, 102, 103, 104

sun, 66–67

T

Tagged Image File Format, 76, 154, 164

telephoto lens, 42–43

Text tool (Photoshop Elements), 94

text watermark, 93–95

TIFF file format, 76, 154, 164

TIFF Options dialog box (Photoshop Ele-

ments), 78

transferring images from camera to computer,

144–149

tripod, 20, 43–44

for slow shutter speeds, 50

U

Undo command, 76

undoing mistakes in photo-editing, 76

unmounting media card, 148–149

V

View menu (OS X Finder) > Columns, 153

View menu (Photoshop Elements)

> Actual Pixels, 72, 76, 160

> Fit On Screen, 72

View menu (Windows)

> Filmstrip, 152

> Thumbnails, 152

viewfinder, shutter and, 49

W

watermark, 93–97

company logo, 96, 96

digital, 97

eBay feature, 93

opacity, 95

text watermark, 93–95

white card, as light diffuser, 33, 34

white level, setting, 80

white paper, as background, 10
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wide-angle lens, 41, 133

distortion by, 58

Windows Bitmap format, 164

Windows menu (Photoshop Elements) 

> Layers, 95

Windows XP

mounting media card, 146, 147

unmounting media card, 148–149

wrapping paper as background, 106, 107

X

XD Picture Card, 144

Z

zoom lens, 43

distortion by wide-angle, 58

zooming, in photo-editing software, 70–72
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